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Pendamping Berselancar Salam!Salam!

canning sebagai teknik hacking ditaruh sebagai
bahasan utama untuk melanjutkan apa yang pernah
NeoTek sajikan pada nomor-nomor terdahulu.

Dengan sajian pada nomor ini kami berharap pembaca dapat
lebih memahami cara penggunaan scan sebagai langkah
selanjutnya setelah footprinting. Namun, sebagaimana
biasanya, kami ingin mengingatkan bahwa scan dipelajari
bukan agar anda sekedar menjadi keren atau tambah beken.
Teknik tetap tinggal teknik. Di tangan andalah teknik itu bisa
berubah menjadi sesuatu yang bermanfaat atau menjadi
malah jadi mudarat. Jadi, mana yang anda pilih?

Redaksi
rreeddaakkssii@@nneeootteekk..ccoo..iidd

Menelisik scanMenelisik scan
bukan asal sekedar bekenbukan asal sekedar beken

SS

• SuperSCAN adalah salah satu program untuk melakukan scanning. Program ini
menjadi salah satu program scanner yang dapat berjalan di Windows 98, sedangkan
yang lain biasanya hanya cocok untuk Windows NT atau Windows 2000.

NeoTek menyediakan CD
yang berisi program-
program yang dibahas
pada NeoTek nomor ini:

• Nmap
• SuperScan
• JavaScript Editor
• WebWriter
• Legion
• Fping
• JRE GNU Zip Tar Shell
• JRE Windows
• Dig
• QuarkXpress 5.0 (Beta)
• The Bat!
• Post Cast Server

Dapatkan CD-ROM-nya
dalam satu paket dengan
majalah NeoTek:

Majalah + CD Rp19.500
CD saja Rp15.000

Hubungi
Bagian Sirkulasi
Majalah NeoTek
Tel.   (021) 548 1457
Faks. (021) 532 9041

email:
pemasaran@neotek.co.id
Kontak: Elvi R. Nainggolan

www.neotek.co.id

Bagaimana menghubungi NNEEOOTEK?TEK?
KONTRIBUSI ARTIKEL
redaksi@neotek.co.id

SURAT PEMBACA
support@neotek.co.id

WEBMASTER
webmaster@neotek.co.id

PEMASARAN
pemasaran@neotek.co.id

CHATROOM DI DALNET
#neoteker

ADMINISTRASI IKLAN
Tel. 021-5481457 Fax. 021-5329041

SIRKULASI NEOTEK
Tel. 021-3854764

ALAMAT REDAKSI
Gedung Cahaya Palmerah Suite 506
Jl. Palmerah Utara III No. 9
Jakarta 11480

MILIS PARA NEOTEKER
http://groups.yahoo.com/group/majalahneotek

PENAWARAN KHUSUS
Dapatkan koleksi 8 CD NeoTek

- CD NEOTEK 2-1
- CD NEOTEK 2-2
- CD NEOTEK 2-3
- CD NEOTEK 2-4
- CD NEOTEK 2-5
- CD NEOTEK 2-6
- CD NEOTEK 2-7
- CD NEOTEK 2-8

Dengan harga Rp95.000,-
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Daftar Isi

Daftar IsiDaftar Isi
NeoStartNeoStart

NeoTNeoTek Vek Vol. Iol. I I No. 8I No. 8
NeoStyleNeoStyle NeoTNeoTeknoekno

Mengintip Bocoran
Dapatkan bocoran dari
Redaksi di milis NeoTek

9 QuarkXpress 5.0
Kenali versi terbaru dari
program desktop publishing

yang digunakan Redaksi NeoTek untuk
menataletak naskah majalah ini.

46

Linux Apa?
Anda belum tahu apa persis-
nya Linux itu sebenarnya?

Inilah artikel yang akan memperke-
nalkannya kepada anda.

10

Scanning Tools
Tools apa sajakah yang
diperlukan untuk men-scan

suatu jaringan?

34

SuperSCAN
Inilah salah satu dari cuma
beberapa program scan yang

dapat dijalankan di Windows 98.

Teknik Routing Internet
Beberapa konsep dasar yang
perlu diketahui agar anda

memahami teknik routing Internet.

40

37

Mejeng Ala NeoTeker
Adjat membuat situs ini

sebagai alat untuk memperkenalkan
kemampuannya di bidang web
development. Ia menawarkan jasa
pembuatan situs Web yang “interatif,
dinamis, animatif, dan promotif.” Situs
Web yang dibuatnya dapat ia
daftarkan pada layanan webspace
gratis yang kredibel sehingga “anda
tidak perlu iuran.” Sebuah tawaran
yang menarik.

19

Program Iseng
Hati-hati! Kini ada program-
program iseng yang dapat

membuat anda puyeng dan kaget tujuh
keliling: pura-pura memformat hard
disk, membuat ikon desktop ‘kabur-
kaburan.’ Hah?

48

Situs NeoTek www.neotek.co.id
neotek.kpone.com.sg

Jadikan situs NeoTek sebagai pangkalan Anda berselancar

Link Langsung
Kunjungi situs-situs yang dibahas di
majalah NeoTek dengan sekali klik
lewat situs NeoTek.

NeoTek versi PDF
Kehabisan NeoTek di kota Anda?
Dapatkan saja versi PDF-nya. Gratis!

Download
Tersedia juga download di situs
NeoTek selain dari situs aslinya

Layanan Rupa-rupa NeoTek
Dapatkan perlengkapan awal dalam
berinternet dari situs web NeoTek
HumanClick
Hotline langsung ke redaksi NeoTek
untuk menyampaikan saran dan pesan.
Chat Room
Kini tidak usah jauh-jauh untuk ngobrol
langsung dengan sesama NeoTeker
Mailing List
Ini yang paling ramai. Segera ikutan
berbagi pengalaman berinternet!



NeoTNeoTutorutor

OE Lebih Lanjut
Tip-tip untuk mengoptimalkan
penggunaan Outlook Express.

26

Mengenal JavaScript
Agar anda tidak sekedar ‘tahu’
mengenai JavaScript, tetapi

‘mengenalnya’ lewat tutorial-tutorial
singkat yang disertai contoh penerapan
dan ditulis secara bersambung.

22
The Bat! yang Hebat
Tidak banyak klien email yang
mempunyai ‘kesaktian’ seperti

The Bat! Di antaranya dapat menghalau
virus yang hendak ditularkan lewat pesan
email. Wah!

30

Yahoo! di OE
Memindahkan pesan email di
Yahoo! ke Outlook Express agar

dapat anda baca secara offline dan
menghemat biaya pulsa.

28

PostCast Server
Kiat agar dapat mengirim email
tanpa perlu terikat pada server

SMTP dari ISP tempat anda berlanggan-
an Internet.

32

Mengenal ASP
Kenali program yang me-
mungkinkan anda membuat

halaman Web yang dinamis ini.

19

Mencari Open Source
Di mana saja anda dapat mem-
peroleh program-program Open

Source baik untuk Linux maupun Windows?

Kompilasi Kernel Linux
Cara mengkompilasi kernel
Linux agar sesuai dengan

kebutuhan anda sebagai pengguna.

13

16

Daftar Isi

NeoSoft

RealProfil

NeoTek Juni 2002

3D Flash Animator
Membuat animasi 3D untuk
digunakan pada situs Web anda
dengan cara yang mudah. Cocok
untuk pemula.

Aneka Tutorial
Ikuti tutorial bagi anda yang ingin
menguasai JavaScript, ASP, dan
PHP.

Enumeration
Langkah hacking selanjutnya
setelah Footprinting dan Scanning.

ICQ Password
Grabber0

Kru NeoTek
Bermarkas di
Gedung Cahaya Palmerah 503
Jl. Palmerah Utara III No. 9
Jakarta 11480
Telp. 021-5481457
Fax. 021-5329041

Bank
Bank BNI
a.n. PT NeoTek Maju Mandiri
No. rekening 070.001709720.001

Bank BCA KCP Rawamangun
a.n. Aswan Bakri
No. rekening 0940544131

Pemimpin Umum
Fachri Said

Pemimpin Redaksi
Kosasih Iskandarsjah

Redaktur Ahli
Onno W. Purbo
Michael S. Sunggiardi

Pemimpin Usaha
Fahmi Oemar
Ridwan Fachri

Redaktur Pelaksana
Gianto Widianto
Dadi Pakar

Sekretaris Redaksi
Elvy Risma Nainggolan

Dewan Redaksi
Supriyanto
Stanley

Pemasaran
Hedhi Sabaruddin
Tuti Sundari

Keuangan
Aswan Bakri

Percetakan
CV Angkasa, Bandung

3

6

4

5

Lupa password ICQ anda?
Atau ‘lupa’ password
orang lain?

NmN
Neoteker menjawab Neoteker
dalam forum milis NeoTek

Ada Apa di CD NeoTek?
Scanning Tools

Daftar Isi CD NeoTek
Scripting • Server • Java 2
Platform • Footprinting • OS
Detection • Unix Network
Admin Tools • Linux Apps

NeoRagam

Inbox

Mei 2002 NeoTek 3

FOKUS BULAN INIFOKUS BULAN INI

Men-scan Jaringan
dengan Tools Canggih

Men-scan Jaringan
dengan Tools Canggih
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NeoRagam

AdaAda ApaApa didi CCDD NeoTNeoTek?ek?
CD NeoTek bulan ini memuat scanning tool dan scripting tool, di
samping Java 2 Platform, Standard Edition v. 1.4.0 yang sulit untuk di-
download sendiri karena ukurannya yang besar.

CCDD  NNeeooTTeekk
MMeeii  22000022

eperti tercermin
pada dari daftar
isinya, CD NeoTek

kali ini berisi program-pro-
gram scanning jaringan.
Yang langsung dapat anda
gunakan selain Nmap un-
tuk pemakai Linux dan NT
adalah SuperScan, yang
berjalan pada Windows 98.

Yang juga tidak kalah me-
narik adalah program-pro-
gram Java 2 Platform,
Standard Edition v. 1.4.0
yang dinanti-nanti oleh
banyak programmer. Pro-
gram-program yang besar
ukurannya itu kami men-
downloadkan untuk anda
agar anda dapat langsung
memanfaatkannya.

Sementara itu, bagi kalang-
an profesional penerbitan,
periklanan, dan dan desain,
ada kabar baik yaitu mun-
culnya QuarkXpress 5.0.
Versi beta-nya pun kami
sertakan pada CD NeoTek
kali ini.

Menyertai tutorial ASP
dan JavaScript kali ini,
disajikan pula scripting
tools, yaitu editor untuk
ASP maupun JavaScript
serta server untuk menguji
script yang telah anda
buat.

uNmap
Scanner serba guna yang
tersedia pada Linux dan NT.
Mempunyai kemampuan
ping sweep, port scan untuk
TCP serta ICMP dan fasilitas
scan eksotis lainnya seperti
TCP SYN scan yang bersifat
siluman (steakth scan)

uSuperScan
Kini bukan hanya pengguna
Linux dan NT yang dapat
menikmati fasilitas scan yang
eksotis. Pemilik Windows 98
juga bisa dengan SuperScan,
yang kekurangannya hanya
tidak men-scan port ICMP.

uNetScan Tool
Versi kecil dari port scanner
komersial terbaik untuk
Windows saat ini, NetScan
Tools Pro 2000.Versi kecil ini
tidak men-scan port UDP.

Ping Sweep (Linux)
uFping
uHping
uicmpenum
uNetPing
uPAT Ping Sweeper
uPinger
uSATAN
uSping ICMP
uWarscan exploit
Untuk melakukan ping se-
cara cepat dan mendapat-
kan sistem yang hidup. Di

antaranya dapat mengatasi
port ICMP yang diblokir.

Ping Sweep (Windows)
uFping
uPingSweep
uRhino Pinger
uSAINT 1.1.2
uWS_Ping Pro Pack
Untuk melakukan ping sweep
dan menembus port ICMP
yang diblokir, tools yang ada
pada Windows ini tidak kalah
dengan rekan-rekannya
yaang untuk Linux.

Unix Port Scanner
uHost Sentry
uHping
uL0pht Watch
uNetcat
uNmap
uPort Sentry
urinedt Port Redirect
uSara
uScotty Network Mgt.
uStrobe
Port scanning untuk menen-
tukan service apa yang ber-
jalan pada suatu sistem yang
sudah diketahui hidup lewat
ping sweep. Kembali andalan-
nya adalah nmap, selain ncat
dan L0pht Watch.

Win Port Scanner Utama
uSuperScan
uipEye
uWUPS

Karena tidak ada port scanner
yang selengkap nmap pada
Windows 9x, gabungkan ke-
mampuan SuperScan, ipEye,
dan WUPS  agar kurang lebih
setara dengan nmap pada
Linux dan NT.

Win Port Scanner Lain
u7th Port Scan
uAA Tools
uCabra Domain Scanner
uChaos Port Scan
uDumpSec
uFpipe Port Forwarder
uFscan
uHCOpen Port Scanner
uHoppa Port Scanner
uLegion
uMing Sweeper
uNetBIOS Audit Tool
uNetcat for NT
uNetFizz
uNgrep
uNmap for NT
uNTO Scanner 126
uPinger
urinedt Port Redirect
uScan  Port
uUltrascan
uWin Nessus
uWinScan 2

OS Detection
uSiphon (Windows)
uSiphon (Linux)
Selain dapat menggunakan
nmap untuk deteksi sistem
operasi suatu sistem, dapat
juga digunakan Siphon dan
Queso.

Network Admin Tools
uCheops 0.59a RPM
uCheops 0.6 Tarball
uCheops-ng
Tools untuk otomatisasi peng-
amatan terhadap jaringan lokal
maupun remote yang dileng-
kapi dengan pemetaan grafis.
Meliputi ping sweep, port
scan, OS detection selain juga
footprinting.

SS

SSCCANANNNIINNG TG TOOOOLLSS
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daftar isi cd neotekdaftar isi cd neotek
SCRIPTING
ASP Edit aspedit
JavaScript Editor 2.5 jse2em
JavaScript Tutorial jstutor
JS Editor 2.0 jsedit160
Kimiko HTML Editor kimiko34
Platypus Editor pjedit
Script Builder 2.0 scrptbld
Web Writer webwri3

SERVER
Personal Web Server setup
Sambar 5.0 sambar50
Xitami bw3224b9

JAVA 2 PLATFORM, SE 1.4
Documentation j2sdk-1_4_0-doc
Java Cryptography Ext. jce_policy-1_4_0
JRE GNU Zip Tar Shell jre2e-1_4_0-linux-i386.bin
JRE RedHat RPM j2re-1_4_0-linux-i386-rpm.bin
JRE Windows j2re-1_4_0-win-I
JRE Windows US j2re-1_4_0-win
SDK Forte GNU Zip Tar Shell j2sdk-1_4_0-forte-ce-3_0-bin-

linux.sh
SDK Forte Windows US j2sdk-1_4_0-forte-ce-3_0-bin-win
SDK GNU Zip Tar Shell j2sdk-1_4_0-linux-i386.bin
SDK RedHat RPM j2sdk-1_4_0-linux-i386-rpm.bin
SDK Windows j2sdk-1_4_0-win

FOOTPRINTING
Dig dig04
Necrosoft NetScan nscan09
Necrosoft Traceroute tracert02
Necrosoft Whois whois03
NS Lookup nslookup
Sam Spade spade114
Whois Installation whoisi
WS_Ping Propack wsping32
Xwhois for UNIX whois-0.4.2.tar

OS DETECTION
Siphon Windows siphon-v.666
Siphon Source Code Unix siphon-v.666.tar

UNIX NETWORK ADMIN TOOLS
Cheops 0.59a RPM cheop-0.59a-1.i386.rpm
Cheops 0.60 Linux Tarball cheop-0.60pre5.tar
Cheops-ng cheops-ng-0.1.

LINUX APPLICATIONS
GIMP 132 gimp-1.3.2.tar
KDE 3 Beta k3b-0.5.1.tar

PING SWEEP
Fping UNIX fping.tar
Fping Windows fping205
Hping hping2.0.0-rc1.tar.gz
ICMP Documentation HTML document
icmpenum UNIX icpenum-1.1.1
icmpquery_c icmpquery_c
NetPing UNIX netping-0.2.tar
PAT Ping Sweeper Unix pat
Ping Sweep pingsweep
Pinger UNIX pinger-1.0.tar
Rhino Pinger pinger
SAINT Windows saint112
SATAN Linux satan-1.1.1-linux.tar
Sping ICMP UNIX sping-1.2.tar
Warscan Exploit Test Unix warscan-0.7.2.tar
WS_Ping Propack wsping32

WINDOWS APPLICATIONS
ICQ Password Stealer icqpw
QuarkXpress 5.0 Beta setup
The Bat! the_bat
PostCast Server setup

WINDOWS PORT SCANNER
7th PortScan 7thportscan
AATools aatools
Cabra Domain Scanner cabdomscan
Chaos Port Scan cha0scan
DumpSec dumpacl
Fpipe Port Forwatder fpipe2_1
Fscan fscan
Fscan 112 fscan112
HCO pen port scanner pscanner
Hoppa port scanner ps
ipEye ipeye
Legion legion
Ming Sweeper minger1a5
NetBIOS Auditing Tool nat10bin
Netcat for NT nc11nt
NetFizz net-fizzV0.1
NetScan Tools est32242
Ngrep ngrep-1.40-win32-full
Nmap for NT nmapnt
NTO scanner 126 ntoscanner126
Pinger pinger
Rinedt Port Redirect rinedt
Scan Port perl
SuperScan superscan
Ultra Scan uscan12
WinNessus winnessus
Winscan 2 winscan2
WUPS wups

UNIX PORT SCANNER
Host Sentry hostsentry-0.02.tar
Hping hing2.0.0-rc1.tar
L0pht Watch l0pht-watch.tar
Log Sentry logsentry-1.1.1.tar
Netcat nc110
Nmap nmap-2.54BETA30
PortSentry portsentry-1.1.tar
rinetd Port Redirect rinetd.tar
Sara sara-3.5.3.tar
Scotty Network Mgt ToolRPM scotty-2.1.9-4mdk.i386.rpm
Strobe strobe-classb-v1.8

JOKE PROGRAMS
Add/Remove add-remove
Bomb bomb
Click Me clickme
Crazy Num Caps Scroll crazy_ncs
Cursor Fun cursorfun
Dirty Mouse dirty
Down Hoax downhoax
Email Fun email
Fake Delete fakedel
Fake Format fakefmt
Fake Shutdown fakeshutdown
Fake Start Menu 95 start
Flip It flipit
Floppy Madness floppy
Follow Me followme
Gas Gripe gas
Headache headache
Message Manager message
Open/Close CD cd
Password Prank password
Pirated Software pirate
Print Me printme
Program WAV Launcer launcher
Random Burper burp
Random Wallpaper wall_papr
Rotate rotate
Scarry Patch scarrypatch
Screen Screw screenscrew
Shake Down shakedown
The Finger finger
Time Traveler traveler
Win Delete windel
Y2K Joke y2k
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Inbox

Forum ini dimaksudkan sebagai bentuk offline dari mailing list
NeoTek di http://groups.yahoo.com/group/majalahneotek.

NmNNmN
NeoTeker menjawab NeoTekerNeoTeker menjawab NeoTeker

Free Proxy Server
T: Posted March 1
Hi, ada yang punya free
proxy server port 8080 ?

Arix
121@telkom.net

J: Posted March 2
dns1.sendai.alsi.co.jp 8080

Feranita Anwar
feranita_anwar@yahoo.com

T: Posted March 2
Apa sich maksud dan kegu-
naan dari Free Proxy Server
tsb...bisa kasih info detail-nya 

Oke Lho
majolca2002@yahoo.com

J: Posted March 2
Singkatnya proxy server itu
membuat kita tidak terlacak
dari daerah mana atau nega-
ra mana kita mengakses in-
ternet.sbg contoh dengan
memakai proxy server
dns1.sendai.alsi.co.jp 8080
kita akan telihat sebagai peng-
akses dari negara jepang, ka-
rena proxy tsb berada di
Jepang.

dns1.sendai.alsi.co.jp 8080
udah ngga bisa dipakai lagi,
mungkin udah di ban kali
yee...

121
121@telkom.net

Ikon Lari-Lari
T: Posted February 27
Saya punya masalah dengan
ikon (icon) deskstop saya.
Tiap saya mau klik, ikonnya
malah lari?

Kaya'nya kena semacam vi-
rus, tapi saya scan pakai nav
2001koq nggak terdeteksi ya?

Heru
wr-zero@semarang.
wasantara.net.id

J: Posted March 19
Anda adalah korban ketiga
yang telah melapor ke milis
ini. Coba buka registry win-
dows dengan Regedit. buka
key berikut:

Hkey_local_machine\softwa
re\microsoft\windows\curre
ntversion\run . Finally

Cari string key yang men-
jalankan program yang aneh.
Kalo dulu ada yang ngomong
adalah program Function.exe.

btw... , kalo bisa kirim ke
saya program tsb via japri.
sayoonara

ÇäkrabiRâwÄ
digitalchandra@yahoo.com

Perl, Php, JavaScript
T: Posted March 1
Saya mau tanya nich ttg
language program yang
ada sekarang.

Saya sering dengar ttg ba-
hasa Perl, Php, JavaScript,
Python, namun saya nggak
tahu tentang fungsi dan ke-
gunaan bahasa tersebut.

Ferdinand Manorsa
ferdinand_ms@yahoo.com

J: Posted February 6

Perl, Python, PHP, JavaScript
adalah bahasa pemrogram-
an yang kebanyakan dipakai
untuk WEB.

Perl, Python, PHP diproses
di server (server-side). Java-
Script diproses di browser
(client-side).

Rio
flush@telkom.net

Edisi Lama NeoTek
T: Posted March 2
Gimana step-step untuk
menyiapkan HDD untuk
diinstall Linux (saya renca-
na mau pake Mandrake

sesuai saran pakar-pakar di
milis ini). Apa di-fdisk dulu,
atau apa? Saya nggak keba-
yang soalnya boot sector-
nya khan harus bekerja di
bawah linux, sedangkan fdisk
kan bawaannya DOS.

Amil Luthfi

amil.l@link.net.id

J: Posted March 4
Pertama komputernya dulu.
Mandrake disiapkan untuk
komputer Pentium dengan
RAM minimal 32 Mbyte.
Prakteknya baru enak kalau
minimal Pentium 400 MHz
dengan RAM 64 Mbyte dan
hard disk tersisa jangan ku-
rang dari 3 Gbyte.

Hard disk yang sudah ada
partisi Windows-nya itu
(FAT32 atau vfat menurut
istilah Linux) mula-mula
harus dibersihkan dari error
dengan scandisk. Setelah itu
rapikan dengan defrag.

Setelah itu tinggal instalasi.
Masukkan CD Mandrake ke
CD drive dan boot ulang dari
CD (kalau komputer tidak
bisa boot dari CD, harus buat
boot disk Mandrake dulu).

Tidak perlu pakai Partition
Magic sebab Mandrake su-
dah punya utilitas partisi
sendiri yang serupa.

Semua ini dijelaskan pada
NeoTek Edisi Khusus Man-
drake 8.0 yang akan terbit
April 2002.

J: Posted March 4
Karena pada hard disk anda
sudah ada Windows, maka
yang pertama kali harus di-
lihat apakah masih ada cukup
tempat kosong.
Akan diminta memilih in-
stalasi secara Recommend-
ed atau Expert. Cara Recom-
mended akan secara oto-

matis berjalan sendiri dan
Mandrake Installer akan
menetapkan parameter2
yang dianggapnya ideal
berdasarkan kapasitas kom-
puter anda. Saya sendiri
lebih suka pilih Expert
sebab bisa lebih mengen-
dalikan proses instalasi ini.
Nanti akan tampil diagram
hard disk anda. Kalau cuma
punya satu hard disk ide
akan tampil hda dengan
warna biru (menandakan
sudah diisi oleh Windows,
partisi FAT32 atau vfat
namanya di Linux).
Partisi ini yang akan kita
kurangi ukurannya. Ku-
rangi dengan menggeser
slot lewat mouse dari
misalnya 10 Gbyte jadikan
7 Gbyte (asumsi bahwa
baru terisi oleh Windows
kurang dari 7 Gbyte;
sisakan untuk Windows
sekitar 1 Gbyte deh).
Selanjutnya buat partisi
untuk Linux. Tinggal pilih
menu kok. Yang mesti
disiapkan adalah:
a. Partisi Linux Native

dengan mount point
/boot (kasih 25 mbyte
aja). Ini adalah primary
partition. Warna partisi
ini merah.

b. partisi swap dengan
ukuran 512 Mbyte.
Hijau

c. Partisi Linux Native
dengan mount point /
(ambil sisanya sehingga
2 Gbyte lebih)

Klik Done dan akan di-
minta untuk memformat
partisi2 itu. Awas: jangan
sekali2 format partisi
Windows di sini!
Selanjutnya ikuti deh
langkah2nya. Gampang kok.

Kosasih Iskandarsjah
kosasih_iskandarsjah@yahoo.com
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3 HALAMAN FILES
Di sinilah file-file bocoran atau file
lainnya ditempatkan. Kebanyakan
berformat PDF karena merupakan
naskah (yang asalnya berformat
Quark/QXD) yang telah di-save
menjadi file PDF. Klik salah satu file
yang anda perlukan.

aat menjawab pertanyaan Neo-
Teker yang dilayangkan di milis
NeoTek (http://groups.yahoo. com/

group/majalahneotek), redaksi kadang
‘bermurah hati’ membocorkan isi majalah
yang belum dijumpai di pasar alias isi
yang masih dalam persiapan. Biasanya isi
atau artikel yang dibocorkan itu sudah
dapat anda baca (karena dikemas dalam
format PDF) dan dapat anda download
dari milis NeoTek yang alamatnya
diberikan di atas.

Lalu di manakah bocoran itu ditempatkan
oleh Redaksi. Ikuti uraian langkah per
langkah di bawah untuk dapat menemu-
kan tempat ‘persembunyian’ bocoran itu.

SSSSTT... I... INNI LHI LHO BO BOOCOCORRANAN
CCARARA MA MEENNCCARARI BI BOOCOCORRANAN
DDI MI MIILILIS NS NEEOOTTEEKK
Di milis NeoTek, dari waktu ke waktu Redaksi NeoTek
memberikan bocoran isi majalah ini untuk nomor yang
belum terbit, lengkap dengan artikelnya. Tetapi di mana
menemukan bocoran itu? Inilah jawabannya.

S

FILE PDF
Jika anda klik salah satu file berfor-
mat PDF, Internet browser anda
akan memanggil program Acrobat
Reader untuk membuka file PDF
yang anda klik itu. Pada gambar di
atas terlihat salah satu artikel pada
edisi khusus NeoTek ‘Mandrake 8.0’
yang telah dibuka.

BERPARTISIPASI
Sebagai anggota milis, anda pun
dapat berpartisipasi mengisi file
yang kiranya berguna untuk Neo-
Teker lain. Untuk itu anda perlu
melakukan Sign In. Lalu pada
halaman Files, klik ‘Add File.’

MASUK KE SITUS NEOTEK
Arahkan browser anda ke situs
NeoTek di www.neotek.co.id atau
neotek.kpone.com.sg. Lalu cari
dan klik link Mailing List di kolom
kiri halaman awal.

LINK FILES
Setelah mengklik link Maliling List, anda
akan diantar ke layar link berikutnya
yang jika anda klik akan membawa
anda ke halaman di atas. Berikutnya
anda harus mengklik Files untuk
sampai pada halaman seperti pada
Langkah 3.

1

4 5

2

Sst... Ini bocoran untuk disebarkan!

MENG-UPLOAD FILE
Inilah halaman untuk anda me-
nambahkan dan mengirimkan file
yang akan anda berikan di milis.
Tentunya para NeoTeker berharap
anda tidak menyumbangkan file
yang nggak-nggak atau bervirus
‘kan?

6
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IKA KITA MENENGOK kembali
ke tahun 60an, ketika ukuran
komputer masih sebesar ru-

mah dan hanya dioperasikan oleh orang-
orang berjanggut dengan tumpukan
kartu berlubang, orang belum menge-
nal yang namanya sistem operasi (SO).
Pemrogram terlebih dahulu harus
menciptakan environment, kemudian
mereka membuat aplikasi untuk men-
jalankannya. Untuk itu diperlukan ba-
nyak kartu berlubang dan juga berar-
ti sebuah aplikasi yang diciptakan un-
tuk suatu sistem barangkali tidak akan
bekerja pada sistem lainnya, bahkan
sistem dari pabrikan yang sama. Keada-
an ini tidak dapat dibiarkan berlanjut
dan pada tahun 1969 sepasang insinyur
dari Bell Labs-nya AT&T menciptakan
sebuah sistem operasi bernama Unix.

Unix memberikan pengguna cara yang
standar untuk berinteraksi dan me-
ngendalikan komputer mereka. Walau-
pun demikian, standar ini bukan stan-
dar sama sekali; sejumlah proprietary
mirip Unix muncul, diciptakan oleh
pabrikan perangkat keras yang beru-
saha keras ‘mengunci’ pengguna agar
tidak lari dari barang produksi mereka.
Satu-satunya kemiripan yang dimiliki
berbagai standar ini adalah semua
barang tersebut luar biasa mahalnya.

Kemudian pada tahun 1991, seorang
mahasiswa dari Helsinki mulai

membuat SO compliant Unix—”seka-
dar hobi” tulis si remaja Linus Trovald
pada sebuah newsgroup—yang akan
dirilis di Internet dan didistribusikan
gratis sebagai sebuah perangkat lunak
open source. Projek ini kemudian di-
ambil alih oleh para tukang oprekkomputer,
hacker dan wiraswasta yang berpen-
ciuman tajam. Linux, seperti yang ke-
mudian dikenal orang, makin luas
jangkauan serta kecanggihannya. Wa-
laupun baru berada pada tahap awal,
cuma menarik untuk para pemrogram,
mereka sudah berupaya mengembang-
kan aplikasi yang akan mempermu-
dah pengguna non-teknis untuk me-
masuki dunia Linux. Diperkirakan
bahwa Linux kini digunakan pada se-
kitar 7% PC di dunia dan berkembang
lebih cepat dibandingkan SO lain.

Apa yang Dapat Dilakukannya?
Seperti SO lain, Linux memungkin-
kan pengguna mengendalikan kom-
puter mereka yang digunakan untuk
menjalankan sejumlah aplikasi sehingga
kepemilikan komputer itu tidak sia-
sia. Mulai dari office suite yang leng-
kap dan piranti grafik sampai desain
Web dan games, Linux dilengkapi de-
ngan semua jenis aplikasi apa pun
yang dapat anda bayangkan—bahkan
ada yang tidak terbayangkan. Linux
terutama populer untuk pekerjaan

yang bersifat ‘kritis’ sehingga memer-
lukan kestabilan dan keamanan—
seperti mengoperasikan situs World
Wide Web dan e-commerce.

Kekurangan dari SO ini adalah, di
masa lalu, Linux telah dicap sulit un-
tuk diinstal dan digunakan untuk
kebanyakan pengguna. Tetapi kesan
itu kini sudah mulai berubah setelah
‘wajah’ Linux lebih bersahabat. Linux
kini menyeruak memasuki mainstream.

Selain dapat menjadi SO multitasking
(Linux dapat melakukan lebih dari
satu tugas sekaligus), Linux juga bisa
digunakan untuk multiuser. Pada se-
buah kantor ini berarti bahwa satu
server dapat menangani berbagai apli-
kasi pada waktu bersamaan: direktur
keuangan mungkin mem-browse data
keuangan perusahaan sementara se-
kretarisnya diam-diam bermain Quake
di ruang yang lain. Bagi pengguna di
perumahan, multiuser berarti bahwa
masing-masing anggota keluarga da-
pat mengatur keperluannya sendiri di
komputer keluarga—termasuk apli-
kasi, desktop theme, dsb—tanpa
mengganggu apa yang sudah diatur
oleh yang lain.

Hebat, Tetapi Berapa Biayanya?
Hal yang revolusioner pada Linux-di
samping kenyataan bahwa SO ini
tidak crash setiap lima menit sekali-

J

PPenganan Apa Pula Ini?enganan Apa Pula Ini?
LinuxLinux

Jika anda tengah membaca artikel ini berarti anda masih ingin tahu perihal Linux. Tidak mengapa,
teruskan saja membacanya. Setelah selesai membaca diharapkan anda paham apa yang disebut

Linux itu.
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adalah cara pendistribusiannya. Se-
mentara perusahaan-perusahaan pe-
rangkat lunak raksasa ‘menguras’ isi
pundi-pundi uang anda jika anda ingin
menggunakan sistem mereka, Linux
sebaliknya gratis! Anda dapat men-
download-nya dari Internet (jika anda
cukup sabar dan tidak memperhitungkan
besarnya biaya pulsa). Atau meng-copy-
nya dari teman atau mendapatkan-
nya dari CD seperti CD NeoTek.

Walaupun ‘motif mencari laba’ ber-
peran besar dalam pertumbuhan Li-
nux yang fenomenal ini, sebentuk
penghargaan juga harus dialamatkan
ke sejumlah perusahaan yang telah
menciptakan berbagai ‘distribusi’ yang
memberi pengguna bukan hanya SO
berkualitas tinggi, tetapi juga serang-
kaian perangkat lunak, utilitas, dan
piranti pemrograman yang ‘bernilai
tambah.’

Nama-nama besar dalam distribusi
Linux mencakup Red Hat, SuSE, Co-
rel, dan Debian, tetapi ini semua ha-
nya puncak dari sebuah gunung es
yang amat besar. Masuk saja ke salah
satu mesin pencari (search engine),
ketikkan 'Linux distributions' lalu
bersiap-siaplah untuk terkejut. Distro
bervariasi baik dalam kuantitas mau-
pun kualitas, tetapi kebanyakan dibe-
rikan gratis atau open source dan da-
pat ‘ditekuk’ atau dibentuk sesuai
selera dan kebutuhan anda.

Dapat Dijalankan di Mana?
Salah satu hal yang paling bermanfa-
at dari Linux adalah bahwa SO ini
tidak terikat pada satu platform tunggal.
Jika Windows hanya berjalan di me-
sin Intel (atau klon-nya) dan MacOS
hanya untuk komputer Apple, maka
distro Linux praktis dapat digunakan
pada semua platform.

Versi x86 dapat diinstal pada komputer
486 (atau bahkan 386) sehingga Linux

ideal untuk mesin tua, tetapi Linux
pun masih dapat memanfaatkan sisa-
sisa kejayaan Pentium III terakhir. Se-
lain itu juga ada ‘flavor’ untuk Moto-
rola prosesor 680x0 (Amiga dan Atari
ST), workstation Sun Sparc, Power PC
(Mac dsb), mesin MIPS 83000/4000
(workstation Silicon Graphics) selain
juga mainframe seperti IBM S/390.

Ketrerbukaan kernel Linux—di sam-
ping dedikasi para peminat perangkat
lunak—adalah alasan di balik mudah-
nya Linux dijalankan pada semua plat-
form, tetapi hasilnya adalah bahwa
anda dapat memperpanjang usia
komputer tua anda, sambil tetap da-
pat menggunakan perangkat lunak
mutkahir.

Jadi Linux Itu Program Perangkat
Lunak?
Walaupun sering disebut sebagai
program tunggal, instalasi Linux se-
benarnya berupa kumpulan perangkat
lunak, yang pada intinya terdapat
kernel-nya. Untuk dapat memahami
kernel anda barangkali memerlukan
ilmu pengetahuan komputer. Untungnya,
anda dapat menyederhanakan segala
sesuatunya dengan menginstal sebuah
shell yang akan bertindak sebagai
perantara pengguna dengan kernel.

Shell itu ada dua jenis: command line
interpreter (CLI) dan graphical user
interface (GUI). Yang lebih membi-
ngungkan lagi, kedua jenis shell mem-
punyai versi sendiri-sendiri. CLI bisa
disamakan dengan MS-DOS yaitu
anda memberikan perintah kepada
SO dengan mengetikkan frasa-frasa
yang ganjil seperti ‘echo $SHELL.’
Lalu anda tinggal duduk menantikan
hasilnya. CLI bisa menjadi instrumen
yang hebat, tetapi jika ingin sesuatu
yang konkret, anda memerlukan GUI.

Apakah Desktop Environment Itu?
Desktop environment sebenarnya ada-
lah apa yang tampil di hadapan anda
sepanjang hari. Sebenarnya desktop
yang asli adalah KDE, tetapi ketakse-
pakatan perihal arah dari projek Linux
dan, lebih khusus lagi, masalah lisen-
si source code-nya, membuat satu ke-
lompok coder menyempal. Mereka
menciptakan GNOME Foundation
yang khusus memproduksi perangkat
lunak gratis di bawah protokol GNU.

Baik GNOME maupun KDE dapat me-
lakukan pekerjaan yang membangga-
kan. Keduanya dapat memberikan
environment yang stabil, customis-
able, dan intuitif untuk Linux, dan,
yang juga penting, memberikan jalan

yang mudah bagi pengguna Windows
yang ingin bermigrasi ke Linux.
GNOME, seperti pesaingnya, sebenar-
nya lebih dari sekedar desktop karena
dapat memberikan platform pengem-
bangan—serta instrumennya—sehing-
ga coder dapat menciptakan sejumlah
aplikasi standar yang kemudian di-
rilis di bawah lisensi GNU. Sebagian
dari paket itu adalah GNOME Office,
satu set piranti produktivitas yang
mencakup pengolah kata (AbiWord),
lembar kerja (Gnumeric) dan paket
grafik (GIMP).

Baik KDE maupun GNOME meru-
pakan alternatif yang fleksibel dan
menyeluruh terhadap Windows, dan
yang luar biasa adalah jika anda tidak
dapat memutuskan dekstop mana
yang anda lebih sukai, anda dapat
menginstal keduanya dan memilih
salah satu yang cocok dengan selera
anda, tanpa perlu mengeluarkan uang
seperser pun. Dan jika anda menyu-
kai tampilan Windows, MacOS atau
bahkan BeOS (untuk hanya menye-
butkan tiga nama), arahkan saja
browser anda ke www.themes.org. Di
sini anda dapat menemukan ribuan
skin untuk kedua environment itu.

Lalu Apa Kabar Buruknya?
Sisi yang tidak baik selalu ada. Di du-
nia Linux, hal itu muncul dalam ben-
tuk saingan dari Windows dan keinginan
pabrikan PC untuk menghemat biaya.
Setelah prosesor PC menjadi lebih
powerful, pabrikan chip memutuskan
bahwa CPU dapat bekerja jauh lebih
keras dan mengambil alih pengelola-
an sound system, grafik dan modem.
Dua yang disebutkan pertama dengan
mudah dapat digabungkan ke dalam
Linux, tetapi yang ketiga ternyata
menimbulkan problem. ‘Winmodem’
ini ternyata bertumpu pada driver
yang menjadi ‘bagian integral’ dari
Windows (sehingga dijuluki Win-
modem.) Akibatnya modem tidak
cocok untuk Linux. Walaupun masa-
lah ini sudah mulai dapat diatasi—
cek di www.linmodem.org untuk
informasi lebih lanjut—tetapi
prosesnya lambat.

Scanner (dari pabrikan tertentu) juga
tidak dapat dijalankan lewat Linux
karena pabrikan tersebut menolak
untuk melepaskan informasi menge-
nai peralatan mereka yang memung-
kinkan pihak lain menciptakan driver.
Jadi jika anda mempunyai parallel
port UMAX, foto anda akan tidak
dapat di-scan.

• Tampilan KDE sebagai desktop environment



Apakah Saya Dapat Menjalankan
Linux & Windows Bersamaan?
Karena berbagai alasan (seperti yang
disebutkan di atas) banyak orang
enggan membuang OS yang sudah
digunakannya. Berita baiknya adalah
hal itu memang tidak perlu anda la-
kukan: Linux dengan senang hati
akan berjalan berdampingan (walau-
pun bukan pada waktu bersamaan)
dengan Windows atau MacOS.

Dengan menempatkan Linux pada
hard disk, anda dapat men-scan atau
melakukan surfing dengan SO anda
yang lama, sambil beroleh manfaat
dari Linux. Linux dapat mengakses
file dari Windows sehingga anda bah-
kan dapat menggunakan wallpaper
hasil scan atau download dengan
GIMP. Proses penginstalan sistem
boot ganda (dual boot) diawali dengan
mempersiapkan hard disk untuk par-
tisi. Di sinilah kebanyakan orang ter-
bentur masalah karena salah pilih bi-
sa berarti kehilangan data, tetapi ba-
nyak distro modern yang mempunyai
piranti (tools) khusus untuk membantu
anda. Jadi sebenarnya tidak terlalu
mengecilkan hati. Selanjutnya, perang-
kat lunak itu memformat partisi yang
baru anda buat itu (komputer mem-
punyai sistem alokasi file sendiri), dan
mulai menambahkan sistem operasi-
nya serta—jika anda telah memilih-
nya—berbagai piranti pengembangan
(development tools), aplikasi dan games.
Itulah keseluruhan ceritanya. Selanjut-
nya saat mem-boot komputer, anda
akan disuguhi sebuah menu yang
mempersilakan anda memilih salah
satu SO untuk mem-boot. Karena PC

sudah sedemikian canggih dan rumit,
anda akan menjumpai banyak masa-
lah. Tetapi pada kebanyakan kasus,
prosesnya tidak lebih memusingkan
dibandingkan menginstal Windows.

Apakah Linux Dapat Menjalankan
Perangkat Lunak Windows?
Ya dan tidak. Jika anda ingin ‘murni’
menggunakan Linux dan menying-
kirkan Windows sama sekali, tetapi
masih membutuhkan satu atau dua
aplikasi Windows yang vital, cobalah
WINE (www.winehq.org), program

kecil yang bertindak sebagai interpreter
antara aplikasi Windows dan Linux.

Para pengguna bisa menceritakan se-
jumlah kisah keberhasilan dengan Li-
nux, termasuk menjalankan Word 2000
dan Excel 2000. WINE menjalankan
fungsinya dengan baik dalam banyak
hal. Perusahaan seperti Corel  meng-
gunakan WINE sehingga dengan ce-
pat memigrasikan aplikasi Windows
mereka ke platform Linux. Walaupun
WINE belum sempurna—dan mungkin
tidak akan pernah sempurna—pro-
gram kecil ini memang dapat mem-
pertahankan aplikasi penting tanpa
harus mempertahankan SO-nya. Al-
ternatif lainnya adalah VMWare yang
merupakan emulator perangkat keras
PC yang bekerja di bawah Linux. Teta-
pi VMWare perangkat lunak komersial
sehingga anda harus membelinya.

Apa yang Berikutnya?
Industri komputer bergerak dengan
cepat, dan Linux bukan kekecualian.
Perbedaannya adalah evolusi SO yang
satu ini digerakkan oleh pengguna dan
terbuka bagi semua pihak. Perkembangan
Linux berjalan ngebut. Perkembangan
dukungan perangkat keras digenjot
oleh banyak pabrikan yang kini
bersedia mendukung Linux. Sedangkan
perangkat lunak yang berjalan di
Linux makin baik saja setiap hari.

Inilah saatnya yang tepat bagi anda
untuk terlibat dengan komunitas
yang menyenangkan ini. Jadi apa lagi
yang anda tunggu?
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Dunia komputer amat menyenangi
akronim dan, khususnya jika
berkaitan dengan lisensi, anda bisa
dimaafkan jika berpendapat bahwa
orang-orang komputer ini sudah
agak keterlaluan…

GPL (General Public License) men-
jamin hak anda untuk menyalin
(copy) dan mengubah perangkat
lunak gratisan. Perangkat lunak GPL
harus selalu menyertakan source
code agar pengguna dapat membuat
perubahan. LGPL adalah versinya
yang lebih sederhana yang me-
mungkinkan link ke modul-modul
perangkat lunak yang tidak gratis.
NPL adalah Netscape Public Licence
yang menjadi payung dari Mozilla.
Artinya adalah walaupun Mozilla
gratis untuk digunakan dan diubah,
Netscape dibolehkan menggunakan

hasil kerja apa pun yang dilakukan
di bawah NPL ini dalam program
proprietary mereka. Sudah barang
tentu, yang sebaliknya tidak berlaku.

MPL adalah Mozilla Public Licence
dan, seperti NPL, adalah lisensi pe-
rangkat lunak gratis yang mempu-
nyai sejumlah pembatasan.

X11 adalah lisensi penggunaan
Xfree86. Sun Industry Standards
Source Licence (SISSL) digunakan
untuk mengembangkan OpenOffice
dengan bekerja sama dengan lisensi
GPL yang lebih sederhana.

Lisensi yang bermacam-macam itu
hampir sama banyaknya dengan dis-
tro Linux itu sendiri. Jika anda me-
merlukan atau ingin mendapat lebih
banyak informasi, arahkan browser
anda ke www.opensource.org.

Lisensi

Inilah beberapa hal yang harus ada
di hard disk anda. GNU Image Mani-
pulation Program, atau GIMP adalah
Photoshop-nya dunia Linux, dan
merupakan piranti yang ideal untuk
memanipulasi foto dan membuat
gambar. Selain dilengkapi peralatan
seperti biasanya—kuas, pensil dan
piranti kloning—GIMP juga men-
dukung alpha channel dan layer se-
hingga montase gambar dapat dila-
kukan dengan cepat. GIMP juga
dapat menggunakan plug-in untuk
meningkatkan fungsinya. Ada lebih
dari 100 plug-in yang disediakan
gratis di Internet.

OpenOffice adalah versi open source
dari StarOffice-nya Sun dan mem-
punyai pengolah kata serta lembar
kerja yang mumpuni. Terakhir ini
diumumkan rencana untuk mema-
sukkan OpenOffice ke dalam envi-
ronment GNOME. Pengguna KDE
mungkin juga dapat mencoba

Koffice sebagai alternatif.

Jika anda pernah mencoba Netscape
dan merasa browser ini dapat dian-
dalkan, cobalah Mozilla. Browser
yang cepat dan dapat customisable
menjadi dasar dari Netscape 6.1 dan
dapat diambil gratis dari
www.mozilla.org.

Xmms memungkinkan anda memu-
tar semua lagu berformat MP3 yang
di-download dari Internet, sementa-
ra Xripper memungkinkan anda meng-
ubah koleksi lagu CD anda menjadi MP3.

Pecandu Civilization bisa memperoleh
game ini dari FreeCiv yang, jika te-
lah anda kumpulkan semua, boleh
di-download gratis.

Akhirnya, sejumlah game komersial
berkualitas top—termasuk Quake
III, Arena, Tribes2, Sim City 3000—
akan menantang keterampilan pecandu
game yang paling terampil sekalipun.

Perangkat Lunak, yang Dasar-Dasar
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AGI PARA PENGGEMAR KOMPUTER
yang belum mengetahui, open
source adalah gerakan atau

aliran dalam dunia komputer yang me-
lepas atau membuka listing program
atau source code-nya bagi para pema-
kai lain. Artinya seseorang yang meng-
gunakan software open source, bukan
hanya terbatas sebagai pengguna saja,
akan tetapi dapat melihat semua list-
ing programnya, mempelajari cara kerja
software, mengubahnya, bahkan mem-
perbaikinya dan memberikannya kem-
bali ke pengguna lain.

Salah satu yang sangat monumental
dalam gerakan Open Source adalah
Linux. Linux dikenal sebagai motor
paling besar dalam gerakan open source
ini. Bagi anda yang ingin mempelajari
cara kerja program, sangat disarankan
untuk bermain dengan menggunakan
Linux dan berbagai aplikasi yang dija-
lankan di atasnya. Jangan kaget kalau
ternyata ilmu yang anda peroleh dari
ngutak-ngatik software open source
tersebut ternyata sangat canggih, dan
sayangnya tidak akan dapat di peroleh
di bangku sekolah manapun di Indonesia.

Dalam tulisan ini, saya akan berfokus
pada teknik mencari software open
source, dan menginstalnya di kompu-
ter yang berbasis Linux Mandrake
8.0. Yang agak memberatkan kantong
terutama pada saat mencari software
tersebut, karena anda harus mendown-
load file yang cukup besar, mungkin
rata-rata sekitar 1-2Mbyte. Oleh ka-

rena itu, sangat disarankan untuk
mengakses Internet pada jam 4-6 pagi
pada saat traffic sangat rendah, se-
hingga kita dapat memperoleh apa yang
kita inginkan dengan cepat.

Secara umum software open source
biasanya akan tersimpan dalam
beberapa format, yaitu:

• RPM—format instalasi RedHat, ju-
ga dipakai oleh Mandrake, Caldera dll.

• tar.gz—format kompresi dan pembun-
delan file.

• zip—format kompresi dan pembun-
delan file, biasanya untuk Windows
(bukan Linux).

Teknik Mencari Software Open
Source
Secara umum teknik mencari software
open source di Internet sangat mudah,
melalui berbagai portal dan search
engine di Internet dapat dilakukan
dengan mudah, terutama jika kita
pandai memilih keyword yang benar.

Pada kesempatan ini, ada empat (4)
portal / search engine yang saya pikir
lumayan baik untuk tempat mencari
software open source, yaitu:

• www.google.com
• www.linux.org
• www.sourceforge.net
• www.freshmeat.net

Google merupakan search engine fa-
vorit saya. Asalkan kita pandai memi-
lih keyword yang tepat, anda akan

dengan mudah memperoleh apa yang
anda inginkan. Beberapa contoh key-
word yang akan sangat membantu,
seperti:

• linux source portal—akan mem-
berikan daftar portal yang memba-
wa informasi tentang source Linux.

• Intrusion detection open source—
akan memberikan berbagai software
open source untuk mendeteksi
cracker yang masuk ke sistem.

• Open source firewall—memberikan
daftar firewall open source.

Bagi yang ingin langsung memperoleh
daftar software open source yang jalan
di atas Linux, ada baiknya untuk me-
lihat-lihat portal www.linux.org →
application. Di bagian application, kita
dapat melihat berbagai aplikasi yang
jalan di atas Linux yang sudah di bagi-
bagi berdasarkan jenisnya, apakah itu
administrasi sistem, multimedia, gra-
fik, office, dll.

PrProgrogramam OpenOpen SourSourccee daridari InternetInternet
MencMencari & Menginstalari & Menginstal

Belakangan ini ada sebuah gerakan yang menghadirkan gelombang gairah baru di kalangan pengguna
komputer.  Nama gerakan itu adalah open source yang salah satu produknya adalah Linux. Onno W.
Purbo menyajikan kiat mencari sumber-sumber di Internet yang menyediakan program open source,

bukan hanya untuk Linux, tetapi juga untuk Windows.

B

• www.google.com
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Pada Linux.org
juga kita dapat me-
lihat berbagai apli-
kasi yang menjadi
favorit di kalangan
pengguna Linux.

Sourceforge.net
merupakan tempat
penyimpanan lebih
dari 35.000 software
open source project.
Kemungkinan bagi
anda untuk mem-
peroleh software
open source yang
sangat baik sangat-
lah mungkin di
sourceforge.net.
Software open sour-
ce bukan hanya
Linux tapi juga cu-
kup banyak yang
berjalan di atas sis-
tem operasi Windows.

Salah satu fasilitas
untuk melihat soft-
ware yang paling
populer adalah fa-
silitas top projects
yang disediakan
sourceforge.net.
Melalui fasilitas
top project anda
akan lebih mudah
memperoleh soft-
ware yang baik.

Situs open source
lain yang akan banyak membantu pencarian software open
source adalah www.freshmeat.net.

Instalasi Software Open Source
Bergantung pada jenis source yang anda peroleh apakah itu
dalam format RPM atau tar.gz, maka teknik instalasinya
akan berbeda.

Jika anda memperoleh software dalam paket dengan eks-
tensi RPM, maka anda cukup beruntung karena biasanya
cukup mudah untuk menginstal-nya. Biasanya paket RPM
didesain untuk distribusi tertentu, misalnya RPM untuk
Linux Mandrake biasanya menggunakan ekstensi mdk.rpm.

Ada dua program di Linux Mandrake yang dapat diguna-
kan untuk menginstal paket RPM, yaitu:

• Package manager—ada di Start > configuration > packaging.
• Software manager—ada di desktop.

Untuk menginstal sebuah paket RPM melalui package ma-
nager cukup mudah, kita tinggal menggunakan file dan
mencari file RPM-nya kemudian akan diinstal. Biasanya
package manager juga akan mencek dulu apakah paket
RPM tersebut tergantung pada paket RPM lainnya. Jika
tergantung, ada baiknya menginstal juga paket RPM yang
lain tersebut agar software yang kita instal dapat berjalan.

Package manager sangat baik jika kita menginstall RPM
yang bukan termasuk dalam distribusi CD Linux Mandrake
yang kita punya, misalnya RPM software yang kita down-
load dari Internet.

Program lain yang juga dapat digunakan untuk menginstal
maupun mendelete RPM adalah software manager. Icon
software manager dapat mudah dilihat karena terdapat
pada desktop Linux pada window KDE.

Berbeda dengan package manager, software manager lebih
mudah digunakan untuk menginstalasi RPM yang terdapat
dalam CD distribusi Linux Mandrake. Jadi misalnya kita
terlupa, atau ingin menginstal software tambahan yang ada
di CD distribusi Linux Mandrake maka dengan mudah dapat
dilakukan dengan software manager tersebut. Kita dapat
melihat seluruh daftar software yang ada di CD 1 dan CD
2 Mandrake yang belum sempat terinstal pada bagian
installable, pemilihan dapat dilakukan dengan mengklik
RPM yang kita inginkan.

Jika kita ingin melihat seluruh pilihan software yang ada,
kita dapat melakukan dengan mengklik flat list, bukan tree
view. Anda dapat memilih secara langsung dari ribuan paket
RPM yang tersedia. Cukup memabokan bagi para pemula
yang baru saja menggunakan Linux, akan tetapi cukup mem-
berikan inspirasi betapa luasnya dunia Open Source.

Setelah RPM yang kita inginkan di pilih, klik tombol install
untuk menginstall RPM yang di inginkan & software open
source yang di inginkan akan terinstall dengan baik.

• www.linux.org/apps/index.htm

• http://sourceforge.net

• www.freshmeat.net
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Bagian yang tersulit untuk dilakukan adalah menginstalasi
langsung dari source code software-nya, biasanya source
code tersimpan dalam format  tar.gz. Untuk melakukan hal
ini C compiler pada Linux Mandrake harus terinstal. Com-
piler C yang digunakan pada Linux Mandrake adalah gcc
(GNU C Compiler).

Jika anda memang berniat akan banyak meng-compile
source code, sebaiknya pada waktu pertama kali instalasi
Linux Mandrake pilih paket development. Jika Linux Man-
drake telah terinstall dapat juga dilakukan melalui software
manager kita pilih agar paket development di instalasi,
kemungkinan gagal-nya akan lebih besar jika instalasi
compiler dilakukan sesudah Linux Mandrake di instal.

Jika compiler C (gcc) telah terinstall dengan baik, langkah
selanjutnya adalah menginstalasi software tar.gz tersebut.
Langkah yang perlu dilakukan sebetulnya cukup standar,
yaitu:

1. copy-kan paket-software.tar.gz ke directory /usr/local/src.
2. pindah cd /usr/local/src
3. lakukan perintah

# tar -zxvf paket-software.tar.gz

setelah perintah ini dilakukan maka software akan di
uncompress dan akan disimpan pada direktori
/usr/local/src/paket-software.

4. pindah ke cd /usr/local/src/paket-software.
5. lakukan konfigurasi software, ada beberapa cara yang

dapat digunakan tergantung bawaan instalasi software-
nya, yaitu:

# ./configure

atau

# make config
pada proses konfigurasi software akan men-cek berbagai
subroutine / library yang dia butuhkan maupun setting
yang kita inginkan. Biasanya jika library yang dibutuh-
kan tidak tersedia, akan diminta agar di install terlebih
dulu.

6. setelah konfigurasi dilakukan langkah selanjutnya ada-
lah mengcompile sorce code, yaitu dengan:

# make

atau

# make all

7. setelah semua source code tercompile dengan baik,
langkah selanjutnya adalah menginstall objek code
maupun binary yang dihasilkan ke sistem Linux yang
kita gunakan. Hal ini dapat dilakukan dengan mudah
juga, yaitu:

# make install

Selesai sudah semua proses instalasi, kita dapat menggu-
nakan software yang kita instal. Biasanya software tersebut
terinstal di directory /usr/bin, /usr/sbin, /usr/local/bin atau
jika kesulitan ada baiknya menjalankan perintah # locate
nama-software.

Keuntungan meng-compile sendiri paket software
terutama kita dapat membaca source code, dan mengerti
dengan baik cara kerja softweare yang kita instal. Di
smping itu ada banyak hal biasanya yang tidak tertulis di
dokumentasi software yang hanya dapat dibaca di source
code maupun file INSTALL atau README bawaan
software. Selamat mencoba.

DEKOMPRESI
Instalsai source code hasil down-
load dengan ekstensi tar.gz dimu-
lai dengan ekstraksi file dengan
perintah tar -zxvf program.tar.gz
yang akan membentuk direktori
program yang berisi hasil eks-
traksi. Lalu pindah ke direktori itu.

KONFIGURASI
Dari dalam direktori itu ketikkan
./configure untuk mengkonfig-
urasi sistem kita sebelum
kompilasi dimulai. Proses ini akan
menghasilkan Makefile dari
Makefile.in yang diperlukan untuk
langkah berikutnya.

1 2 KOMPILASI DAN INSTALASI
Selanjutnya ketik make untuk
mengkompilasi aplikasi ini. Langkah
berikutnya adalah menginstalasi
hasil kompilasi ini dengan menge-
tikkan make install. Sampai di sini
file exetuteable sudah terbentuk
dan siap dijalankan.

3
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UANGLAH PERASAAN
ITU jauh-jauh. Kom-
pilasi kernel tidaklah

sesulit yang anda bayangkan.
Sekarang silakan anda duduk
santai dan biarkan tutorial ini
menunjukkan kepada Anda
bagaimana cara mengkompi-
lasi kernel. Oh ya, anda harus
login sebagai root jika ingin
melakukan kompilasi kernel.

Apa itu Kernel?
Ngomong-ngomong, sebelum
terlalu jauh, apakah sebenar-
nya “kernel” itu? Kernel ada-
lah bagian inti dan paling pen-
ting dari suatu sistem operasi
(operating system),mungkin
sama pentingnya dengan
jantung pada tubuh manusia.
Fungsi dan peran kernel akan
kita bahas kemudian.

Linux Itu... Cuma Nama
Kernel!
Apa yang terpikirkan saat an-
da mendengar kata “Linux”?
Saat mendengarnya, saya
langsung memikirkan sebuah
distribusi Linux (misal Man-
drake, RedHat, dan lain-lain),
lengkap dengan program-
program yang secara bersa-
ma-sama membuat distribusi
ini bisa berfungsi. Namun
sebenarnya, secara teknis,

yang bernama Linux itu ada-
lah kernelnya saja. Sementara
bagian-bagian lain yang biasa
kita sebut Linux (seperti shell
dan compiler) secara teknis
terpisah dari Linux (kernel).
Walaupun banyak orang sa-
lah kaprah menggunakan
kata Linux untuk menunjuk
“distribusi Linux,” tetapi
rasanya semua orang bisa
setuju bahwa Linux adalah
inti dari setiap distribusi.

Fungsi dan Peran Kernel
Interaksi dengan hardware.
Peran utama kernel adalah
berinteraksi secara langsung
dengan hardware dalam sis-
tem anda. Kernel menjadi
perantara (mediator) antara
hardware dengan software
aplikasi dengan memberikan
sebuah lapisan abstraksi (lay-
er of abstraction). Dengan
demikian, software aplikasi
tidak perlu mengetahui seca-
ra rinci spesifikasi mother-
board atau disk controller, te-
tapi mereka cukup meminta
kepada kernel untuk memba-
ca atau menulis file ke disk,
misalnya.

Abstraksi prosesor. Kernel
juga memberikan abstraksi
bagi satu atau lebih prosesor
dalam sistem anda, sehingga

beberapa program bisa tam-
pak berjalan secara simultan.
Ini dikerjakan oleh Linux de-
ngan mengijinkan beberapa
proses untuk berjalan sekali-
gus, dan kernel secara adil
memberikan giliran bagi
setiap proses untuk menggu-
nakan prosesor.

Linux mendukung satu atau
banyak prosesor pada satu
komputer. Kernel anda saat ini
mungkin hanya mendukung
satu prosesor (uniprocessor-
aware, UP-aware) atau sudah
mendukung banyak prosesor
(symmetric multiprocessor-
aware, SMP-aware). Jika anda
menggunakan lebih dari satu
prosesor, tetapi anda menggu-
nakan kernel UP, maka Linux
tidak bisa “melihat” prosesor
tambahan yang anda miliki.
Untuk membuat kernel anda
menjadi kernel SMP, anda
harus melakukan kompilasi
ulang (recompile) kernel dan
mengaktifkan dukungan un-
tuk SMP. Saat ini kernel
SMP juga bisa bekerja pada
sistem dengan satu prosesor,
namun performanya sedikit
lebih rendah.

Abstraksi I/O. Kernel juga
memberikan abstraksi bagi
operasi input-output (I/O)
terhadap file. Bayangkan apa

yang terjadi jika program-
program harus berinteraksi
langsung dengan hardware:
jika anda mengganti hard
disk, semua program anda
akan berhenti bekerja! Un-
tunglah, kernel Linux mengi-
kuti model UNIX dalam
memberikan abstraksi disk
I/O yang sederhana dan da-
pat digunakan oleh semua
program. Dengan cara ini,
anda tidak perlu pusing apa-
kah menyimpan data di dis-
ket, hard disk IDE, SCSI, atau
hard disk di komputer tetangga.

Networking. Untuk anda yang
sering bermain dengan jaring-
an, perlu diketahui bahwa
TCP/IP stack itu terintegrasi
di dalam kernel Linux. Kernel
memberikan high-level inter-
face yang bagus bagi program-
program yang ingin mengi-
rimkan data lewat jaringan.
Di balik layar, kernel berin-
teraksi secara langsung de-
ngan ethernet card atau
modem anda, dan mengurusi
segala detil-detil low-level
dalam komunikasi jaringan.

Proses Booting
Saat sistem Linux anda me-
nyala, kernel yang tersimpan
dalam disk akan dimuat ke
memori oleh suatu boot load-

KKompilasi Kompilasi Kernel Linuxernel Linux
TTuntunanuntunan

Kompilasi (compile) kernel biasanya dilakukan untuk menyesuaikan sistem Linux dengan kebutuhan spesifik
pemakai, atau untuk mengganti kernel dengan versi yang lebih baru. Apakah anda seorang newbie yang

masih merasa ngeri jika mendengar kernel compiling? Agar tidak ngeri, ikuti penjelasan Gatut S.E Ribowo
berikut ini.

B
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er (misalnya LILO). Setelah
berada dalam memori, kernel
akan mengambil alih kontrol
terhadap sistem. Hal pertama
yang dilakukannya adalah
melakukan inisialisasi pada
semua hardware yang ditemu-
kan dan didukungnya. Sete-
lah hardware diinisialisasi de-
ngan baik, kernel siap untuk
menjalankan proses-proses.
Proses yang pertama kali
dijalankannya adalah “init”
(/sbin/init). Lalu “init” men-
jalankan proses-proses lain,
seperti yang tercantum dalam
file /etc/inittab.

Program yang biasanya dija-
lankan oleh “init” adalah “get-
ty.” Tugas program ini adalah
menunggu pemakai login ke
console. “init” menjalankan
beberapa salinan dari program
ini sekaligus. Setelah “getty”
sukses memproses perminta-
an login anda, maka shell
default anda akan dimuat ke
memori (biasanya bash). Be-
gitu berada di dalam bash, an-
da bebas menjalankan program
apa saja yang anda mau.

Walaupun saat ini sudah ada
beberapa proses dalam me-
mori, kernel tetap memegang
kendali. Ia membagi-bagi wak-
tu pemakaian CPU sehingga
setiap proses mendapatkan
bagian yang adil. Kernel juga
terus memberikan abstraksi
hardware dan network
services kepada proses-proses
yang sedang berjalan.

Berkenalan dengan
Modul
Semua kernel Linux keluaran
tahun-tahun terakhir pasti
mendukung “kernel modules,”
atau sering disebut modul
saja.Apa itu modul? Modul
adalah bagian kernel yang
tetap tinggal di disk, sampai ia
dibutuhkan. Saat kernel mem-
butuhkan fungsi dari suatu
modul, maka modul tersebut
akan dimuat dari disk ke me-
mori, lalu secara otomatis diin-
tegrasikan dengan kernel, dan
siap digunakan. Sebaliknya,
jika suatu modul tidak digu-
nakan selama beberapa menit,
maka kernel dapat membuang-
nya dari memori. Proses ini
disebut “autocleaning.”

Kernel modules disimpan
dalam /lib/modules, dan

setiap modul mempunyai
akhiran “.o” pada nama file-
nya. Mungkin anda telah
menduga, setiap modul me-
representasikan komponen
tertentu dari fungsi kernel.
Suatu modul mungkin menye-
diakan dukungan bagi FAT
file system, sementara modul
lain mungkin mendukung
ISA ethernet card tertentu.

Modul memungkinkan peng-
hematan memori yang digu-
nakan oleh kernel. Anda bisa
membuat kernel yang hanya
berisi fitur-fitur yang diper-
lukan untuk booting kompu-
ter anda, sedangkan fitur-fitur
lain dapat diambil dari modul
sesuai kebutuhan. Karena
kernel secara otomatis mem-
bersihkan (autoclean) memori
dari modul yang tidak dibu-
tuhkan, maka tingkat peng-
gunaan memori menjadi sa-
ngat baik sekali.

Peringatan tentang modul.
Tidak semua fitur bisa dile-
takkan dalam modul. Ingat
bahwa modul disimpan da-
lam disk, sehingga bootable.
Kernel image harus secara
built-in mendukung disk
controller dan filesystem yang
anda gunakan (biasanya ext2
filesystem). Jika anda tidak
mengkompilasi dukungan
disk controller dan filesystem
ini ke dalam kernel (tetapi
mengkompilasinya sebagai
modul), maka kernel anda ti-
dak bisa memuat modul ini
dari hard disk.Ya, jadinya me-
mang seperti masalah “ayam
dan telur duluan mana?”

Mendapatkan Kernel
Source
Versi-versi kernel. Sebelum
melakukan kompilasi kernel
versi terbaru, lebih dulu anda
harus men-download source
code dari kernel tersebut (bia-
sa disebut dengan kernel
source). Tetapi sebelum men-
download kernel source ini,
anda harus tahu dulu apa yang
anda cari. Kernel versi “sta-
bil” atau “eksperimental”?

Kernel versi stabil memiliki
digit kedua berupa bilangan
genap, misalnya 2.0.38, 2.2.15,
2.4.1 (digit kedua adalah 0, 2,
dan 4). Sedangkan kernel ver-
si experimental (sering juga
disebut versi development)

digit keduanya berupa bilangan
ganjil. Misalnya 2.1.30 dan
2.3.99 (digit kedua adalah 1
dan 3) merupakan kernel
versi development.

Download dan uncompress
kernel source. Jika anda telah
memiliki kernel source yang
akan dikompilasi, maka anda
tidak perlu melakukan down-
load dan uncompress. Anda
bisa melewati bagian ini dan
melanjutkan ke bagian
berikutnya.

Anda bisa mendapatkan kernel
source dari situs web www.
kernel.org/pub/linux/kernel.
Di sini anda akan menemu-
kan susunan direktori berda-
sarkan versi kernelnya (v2.2,
v2.3, dan lain-lain). Dalam
setiap direktori anda akan
menemukan file-file dengan
nama seperti “linux-x.y.z.tar.gz”
dan “linux-x.y.z.tar.bz2.” Ini-
lah file-file kernel source. An-
da juga akan menemukan
file-file dengan nama seperti
“patch-x.y.z.tar.gz” dan
“patch-x.y.z.bz2.” Ini adalah
file-file patch yang dapat di-
gunakan untuk meng-update
kernel source versi sebelum-
nya. Jika ingin mengkompi-
lasi kernel rilis baru, anda
harus men-download salah
satu file “linux” dengan versi
yang anda inginkan.

Jika kernel source telah di-
download, anda dapat mem-
’bongkar’-nya (karena kernel
source ada dalam format ter-
kompresi). Untuk melakukan
hal ini, pindahlah ke direktori
/usr/src (jalankan cd /usr/src).
Jika di dalamnya terdapat di-
rektori “linux”, ganti nama
(dalam linux: move) direktori
tersebut ke “linux.old” (seba-
gai root perintahkan “mv
linux linux.old.”)

Sekarang, kita akan ekstrak
file kernel source anda yang
baru. Masih dalam direktori
/usr/src, perintahkan tar -
xzvf /tempat/file/linux-
x.y.z.tar.gz atau cat
/tempat/file/linux-x.y.z.tar.bz2
| bzip2 -d | tar -xvf, bergan-
tung pada kompresi file anda
apakah menggunakan gzip
atau bz2. Setelah menjalankan
perintah ini, kernel source
anda akan diekstrak ke dalam
direktori “linux” yang baru.
Hati-hati, kernel source

secara lengkap biasanya ber-
ukuran 50 Mbytes atau lebih.

Konfigurasi Kernel
Sebelum melakukan kompi-
lasi kernel, anda harus meng-
konfigurasi kernel terlebih
dulu. Proses konfigurasi ini
memberi kesempatan pada
anda untuk menentukan
fitur-fitur apa saja yang akan
diaktifkan (enabled) dan yang
tidak akan diaktifkan (dis-
abled). Anda juga bisa me-
ngontrol bagian-bagian yang
harus dikompilasi secara
built-in ke dalam binary
image dari kernel (yang di-
load saat boot), dan bagian-
bagian yang harus dikompi-
lasi sebagai modul (yang di-
load sesuai kebutuhan).

Cara ‘kuno’ untuk konfigura-
si kernel betul-betul mem-
buat pusing. Anda harus ma-
suk ke direktori /usr/src dan
menjalankan make config.
Walaupun cara ini sampai
sekarang masih bisa bekerja,
tetapi lebih baik anda tidak
menggunakan cara ini. Ke-
cuali jika anda tidak keberat-
an menjawab ratusan (benar,
ratusan!) pertanyaan ‘YES/
NO’ pada command line.

Cara baru konfigurasi kernel.
Cara yang lebih modern, bu-
kan mengetikkan make config,
tetapi kita ketikkan make
menuconfig atau make
xconfig. Jika ingin mengkon-
figurasi kernel, ketikkan salah
satu perintah tadi. Perintah
make menuconfig memberi
anda sebuah menu berwarna
dalam mode teks yang dapat
anda gunakan untuk meng-
konfigurasi kernel anda. Pe-
rintah make xconfig memberi
anda interface dalam ling-
kungan XWindow yang da-
pat digunakan untuk meng-
konfigurasi kernel anda.

Jika menggunakan make
menuconfig, opsi-opsi yang
mempunyai tanda “< >” di
sebelah kiri dapat dikompilasi
sebagai sebuah modul. Jika
opsi ini sedang disorot (high-
light), tekan spasi untuk
menentukan apakah opsi ini
tidak dipilih (“< >”), atau
dipilih untuk dikompilasi ke
dalam kernel (“<*>”), atau
dipilih untuk dikompilasi
sebagai module (“<M>”).
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Tips Konfigurasi. Ada banyak sekali opsi
konfigurasi kernel, dan tidak cukup ru-
ang di sini untuk menjelaskannya satu
per satu. Maka anda harus memanfaatkan
fungsi bantuan (help) yang diberikan
oleh proses konfigurasi kernel. Hampir
setiap opsi dijelaskan dengan cukup detil,
dan juga menambahkan keterangan “If
you don’t know what this means, type
Y” (atau mungkin juga “...type N”).
Petunjuk-petunjuk ini membantu anda
terhindar dari masalah jika anda tidak
mengerti apa maksud suatu opsi. Untuk
menggunakan fungsi help, sorot
(highlight) opsi yang membuat anda
bingung dan tekan tombol “?”.

Kompilasi dan Instalasi Kernel
make dep; make clean. Begitu konfigu-
rasi kernel selesai, maka kernel tersebut
siap dikompilasi. Sebelum melakukan
kompilasi, kita perlu membangkitkan
(generate) secara otomatis dependency
information, dan juga membersihkan
bekas-bekas kompilasi sebelumnya (jika
ada).Hal ini dilakukan dengan mengetikkan
perintah make dep; make clean saat anda
berada di dalam direktori /usr/src.

make bzImage. Sekarang waktunya me-
lakukan kompilasi binari image kernel
yang sebenarnya. Ketikkan make bzImage.
Setelah berjalan beberapa menit, kompi-
lasi akan selesai dan anda akan menemu-
kan file bzImage dalam direktori /usr
/src/linux/arch/386/boot (jika anda
menggunakan PC keluarga x86). Kita
akan membahas bagaimana menginstal
kernel baru ini, tetapi terlebih dulu kita
akan membahas mengenai modul.

Kompilasi modul. Setelah kita menda-
patkan file bzImage, sekarang waktunya
untuk melakukan kompilasi modul.
Meskipun tidak mengaktifkan modul
apa pun saat konfigurasi kernel, jangan
anda lewati tahap ini. Sangat baik untuk
membiasakan kompilasi modul segera
setelah kompilasi bzImage. Dan jika anda
memang tidak mengaktifkan modul apa
pun, tahap ini akan berlangsung dengan
sangat cepat. Ketikkan perintah make
modules; make modules_ install. Perintah
ini akan menyebabkan modul terkom-
pilasi dan selanjutnya terinstal dalam
direktori /usr/lib/<versi kernel>.

Selamat! Kernel anda sekarang sudah
terkompilasi secara lengkap. Modul anda
pun sudah terkompilasi dan terinstal.
Sekarang tiba waktunya mengkonfigurasi
LILO sehingga anda dapat mem-boot
komputer anda dengan kernel baru.

Konfigurasi boot
Akhirnya tiba waktunya untuk meng-
konfigurasi LILO supaya ia mampu
booting dengan kernel yang baru. LILO

(LInux LOader) adalah boot loader Linux
yang paling populer dan digunakan oleh
distro-distro Linux yang terkenal. Hal
pertama yang harus anda lakukan adalah
melihat isi file /etc/lilo.conf. Ada satu ba-
ris di dalamnya yang berisi “image=/
vmlinuz”. Baris ini memberi tahu LILO
ke mana ia harus mencari kernel yang
akan di-load.

Agar LILO mampu booting dengan ker-
nel yang baru, anda punya dua pilihan.
Pilihan pertama: timpa kernel anda de-
ngan yang baru. Hal ini cukup berisiko,
kecuali jika anda punya persiapan keada-
an darurat, seperti sebuah boot disk
dengan kernel yang akan anda timpa.

Pilihan kedua, yang lebih aman, Anda
mengkonfigurasi LILO sehingga ia bisa
booting baik menggunakan kernel baru
maupun kernel lama. LILO dapat dikon-
figurasi untuk secara default mengguna-
kan kernel baru saat booting, tapi juga
masih memberi anda pilihan untuk
menggunakan kernel lama jika ternyata
kernel baru masih bermasalah. Ini ada-
lah pilihan yang dianjurkan, dan yang
akan ditunjukkan dalam tutorial ini.

File /etc/lilo.conf anda mungkin
berisi seperti ini:

boot=/dev/hda
delay=20
vga=normal
root=/dev/hda1
read-only
image=/vmlinuz
label=linux

Untuk menambahkan boot entry baru
ke dalam file /etc/lilo.conf anda,
lakukan yang berikut. Pertama, copy file
/usr/rc/linux/arch/386/boot/bzI
mage ke suatu file pada root-directory
(/), misalnya /vmlinuz2. Setelah itu,
copy dua baris terakhir dari
/etc/lilo.conf dan paste ke akhir
file. Hmm... kita sudah hampir selesai.
Sekarang /etc/lilo.conf anda akan
terlihat seperti ini:

boot=/dev/hda
delay=20
vga=normal
root=/dev/hda1
read-only
image=/vmlinuz
label=linux
image=/vmlinuz
label=linux

Ganti baris “image=” yang pertama se-
hingga menjadi “image=/vmlinuz2“.
Lalu, ganti baris “label=” yang kedua
menjadi “label=linux_lama”. Juga pas-
tikan ada baris “delay=20" di dekat awal
file. Jika baris ini belum ada, anda harus
tambahkan. Jika sudah ada, pastikan
angkanya minimal 20.

Setelah perubahan tadi, file
/etc/lilo.conf anda akan terlihat
seperti ini:

boot=/dev/hda
delay=20
vga=normal
root=/dev/hda1
read-only
image=/vmlinuz2
label=linux
image=/vmlinuz
label=linux_lama

Jika sudah sampai pada tahap ini, sebagai
root, jalankan perintah “lilo” pada com-
mand line. Ini penting sekali!  Jika anda
tidak melakukannya, anda tidak akan
berhasil booting dengan kernel baru.

Sekarang kita bahas sedikit penjelasan
mengenai perubahan-perubahan yang
kita lakukan. File /etc/lilo.conf ini diset
untuk mengizinkan anda booting
menggunakan dua kernel yang berbeda.
Anda bisa menggunakan kernel anda
yang lama, disimpan dalam /vmlinuz.
Anda juga boleh menggunakan kernel
yang baru, disimpan dalam /vmlinuz2.
Secara default, komputer anda akan
booting dengan kernel baru (karena ba-
ris “image=” dan “label=” bagi kernel
baru berada pada urutan pertama dalam
/etc/lilo.conf).

Jika, karena alasan tertentu, anda perlu
boot dengan kernel yang lama, cukup
restart komputer anda dan tekan tombol
‘Shift.’ LILO akan mendeteksi penekan-
an tombol ini dan mengizinkan anda
untuk mengetikkan label dari kernel
image yang akan anda boot. Untuk boot
kernel lama anda, ketikkan linux_lama
dan tekan ‘Enter.’ Untuk melihat semua
label yang ada, tekan tombol ‘Tab.’

Selamat! Anda telah berhasil melakukan
kompilasi kernel. Semoga semuanya
berjalan baik-baik saja. Berikut ini adalah
beberapa sumber yang bisa anda guna-
kan untuk mempelajari kompilasi kernel
lebih lanjut:

1. The Linux Kernel HOWTO (biasanya
ada di /usr/doc/HOWTO atau
/usr/share/doc/HOWTO).

2. The LILO, Linux Crash Rescue
HOWTO, cara membuat emergency
boot disk

3. www.kernel.org, situs penyimpanan
kernel source.

Penulis adalah seorang software developer,
tinggal di Bandung. Anggota KLuB (Klub
Linux Bandung) nomor 022-200007-40.
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ayangkan jika Web Amazon.
com yang melayani penjual-
an buku di Internet dibuat

secara statis, anda tidak dapat menca-
ri buku yang sesuai dengan keingin-
an anda. Anda tidak dapat memesan
secara online dan membaca atau
mengirim komentar kepada mereka.

ASP merupakan Server-Side yang
artinya bahwa ASP dijalankan atau
dieksekusi terlebih dahulu di server
sebelum dikirim ke client atau brows-
er anda. Jika anda menemukan hala-
man ASP di Internet, cobalah lihat
source code-nya. Anda tidak akan
pernah menemukan pemprograman
ASP di sana karena source code yang
ada di browser anda merupakan hasil
dari pengolahan scripting di server.

Secara default, ASP menggunakan
bahasa VBScript, yang sintaks dan
cara penulisannya mirip dengan ba-
hasa pemprograman Visual Basic
yang sangat umum. ASP bukan me-
rupakan scripting yang sulit. Jika an-
da pernah mencoba mengutak-atik
Visual Basic, anda akan dapat dengan
mudah membuat ASP. Namun bagi
yang belum pernah dengan Visual
Basic tersebut, tidak perlu bingung
karena kita akan mulai mengenal
ASP dari dasar.

Melalui ASP anda dapat membuat
menu Buku Tamu, Counter, Polling,
Fasilitas Chatting, Forum, Postcard
dan masih banyak lainnya. ASP men-
dukung sekali penggunaan basis data.
Basisdata yang sering digunakan ialah
Microsoft Access dan MySQL. Na-

mun karena kita masih dalam tahap
pengenalan, kita hanya akan memba-
has cara penulisan dan aturan yang
berlaku di ASP. Sebagai catatan, da-
lam membuat tulisan ini, penulis
berasumsi bahwa anda telah menguasai
HTML (walaupun dasar). Dan dalam
membuat ASP, kita memerlukan:

1 Editor seperti Notepad
2 Microsoft  Personal Web Server

yang dapat didownload dari
www.microsoft.com/msdownload/
ntoptionpack/askwiz.asp.

Jika dalam HTML semua perintah
ada di dalam “<” dan “>”, maka kode
ASP menggunakan “<%” dan “%>.”
Marilah kita mulai menciptakan hala-
man ASP pertama kita. Bayangkan,
tergantung dari waktu dalam hari,
anda ingin agar halaman Web menam-
pilkan pesan yang berbeda. Contoh,
jika waktu sekarang pukul 9 pagi, an-
da ingin menampilkan pesan “Sela-
mat Pagi,” dan selain itu anda ingin
menampilkan pesan “Selamat Sore.”
Jika menggunakan HTML biasa, anda
harus mengedit halaman tersebut dua
kali (walaupun mungkin anda bisa
menggunakan scripting seperti Java-
script), namun dengan ASP, anda
dapat menggunakan kode pemrogram-
an untuk menentukan waktu sekarang
dan tampilan pesan.

Pada boks pertama kami sajikan
contoh kode untuk halaman ASP
yang menampilkan pesan yang
berbeda, dengan penjelasan sebagai
berikut.

Penjelasan program:

<HTML> dan <BODY>

Seperti yang anda tahu bahwa dalam
HTML diperlukan dua tag diatas.

Sekarang pukul : <%=Time()%>

Kode di atas merupakan kode untuk
menampilkan waktu sekarang. Time()
merupakan suatu fungsi untuk me-
nampilkan waktu yang di dahului
dengan kalimat “Sekarang pukul:”

<%
If DatePart(“H”, Time()) <= 12 Then

Response.Write “Selamat Pagi”
Else

Response.Write “Selamat Sore”
End If

%>

Kode tersebut merupakan kode untuk
menentukan angka jam pada saat ini,
untuk itu kita menggunakan
DatePart(“H,” Time()). Lihatlah da-
lam sintaks tersebut ada huruf  “H”

B

BerkBerkenalan dengan Aenalan dengan ASSPP
ASP atau Active Server Pages merupakan solusi dari Microsoft untuk membuat halaman web yang

dinamis, yang dapat berinteraksi dengan user (netter). Pada awalnya HTML digunakan untuk
membuat halaman Web yang statis. Namun kini, halaman Web yang statis mulai ketinggalan

zaman. Ingin mengenal ASP? Ikuti uraian David Sugianto berikut ini.

HTML>
<BODY>

Sekarang pukul : <%=Time()%>
<P>

<%
If DatePart("H", Time()) <= 12
Then

Response.Write "Selamat Pagi"
Else If

Response.Write "Selamat Sore"
End If

%>
</BODY>
</HTML>
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yang menunjukan bahwa yang kita
ingin ambil hanya angka jamnya
saja, bukan menit maupun detik. Jika
jamnya kurang dari angka 12 maka
akan menampilkan “Selamat Pagi,”
selain itu akan menampilkan pesan
“Selamat sore.” Fungsi If dan Else If
digunakan sebagai seleksi yang
biasanya kita artikan dengan “Jika,
Selain Itu” dalam kehidupan kita
sehari-hari dan selalu diakhiri de-
ngan End If. Sedangkan Fungsi
Response.Write digunakan untuk
menampilkan tampilan atau kata-
kata. Ingat bahwa kode ASP selalu
dikelilingi oleh karakter "<%" dan "
%>" seperti pada kode di atas.

</BODY> dan </HTML>

Kedua tag di atas menandakan akhir
dari halaman Web.

Hasil dari tampilan di atas berupa :

Selamat anda telah menciptakan
halaman ASP pertama anda.

Untuk menjalankan halaman ASP di
komputer, anda perlu menginstal
Web Server yang mendukung ASP,
dalam hal ini penulis menyarankan
program Personal Web Server (PWS)
yang dapat dijalankan pada Windows
95 dan 98, dan Windows NT work-
station, atau Internet Information
Server(IIS) yang dapat dijalankan
pada Windows 2000 atau Windows
NT Server 4.0.

Setelah Web Server tersebut diinstal,
copy-lah halaman ASP anda ke root
directory yang digunakan oleh Web
Server. Setelah itu bukalah halaman
ASP anda dengan browser anda.

Seringkali muncul pertanyaan yang
diajukan oleh Programmer ASP pe-
mula, antara lain, “Apakah kode ASP
saya dapat dilihat oleh orang lain?”
Jawabnya adalah “Tidak” karena
ketika halaman ASP dikirim ke user,
pekerjaan ASP telah selesai, dan
menghasilkan dokumen HTML biasa
dan itulah yang dikirim. ASP tidak
seperti scripting JavaScript atau
VBScript yang berbasis Client-Side.
Jika anda menggunakan scripting
JavaScript, maka kode-kode scripting
anda dapat dilihat oleh orang lain.
Dan salah satu kelebihan ASP dari
kode scripting lainnya yang paling
mutakhir ialah sistem basisdatanya.

Berikutnya kita akan memfokuskan
pembahasan pada cara penulisan ASP.
Bagaimana cara meletakkan “Komen-
tar.”

Tampilan di browser ialah:

Seperti yang anda lihat pada kode ASP
di atas, perintah ASP selalu dikeli-
lingi oleh <% dan %>. Fungsi
Response.Write digunakan untuk
menampilkan string di browser. Dan
menuliskan kode ASP, cukup disisip-
kan ke kode HTML anda. Contoh 1
dapat pula ditulis dengan cara
berikut:

Hasilnya akan sama dengan hasil
contoh sebelumnya.

Perintah ASP dapat pula digabung
dengan perintah HTML. Misalnya,
anda ingin menampilkan:

“Nama Saya: David.” Kode ASPnya
sebagai berikut:

Dari kode ASP di atas, dapat kita lihat
adanya penggunaan tag BOLD yaitu
<B>. Sebagaimana kita tahu, tag ini
berfungsi untuk mempertebal huruf
yang ada di antara kedua tag ini. Jadi
untuk kata “David” akan tercetak
tebal karena berada di dalam tag
<B>. Namun, kode ASP di atas dapat
pula di tulis pada boks selanjutnya.

Hasil yang akan diperoleh dari kode
boks ini akan sama dengan contoh di
atas. Perbedaannya hanya terletak
pada cara penulisan kodenya saja.
Seperti yang anda lihat, ASP

memberi kebebasan kepada anda

dalam hal penulisan kode, hebat ‘kan?
Ada sesuatu yang anda harus
perhatikan baik-baik, walaupun
dalam penulisan HTML
memperbolehkan tag HTML di
dalam tag yang lain, namun bagi ASP
sangat dilarang menggunakan tag
ASP di dalam tag ASP yang lain.
Kode berikut  akan menyebabkan
error:

<%
<%

Response.Write “Hallo Indonesia”
%>
%>

Mengapa? Karena di dalam <% ter-
dapat <% lagi. Hal ini tidak diperbo-
lehkan dalam penulisan kode ASP.
Berikut ini merupakan contoh penu-
lisan kode ASP sederhana yang sudah
jadi, yang berfungsi untuk menghi-
tung hingga empat.

Hasilnya akan seperti berikut:

Kini anda telah memahami cara
penulisan kode ASP yang benar dan
yang tidak diperbolehkan.

Komentar
Komentar adalah baris yang disisip-
kan ke dalam kode untuk memberi-
kan kemudahan bagi programmer
dan orang lain yang mencoba untuk
mengerti kode tersebut. Dengan kata

Sekarang pukul : 8:20:50 AM

Selamat Pagi

Ini Halaman ASP Pertamaku

<HTML><BODY>
<%

Response.Write “Ini Halaman
ASP Pertamaku”

%>
</BODY>
</HTML>

<HTML><BODY>
<%

Response.Write “Nama Saya:
<B>David</B>”

%>
</BODY>
</HTML>

<HTML><BODY>
<%

Response.Write “Ini Halaman“   
Response.Write “ASP Pertamaku”

%>
</BODY>
</HTML>

<HTML><BODY>
<%

Response.Write “Nama Saya:”
%>
<B>

<%
Response.Write “David”

%>
</B>

</BODY>
</HTML>

<HTML><BODY>
Saya Bisa Menghitung Sampai
Empat

<%
Response.Write “<BR>1”
Response.Write “<BR>2”
Response.Write “<BR>3”
Response.Write “<BR>4”

%>
</BODY>
</HTML>

Saya Bisa Menghitung Sampai 
Empat

1
2
3
4
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lain, komentar merupakan penjelasan
singkat mengenai kode program anda
yang tidak akan dieksekusi oleh
browser. Untuk lebih jelasnya mari
kita ambil contoh.

Seperti yang dapat kita lihat, bahwa
komentar untuk HTML ialah <!--
dan -->, sedangkan dalam ASP, ko-
mentar selalu dimulai dengan tanda
petik ('). Komentar ini tidak akan
dieksekusi, karena sifatnya hanya
penjelasan. Dengan memakai komen-
tar seperti di atas, kita akan lebih mu-
dah memahami program yang kita
buat dan jika ada kesalahan, kita da-
pat menganalisanya dengan mudah.
Hasil dari kode ASP di atas seperti
berikut :

Komentar sebenarnya bukanlah
komponen yang harus ada dalam pe-
nulisan kode ASP. Penggunaan ko-
mentar tergantung dari Webmaster-
nya masing-masing.

Boks terakhir di atas adalah contoh
kode ASP yang telah mencakup se-
mua yang dibahas di atas. Jika anda
jalankan, kode di atas berfungsi
untuk menampilkan tanggal, dan
jam.

Selamat Mencoba!

Jika ada pertanyaan seputar tutorial
ini anda dapat mengirimkan email
anda ke:

david_sugianto2002@yahoo.com

<HTML><BODY>
Sekarang pukul : <%=Time()%>   

<P> <!--ganti baris-->
<%

‘memeriksa apakah jam kurang
dari angka 12
If DatePart("H",Time()) <= 12 Then

'jika jam kurang dari 12, maka
Response.Write “Selamat Pagi”

Else
'selain itu maka           
Response.Write “Selamat
Sore”

'akhir dari If
End If
%>
</BODY>
</HTML>

<HTML>
<BODY>

Hari ini
<!-- tampilkan tanggal saat ini -->
<%

Dim arrHari
'menentukan nama hari dalam
array arrHari = Array
(“Minggu”, "Senin", "Selasa",
"Rabu", "Kamis, "Jumat",
"Sabtu")
Response.Write
arrHari(DatePart("w", Date())
- 1)
'menampilkan tanggal, bulan
dan tahun
Response.Write " " & Date()

%>
</BODY>
</HTML>

Sekarang pukul : 8:30:50 AM

Selamat Pagi

AS-WEB
http://adjat.vze.com

Adjat membuat situs ini sebagai alat untuk memper-
kenalkan kemampuannya di bidang web development. Ia
menawarkan jasa pembuatan situs Web yang “interatif,
dinamis, animatif, dan promotif.” Situs Web yang
dibuatnya dapat ia daftarkan pada layanan webspace gratis
yang kredibel sehingga “anda tidak perlu iuran.” Sebuah
tawaran yang menarik.

Produk

Jika anda membuka situs ini lewat browser anda maka
akan muncul animasi yang menawan. Walaupun belum ada
produk situs hasil ‘produksi’ AS-WEB, Adjat, ketika rubrik
ini ditulis, memberikan contoh karya desainnya lewat
menu ‘Stuff.’ Silakan ‘mencicipi’ hasil karya Adjat untuk
mengetahui kemampuannya.

Mejeng Ala NeoTeker
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AVASCRIPT ADALAH SALAH SATU JENIS BAHASA SCRIPTING
(scripting language) yang dimasukkan ke dalam
dokumen HTML. Bahasa scripting merupakan bagian

“kecil” dari bahasa pemrograman (programming language).
Bahasa scripting dapat dibedakan atas dua kelompok, yaitu

a. Bahasa scripting yang dieksekusi oleh server, disebut server-
side scripting, sangat bergantung pada kemampuan server.
Contoh: ASP (Active Server Pages), PHP (Hypertext
Prepocessor), dan JSP (Java Server Pages).

b. Bahasa scripting yang dieksekusi oleh client (dalam hal ini
browser), disebut client-side scripting, sangat bergantung
pada kemampuan browser. Contoh: JavaScript  dan VBScript.

Javascript  pertama kali dikembangkan oleh Netscape dan kini
telah didukung oleh browser-browser yang kondang seperti IE
(Interner Explorer) versi 4.0 ke atas dan Netscape versi 3.0 ke
atas.

Sebelum Mempelajari JavaScript 
Agar mudah dalam mempelajari JavaScript, berikut adalah hal
yang harus anda perhatikan sebelum mulai mempelajarinya

a. Anda harus mengerti atau setidaknya mengenal HTML.
Javascript ini nantinya akan dituliskan bersama dokumen
HTML, sehingga akan sangat menyulitkan jika anda tidak
mengerti HTML.

b. Anda harus menggunakan browser yang mendukung
JavaScript. Misal, Internet Explorer atau Netscape.

c. Text editor untuk membuat file-file JavaScript maupun
dokumen HTML. Anda bisa menggunakan Notepad, atau
text editor lain.

Keunggulan JavaScript
Dengan JavaScript dapat dibuat suatu dokumen HTML yang
dinamis dan interaktif. Banyak aplikasi yang menarik yang
bisa dibuat dengan Javascript, misalnya saja animasi text, jam,
random image, validasi form dan masih banyak lagi yang lain.

Sintaks Umum
Javascript  dituliskan  langsung  pada  dokumen  HTML  de-
ngan  menggunakan  tag <script>. Statement-statement

ditulis di antara tag  pembuka  dan tag  penutup. Tag <script>
ini berfungsi untuk memasukkan script ke dalam dokumen
HTML secara umum. Sedangkan untuk menentukan bahasa
scripting yang dipakai digunakan atribut type atau language.
Perhatikan contoh sintaks berikut:

atau

Masalah Browser
Sebagaimana telah kita pahami bersama, penggunaan Java-
Script sangat bergantung pada browser. Untuk browser -
browser yang tidak mendukung JavaScript, statement -
statement akan ditampilkan sebagai teks biasa pada dokumen
HTML, tentu hal ini akan sangat mengganggu tampilan
dokumen HTML anda. Untuk menghindari hal tersebut maka
maka dapat digunakan tag komentar HTML <!---  --->.
Sehingga syntaxnya akan menjadi seperti berikut:

Mengenal JavaScriptMengenal JavaScript
Anda mungkin sudah sering kali mendengar tentang JavaScript, tetapi belum tahu fungsi dan cara kerjanya

yang sebenarnya. Untuk anda yang ingin mengenal JavaScript, NeoTek menguraikannya disertai contoh-
contoh yang dapat anda praktikkan langsung.

J

<script type = "text/javascript">
--- statement javascript
--- statement javascript
--- statement javascript

</script>

<script language = "javascript">
--- statement javascript
--- statement javascript
--- statement javascript

</script>

<script language = "javascript">
<!--
---statement javascript
---statement javascript
---statement javascript

-->
</script>
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Secara sekilas masalah telah selesai. Namun ternyata tidak de-
mikian, karena baris terakhir yaitu tag penutup komentar --->
akan dianggap sebagai statement pada browser yang mendu-
kung JavaScript, sehingga mungkin akan memunculkan pesan
error ketika dieksekusi. Untuk menghindari hal ini maka di
depannya diberi tanda dua garis miring (//) yang merupakan
tanda komentar pada JavaScript. Sehingga sintkas umumnya
menjadi seperti berikut:

Penggunaan Tanda Titik Koma
Tanda titik koma ( ; ) digunakan untuk memisahkan statement
yang satu dengan yang lainnya. Penggunaan tanda titik koma
dalam Javascript bersifat opsional, kecuali jika beberapa state-
ment dituliskan dalam satu baris maka penggunaan tanda titik
koma sebagai pemisah menjadi keharusan. Jika tiap statement
ditulis pada baris-baris yang berbeda, maka tanda titik koma
tidak lagi diperlukan. Namun jika tetap dituliskan maka tidak
menjadi masalah.

Perhatikan contoh sintaks berikut:

Komentar Program
Kadangkala komentar atau catatan kecil perlu disertakan pada
JavaScript. Fungsinya untuk memudahkan pemahaman kita
terhadap alur program dalam script. Ada dua cara untuk
memasukkan komentar dalam Javascript, yaitu

a. Komentar satu baris, diawali dengan dua tanda garis miring
( // ). Jika komentar lebih dari satu baris maka, tiap baris
harus diawali dengan tanda //.

b. Komentar lebih dari satu baris, diawali dengan tanda /*
dan diakhiri dengan tanda */.

Perhatikan contoh berikut:

Integrasi ke Dokumen HTML
Sebagaimana dijelaskan di atas, JavaScript merupakan script
yang terintegrasi dengan dokumen HTML. Ada dua cara
untuk menggunakan JavaScript pada dokumen HTML yaitu:

a. Langsung dituliskan pada dokumen HTML bersangkutan
Pada dasarnya JavaScript dapat diletakkan di mana saja dalam
dokumen HTML, namun yang paling sering digunakan yaitu :

Pada bagian kepala dokumen
Yaitu di antara tag <head>. JavaScript pada bagian ini akan
dieksekusi ketika dipanggil, misalnya bila terjadi suatu even
tertentu. Perhatikan sintaks berikut:

Pada bagian badan dokumen 
Yaitu di antara tag <body>. Javascrript pada bagian ini akan
dieksekusi langsung ketika bagian tersebut diload. Perhatikan
sintaks berikut :

Jumlah JavaScript yang bisa dimasukkan ke dalam suatu do-
kumen HTML tidaklah dibatasi, sehingga adakalanya kita
menggunakan JavaScript pada bagian kepala maupun badan
dokumen secara bersamaan. Perhatikan sintaks berikut:

b. Eksternal File
Yaitu dengan menuliskan statement-statement Javascript
dalam suatu file terpisah yang khusus dengan ekstensi file .js
Lalu untuk mengakses file tersebut dari dokumen HTML
masih dengan menggunakan tag <script> dengan tambahan

<script language = "javascript">
<!--

--- statement javascript
--- statement javascript
--- statement javascript

//-->
</script>

<script language = "javascript">
<!--
// syntax berikut benar :

--- statement javascript
--- statement javascript;
--- statement1; statement2; statement3;

// syntax berikut salah :
--- statement1 statement2 statement3

//-->
</script>

<script language = "javascript">
<!--
// ini contoh kementar satu baris
// kalau lebih dari satu baris
// tiap baris harus dimulai dengan tanda //
/* atau bisa juga dengan menggunakan

tanda seperti ini untuk 
memberikan komentar lebih dari satu baris

*/
//-->
</script>

<body>
<script language = "javascript">
<!--

--- statement javascript
--- statement javascript

//-->
</script>
</body>
</html>

<script language = "javascript">
<!--

--- statement javascript
--- statement javascript
--- statement javascript

//-->
</script>

<html>
<head>
<script language = "javascript">
<!--

--- statement javascript
//-->
</script>
</head>
<body>
<script language = "javascript">
<!--

--- statement javascript
//-->
</script>
</body>
</html>
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atribut src untuk menentukan nama file .js bersangkutan.
Perhatikan contoh berikut :

Buat file yang berisi statement JavaScript berikut dengan
Notepad, lalu simpan dengan nama contoh.js 

Maka kemudian jika ingin mengakses file tersebut dari suatu
dokumen HTML sintaksnya adalah sebagai berikut:

Penting untuk diingat bahwa dalam file .js  anda tidak boleh
menyertakan tag <script> karena akan terjadi  error, yang
perlu dituliskan hanyalah statement-statement JavaScriptnya
saja secara langsung.

File Pertama
Setelah mengetahui beberapa hal dasar tentang Javascript seka-
rang marilah kita mencoba membuat sebuah dokumen HTML
yang mengandung JavaScript sebagai latihan. Silakan tulis
dengan Notepad, lalu simpan dengan nama coba.htm.
Jika sudah coba jalankan di browser! Bagaimana hasilnya?

PPeennjjeellaassaann::
Di sini kita telah menggunakan statement document.write()
yang merupakan statement yang digunakan untuk menulis-
kan pada dokumen HTML.

Sekarang mari kita coba jika kita menggunakan eksternal file.
Pertama buat dulu file satu.js seperti berikut dengan Notepad.
Lalu kita panggil dari dokumen HTML dengan cara sebagai
berikut :

Nah, sekarang coba jalankan di browser Anda! Bagaimana
hasilnya? Sama bukan?

--- statement javascript
--- statement javascript
--- statement javascript

<html>
<head>
<script language = "javascript" src="contoh.js">
</script>
</head>
<body>
<script language = "javascript" src="contoh.js">
</script>
</body>
</html>

<html>
<head>
<title>File Pertama Javascript</title>
</head>
<body>
Tulisan ini dibuat dengan HTML biasa.
<br>
<script language = "javascript" src="satu.js">
</script>
</body>
</html>

document.write(“Tulisan ini dibuat dengan Javascript”)

<html>
<head>
<title>File Javascript Pertama</title>
</head>
<body>
Tulisan ini dibuat dengan HTML biasa.
<br>
<script language = "javascript">
<!--
document.write("Tulisan ini dibuat dengan Javascript!")

//-->
</script>
</body>
</html>

EMPELAJARI SUATU BAHASA BARU SANGAT MENANTANG, se-
bab mungkin sulit memahami apa kegunaannya dan
letak bahasa itu bila dipandang secara keseluruhan. Di

bawah ini terdapat sepuluh fakta mengenai JavScript sebagai ba-
han pemahaman dasar sebelum anda mempelajarinya lebih jauh.

1. JJaavvaaSSccrriipptt  MMeelleekkaatt  ppaaddaa  HHTTMMLL.. Mungkin inilah fakta ter-
penting. JavaScript tidak mempunyai user interface sendiri
untuk berinteraksi dengan pemakai.

2. JJaavvaaSSccrriipptt  bbeerrssiiffaatt  BBrroowwsseerr--DDeeppeennddeenntt.. JavaScript semata-
mata hanya bahasa scripting dan bukannya tool tersendiri.
Software yang menjalankan kode-kode JavaScript yang
anda buat adalah Web browser yang mendukungnya.

3. JJaavvaaSSccrriipptt  aaddaallaahh  IInntteerrpprreetteedd  LLaanngguuaaggee..  Seperti kebanyakan
bahasa scripting lainnya, JavaScript diterjemahkan (interpreted)
sewaktu dioperasikan (runtime) oleh browser sebelum
dijalankan (executed).

4. JJaavvaaSSccrriipptt  ssuuaattuu  LLoooosseellyy  TTyyppeedd  LLaannggaauuggee..  JavaScript
berbeda dengan bahasa-bahasa strong typed seperti Java
atau C++ yang padanya anda harus mendeklarasi semua
variabel dari tipe tertentu sebelum menggunakannya.

5. JJaavvaaSSccrriipptt  ssuuaattuu  OObbjjeecctt--BBaasseedd  LLaanngguuaaggee.. Walaupun anda

bekerja dengan objek, pada JavScript anda tidak dapat
menetapkan subclass. Model objek pada JavaScript bersifat
instance-based, bukan inheritance-based.

6. JJaavvaaSSccrriipptt  bbeerrssiiffaatt  EEvveenntt--DDrriivveenn..  Kebanyakan kode yang
akan anda ciptakan pada JavaScript merupakan tanggapan
terhadap event yang diciptakan oleh pemakai dalam sistem.

7. JJaavvaaSSccrriipptt  bbuukkaannllaahh  JJaavvaa.. Java dan JavaScript diciptakan
oleh dua perusahaan yang berbeda. Bahwa ada kesamaan
nama, sepenuhnya hanyalah untuk keperluan pemasaran.

8. JJaavvaaSSccrriipptt  bbeerrssiiffaatt  MMuullttiiffuunnggssiioonnaall..  JavaScript bersifat
multifacet dan dapat digunakan untuk pelbagai masalah
sehubungan dengan Web.

9. JJaavvaaSSccrriipptt  MMaassiihh  BBeerreevvoolluussii..  Bukan saja anda harus
mempertimbangakn browser apa saja yang mendukung
JavaScript, melainkan juga intersi JavaScript (JScript) apa
yang didukungnya.

10. JJaavvaaSSccrriipptt  LLaanngguuaaggee  KKoonntteekkssnnyyaa  MMeelleebbaarr..  Karena suatu
langauage dan bukannya tool, JavaScript dapat juga digu-
nakan pada sisi server dalam lingkungan Netscape LiveWire
atau MS Active X Server. Juga bahasa untuk pengembang-
an Web seperti Borland’s IntraBuilder.

Sepuluh FSepuluh Fakta JavaScript yang Pakta JavaScript yang Perlu Anda Kerlu Anda Ketahuietahui

M
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JavaScript dan Java:JavaScript dan Java:
TTools yang Digunakan oleh Kools yang Digunakan oleh Kedua Bahasa Iniedua Bahasa Ini

JavaScript adalah scripting language yang unik, yang memungkinkan mengembangkan dengan cepat
aplikasi network cross-platform. Kemampuannya membentuk lapisan-lapisan event di atas HTML

memungkinkan melaksanakan validasi di sisi client dan customized data presentation. Selanjutnya,
setelah menguasai sintaks JavaScript, maka untuk mengembangkan aplikasi yang besar dan

kompleks, diperlukan Java. Kode-kode JavaScript dapat mengakses berbagai objek Java dalam script
file-nya, sehingga investasi yang telah ditanam dalam mempelajari scripting language ini tidak sia-sia.

ELAJAR BAHASA BARU BUKANLAH
pekerjaan remeh, tetapi kesa-
maan JavaScript dengan Java

membuat programmer JavaScript dapat
lebih mudah mepelajari Java.

Reserved word, operator dan flow control
sangat mirip, hanya karena Java adalah
bahasa yang dikompilasi (JavaScript ada-
lah bahasa yang diinterpretasi), maka
diperlukan pendefinisian kode-kode
yang ketat.

Development Tool
Dalam menciptakan kode JavaScript,
tool yang diperlukan hanyalah text
editor dan browser yang JavaScript
enabled.

CD NeoTek bulan ini menyediakan
editor-editor yang dapat memudahkan
anda mengembangkan kode-kode
JavaScript: JavaScript Editor 2.5, Bor-
land IntraBuilder, jsEditor, Kimiko HTML
Editor, Script Builder 2.0, Platypus
JavaScript Editor, dan WebWriter 3.5.

Sedangkan untuk menciptakan modul-
modul Java, diperlukan Java library
modules dan Java compiler, yang dapat
diperoleh gratis dari Sun Microsystem.

Java Development Kit 1.1 mencakup
Java Compiler, Java Debugger, dan Java
Virtual Machine yang diperkenalkan
pada tahun 1995 dengan cepat diterima
sebagai standar dalam mengembang-
kan aplikasi cross platform.

Kini JDK 1.1 sudah berkembang men-
jadi Java 2 SDK, Java 2 Platform Stan-
dard Edition ver. 1.3, dan terakhir Java
2 Platform Standard Edition ver. 1.4.0.
Semua ini dapat di-download dari situs
Sun Microsystem di java.sun.com.
Mengingat besarnya file-file ini untuk
di-download, pada CD NeoTek bulan
ini Java 2 SDK 1.4.0 disediakan untuk
yang memerlukan.

B Perbandingan JavaScript dengan Java
JavaScript Java
• Scripting language • Programming language
• Loose variable type checking • Strong variable type checking
• Rudimentary access control • Tiered-access control definition
• No ability-derived types • Full object-oriented capabilities
• No array checking • Strict array access checks
• Instance hierarchy • Object hierarchy
• JavaScript objects • Java class

• JDK 1.1 terdiri dari Java Compiler, Java
Debugger, dan Java Virtual machine.
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UTLOOK EXPRESS (OE) meru-
pakan program klien email
(email client) yang paling

populer untuk sistem operasi Win-
dows. Program ini hadir dengan ke-
mudahan penggunaan dan fitur yang
cukup lengkap untuk urusan komuni-
kasi dengan email. Meskipun demikian
kerap dijumpai banyak pertanyaan
mengenai how-to-nya OE.

Berikut ini sejumlah pertanyaan yang
sering dijumpai yang merupakan hasil
monitoring penulis pada berbagai
mailing list di Yahoogroups. Semoga
bermanfaat bagi pembaca.

Apa manfaat membaca email
dengan OE?
Salah satu manfaatnya adalah anda
dapat men-download email terlebih
dahulu kemudian email-email terse-
but dapat dibaca secara offline alias
tanpa perlu terkoneksi ke Internet.
Artinya anda dapat menghemat biaya
akses Internet. Untuk mendukung hal
ini tentu saja email yang anda miliki
harus mendukung POP. Email gratis-
an yang mendukung POP diantaranya
yang populer adalah Yahoo!Mail dan
Telkom.net.

Bagaimana mengatur setting email
account Yahoo!Mail pada OE?
Jalankan aplikasi OE. Setelah jendela
OE tampil, pilih menu Tools → Ac-

count → Add → Mail … Akan diikuti
dengan tampilan Internet Connection
Wizard. Ketikkan nama anda pada ko-
tak Display Name.Tekan tombol Next.
Ketikkan email anda pada kotak Email
Address, misal saya@yahoo.com. Se-
telah menekan tombol Next, anda per-
lu mengatur setting Email Server
Names. Pilih jenis server POP3 pada
My incoming mail server, dan isikan
pop.mail.yahoo.com dan smtp.mail.
yahoo.com untuk setting pop dan
smtp-nya. Selanjutnya pada kotak
Internet Mail Logon, isikan dengan
nama account dan password email
Anda. Untuk saya@yahoo.com maka
nama account - nya adalah “saya.”
Akhirnya tekan tombol Next dan
Finish.

Langkah selanjutnya login ke
http://mail.yahoo.com, kemudian ma-
suklah ke bagian Options. Atur setting
- nya sehingga mendukung POP dan
SMTP, anda cukup mengikuti wizard
yang disediakan Yahoo!Mail.

Bagaimana mengatur setting email
account Telkom.net pada OE ?
Caranya serupa dengan mengatur set-
ting untuk Yahoo!Mail di atas, hanya
saja anda harus mengisikanpop3.
telkom.net dan smtp.telkom.net untuk
setting pop dan smtp-nya.

Bagaimana cara mengganti nama
pada email?
Dengan OE Anda dapat mengganti
nama email anda sendiri. Nama yang
dimaksud di sini adalah user name
bukan account name. Untuk meng-
ubahnya pilih menu Tools → Account,
kemudian pilih account yang dimak-
sud dan tekan tombol Properties. Pada
kotak Name di bagian User Inform-
ation, isikan nama baru yang Anda
inginkan. Nama inilah yang akan
tampil pada bagian From di kotak
Inbox.

Bisakah OE digunakan untuk
beberapa email account?
Ya, OE dapat digunakan untuk banyak
email account. Gunakan saja tombol
Add → Mail. Untuk mengatur setting

O

PPermasalahan pada Outlook Expressermasalahan pada Outlook Express
MembidikMembidik

Walaupun klien email Outlook Express amat populer, tetapi banyak hal dalam seluk beluk
penggunaannya yang belum diketahui orang. Chandraleka menjawab sejumlah pertanyaan

untuk permasalahan yang kerap mengganjal orang ketika menggunakan OE.

• Internet Connection wizard
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Yahoo!Mail bacalah jawaban perta-
nyaan terdahulu. Setelah selesai me-
ngatur setting untuk satu email account,
ulangi lagi prosesnya sebanyak email
account yang anda kehendaki.

Saya mengikuti banyak mailing list,
bagaimana caranya agar setiap email
yang saya download langsung ber-
pindah ke folder tertentu sehingga
tidak menumpuk pada folder Inbox?
Anda dapat menggunakan Rule untuk
kepentingan ini. Pertama buat folder
baru dengan nama misalnya “Milis
Neotek.” Kemudian pilih menu Tools
→ Message Rules sehingga tampil
kotak dialog Message Rules. Pilih tab
Mail Rules dan tekan tombol New.
Anda akan dihadapkan pada kotak New
Mail Rule. Perlu diingat bahwa setiap
email yang dikirimkan dari Yahoogroups
mempunyai ciri khas pada bagian
Subject-nya. Untuk mailing list maja-
lah Neotek akan terdapat tulisan
“majalahneotek” pada setiap email-
nya. Ciri khas ini yang dapat Anda
manfaatkan dalam membuat Rule.
Beri tanda cek pada “Where the Subject
line contains specific words.” Selanjut-
nya pada kotak Description klik tulis-
an “Contains specific words” dan
isikan dengan “majalahneotek.” Tekan
tombol Add dan OK sehingga anda
kembali ke jendela New Mail Rule.
Pada kotak “Action for your Rule”
beri tanda cek pada “Move it to the
specified folder.” Dan klik pada kotak
nomor 3 kata “specified.” Tentukan
folder-nya. Dalam contoh ini pilih fol-
der yang telah dibuat yaitu folder
“Milis Neotek.” Tekan tombol OK, ke-
mudian beri nama Rule tersebut dengan
“Rule Neotek.” Tekan tombol OK sam-
pai jendela Message Rule tertutup.

Dengan demikian bila Anda men-
download email, maka email dari milis
majalah Neotek akan langsung berpin-
dah ke folder “Milis Neotek.” Kiat ini
sangat bermanfaat untuk mengelola
email yang masuk, terlebih bila anda
mengikuti banyak mailing list.

Saya telah mengatur setting OE untuk
tiga email saya dengan tiga signature-
nya, tetapi ketika menulis email dan
mengganti account pada kotak From,
signature-nya tidak berganti. Adakah
trik yang efektif dalam hal ini?

Anda cukup membuat signature yang
baru—katakanlah signature empat—
yang berisi blank text. Pada jendela
Options, setelah menekan menu Tools
→ Options, pilih tab Signature. Tekan
tombol New dan aktifkan pilihan Text
pada Edit Signature. Isikan saja karak-
ter kosong dengan menekan space bar.
Kemudian tekan tombol Set as Default.
Beri tanda cek pada “Add signature to
all outgoing messages.” Terakhir tekan
tombol Apply dan Ok.

Dengan demikian bila anda menulis
atau me-reply email, signature yang
aktif adalah yang memuat karakter
blank. Selanjutnya dengan mudah an-
da dapat menentukan signature yang
sesuai dengan keinginan dengan me-
milih menu Insert → Signature.

Apakah email yang dihapus bisa di-
undelete lagi?
Email-email yang anda baca pada OE
kemudian dihapus akan dipindahkan
ke folder Deleted Items. Email-email
pada direktori ini masih dapat anda
baca sebagaimana pada folder lain. Te-
tapi bila email-email di folder ini anda
hapus, maka email tersebut akan
benar-benar hilang dan tidak bisa di-
undelete.

Apakah begitu email di-download
dengan OE, email-email di server
Yahoo!Mail hilang?
Benar. Begitu email di-download
dengan OE maka email tersebut akan
hilang dari server Yahoo!Mail. Ini ada-
lah setting bawaan (default) dari OE
ketika anda  mendaftarkan email ac-
count di OE. Namun demikian, anda
masih dapat mengubah setting ini.
Pilih menu Tools → Accounts dan pi-
lih email account bersangkutan. Tekan
tombol Properties. Setelah tampil pro-
perti email tersebut, pilih tab Advanced.
Pada bagian Delivery beri tanda cek
pada “Leave a copy of messages on
server,” sehingga email yang anda
download  masih tetap berada di server.

Adakah cara untuk mengetahui
bahwa penerima telah membaca
email yang saya kirim?
Untuk keperluan ini anda dapat mem-
buka kotak dialog Options dengan me-
milih menu Tools → Options. Setelah
jendela tersebut tampil, pilih tab
Receipts. Beri tanda cek pada “Request
a read receipt for all sent messages.”

Sehingga bila penerima membaca
email dari anda, ia akan dihadapkan
pada kotak dialog konfirmasi apakah
akan memberi pemberitahuan kepada
anda bahwa email tersebut telah diba-
ca atau tidak. Bila tombol Yes ditekan
maka pemberitahuan akan dikirim
dan anda akan tahu bahwa email telah
dibaca.

Bagaimana cara memberikan prio-
ritas pada email sehingga email
yang saya kirim terlihat beda de-
ngan email yang lain pada inbox
penerima?
Email yang anda kirim dapat diatur
prioritasnya, sehingga akan terlihat
perbedaannya dengan email-email
yang lain. Ada tiga setting prioritas
yaitu high, normal, dan low. High
akan ditandai dengan tanda seru ber-
warna merah yang mengindikasikan
email tersebut penting. Low ditandai
dengan tanda panah ke bawah berwar-
na biru. Setting defaul-nyat adalah
normal dan tidak ada tandanya. Cara-
nya ketika anda menulis atau me-
reply email, pilih menu Message →
Set Priority, dan tentukan prioritas-
nya. Gunakan fasilitas ini dengan
bijaksana.

Saya tidak bisa mendownload email
Yahoo lewat OE, hanya ada tampil-
an yang menanyakan password,
padahal password telah diisi
dengan benar
Login ke Yahoo!Mail dengan account
email tersebut. Lalu pilih menu Options
dan ikuti terus wizard-nya sampai
selesai untuk mendukung pop dan
smtp. Pada OE, pilih menu Tools →
Accounts, dan sorot email account  ber-
masalah tersebut.Tekan tombol Properties.
Selanjutnya pilih tab Servers. Beri
tanda check pada “My server requires
authentication.” Tekan tombol OK.

Bagaimana mem-backup email yang
telah di-download?

Email-email yang telah di-download
akan disimpan di folder Inbox (bila
belum dipindahkan), dan berada dalam
satu file dbx. Untuk mengetahui letak
file dbx ini pada komputer, pilihlah
menu Tools → Options, dan pilih tab
Maintenance. Tekan tombol Store
Folder, akan tampil jendela Store
Location yang menunjukkan lokasi di
mana file dbx tersebut disimpan.
Jalankan Windows Explorer dan
carilah direktori tersebut. Akhirnya
copy file inbox.dbx ke disket atau
direktori yang lain untuk backup.

Chandraleka
UnitChandra@yahoo.com• Kotak dialog New Mail Rule
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idak banyak layanan email
gratis yang menyediakan
fasilitas POP3 untuk pe-

langgannya. Dengan adanya fasi-
litas tersebut, pemilik email dapat
memindahkan atau meng-copy
email yang ada di server ke dalam
komputer pribadi. Untuk membaca
email satu persatu, pengguna tidak
perlu berlama-lama di depan
komputer yang online ke Internet.
Dengan begitu, pulsa telepon yang
makin mahal, dapat lebih dihemat.

Fasilitas POP3 sebetulnya bukan
sesuatu yang baru. Sejak awal per-
kembangan Internet di tanah air,

EEMAIMAIL YL YAHAHOOO!O!
PPADADA OA OUUTTLLOOOOK EK EXXPPRREESSSS

Anda mempunyai email account di Yahoo!? Ada satu kiat ber-
manfaat agar anda dapat membaca pesan email anda di
komputer anda secara offline. Untuk itu silakan simak uraian
Ridwan Sanjaya di bawah ini.

T

MENGATUR PROPERTIES
Setelah pengaturan selesai,
masih ada satu tugas anda
yaitu mengatur Properties agar
account tersebut dapat bekerja
dengan baik. Untuk itu pada
‘Internet Accounts’ klik
‘Properties.’

MENGUBAH EMAIL ACCOUNT
Ubah email account dengan
nama yang anda inginkan. Un-
tuk tidak membingungkan,
email account dapat disesuai-
kan dengan nama depan dari
alamat email yang digunakan.
Tekan tombol Apply untuk me-
nyimpan seting tersebut

MENGAKTIFKAN FASILITAS
Untuk dapat mengakses
fasilitas POP3 Yahoo! anda
harus melakukan ‘Sign In’ (jika
anda telah mempunyai
account di Yahoo!). 

POP ACCESS & FORWARDING
Pada layar selanjutnya, klik
‘Options’ → ‘POP Access &
Forwarding’ untuk mengatur
agar email Yahoo! anda dapat
dikirim ke alamat email lain
atau dipindahkan ke komputer
pribadi dengan men-down-
load-nya melalui klien email.

1

7 8

2

Memanfaatkan fasilitas POP3 pada Yahoo!

MEMILIH OPSI
Selanjutnya anda cukup
mengklik tanda pada radio
button di depan ‘Web and POP
Access’ dan/atau ‘HTML
Messages,’ untuk mengaktifkan
salah satu atau kedua fasilitas
ini. Lalu klik tombol ‘Submit.’

MENSINKRONKAN
Selanjutnya, klik mouse pada
tab Servers. Klik ‘My server
requires authentication’ karena
Yahoo! mengharuskan penge-
cekan ulang password pada
saat pengiriman email. Lalu klik
tombol ‘Apply.’

3

9
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beberapa layanan email gratis telah
menyediakannya. Meskipun jumlah-
nya cukup terbatas. Namun pada saat
itu, masih sedikit dari pengguna
email gratis yang mempunyai
komputer sendiri dengan koneksi
Internet sehingga fasilitas tersebut
tidak banyak dimanfaatkan. Untuk
melihat email yang masuk dan mem-
bacanya satu-persatu, mereka harus
online setiap saat.

Keadaan menjadi berubah ketika pe-
milik email gratisan tersebut telah
memiliki komputer yang mampu
online setiap saat, entah komputer
pribadi atau fasilitas kantor. Mereka

ingi mengambil setiap email yang
masuk ke server pada satu saat saja
dan membacanya di saat yang seng-
gang, tanpa harus selalu terkoneksi
ke Internet. Untuk bernostalgia de-
ngan surat-surat lama, mereka tidak
harus online terlebih dahulu. Cukup
melihat di komputer, arsip-arsip
tersebut dapat dibaca setiap waktu.

Setelah ditutupnya fasilitas POP3
bebas biaya milik Netaddress (www.
usa.net) yang sudah menemani para
netter pada awal perkembangannya,
banyak pengguna email gratis mulai
beralih ke Yahoo!Mail. Selain terke-
nal sebagai mesin pencari yang han-

dal, kapasitas mailbox yang diberikan
cukup besar (6 Mb). Dan yang lebih
penting, fasilitas POP3 diberikan
tanpa dipungut biaya! Pengguna
hanya diberikan persyaratan untuk
menerima iklan-iklan sponsor mela-
lui email masing-masing. Di bawah
ini diuraikan cara memindahkan
email yang ada di Yahoo! ke kompu-
ter pribadi anda di rumah atau kantor
sehingga anda dapat membaca email
Yahoo! yang web-based itu tanpa
harus tersambung ke Internet.
Sedangkan program klien email yang
digunakan sebagai contoh adalah
Outlook Express.

EMAIL DIBIARKAN DI SERVER
Klik tab ‘Advance,’ lalu pilih
‘Leave a copy of messages on
server’ jika anda menghendaki
email yang di-download tetap
ada di server. Dengan demikian
email tidak serta merta diha-
pus dari server Yahoo! ketika
sudah diambil oleh klien email.

MENCEK EMAIL
Kini anda dapat mencoba
mencek email yang anda coba
ambil atau download dari
Yahoo! dengan, seperti biasa,
mengklik tombol ‘Send/Recv’
pada Outolook Express.

SETTING SMTP & POP
Pada layar berikutnya Yahoo!
memberitahukan setting POP3
dan SMTP yang harus anda
masukkan pada program klien
email anda (misal, OE) agar
email Yahoo! anda dapat anda
akses secara POP.

MENGATUR OUTLOOK EXPRESS
Pada OE, klik ‘Tools’→ ‘Account’.
Klik pilihan ‘Mail’ pada tombol
‘Add’ untuk menambah daftar
account selain yang sudah ada
pada daftar di sisi kiri.

4

10 11

5 MENGISI ACCOUNT DI YAHOO!
Ikuti langkah-langkah pengisian
seperti yang diminta oleh OE.
Pada bagian ‘Email Server
Names,’ isikan POP dan SMTP
server yang diberikan oleh
Yahoo! (Langkah 4).

EMAIL YANG DITERIMA
Jika semuanya berjalan baik,
maka anda akan menerima
pesan email yang berasal dari
Yahoo! di ‘Inbox’ anda. Anda
pun dapat membaca pesan-
pesan email itu tanpa harus
tersambung ke Internet. Hmm..

6
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ita sudah mengenal dan se-
ring menggunakan program
klien email (email client).

Yang terbanyak digunakan orang
barangkali adalah Outlook Express
dan Netscape Messenger, di sam-
ping nama lain seperti Eudora dan
IncrediMail. Keluhan yang masih
sering kita dengar dalam hal peng-
gunaan klien email adalah masalah
virus yang sering ‘mendompleng’
pada email, biasanya sebagai attach-
ment. Jika keluhan anda terutama
adalah masalah yang satu ini, anda
barangkali dapat menggunakan The
Bat! sebagai klien email alternatif.

TTHHE BE BAAT!T!
EEMAIMAIL CL CLILIEENNT DT DEENNGGANAN
PPEELILINNDDUUNNG VG VIIRRUUSS
Jika anda selama ini selalu gamang saat menerima email dari
pihak yang tidak anda kenal, cobalah The Bat! Email client ini
dilapisi pelindung anti virus, salah satunya terhadap KLEZ, worm
yang dapat memperbanyak diri walaupun email tidak dibuka.

K

FOLDER
Setelah anda menset semua-
nya maka akan terlihat seperti
pada gambar di atas.

MENGIMPOR PESAN
The Bat! mendukung beberapa
sistem email seperti email dari
UNIX, The Bat! sendiri dan MSB
files. Untuk UNIX harus mem-
punyai account pada UNIX
mailbox.

INSTAL THE BAT!
Install The Bat! yang bisa anda
dapatkan pada CD Neotek atau
mendownloadnya dari
www.ritlabs.com/the_bat. 

MEMBUAT ACCOUNT
Setelah terinstal, jalankan The
Bat! kemudian klik ‘Account’ →
‘New.’ Masukkan nama untuk
account anda dan klik ‘Next.’

1

7 8

2

Menggunakan The Bat! yang ‘ramai’ dengan fitur

DATA EMAIL
Berikutnya masukkan nama
lengkap anda beserta dengan
email dan organisasi anda,
pilihan ini opsional, boleh anda
isi atau tidak (Organization).

MENSINKRONKAN
Kegunaan dari synchronise
adalah untuk menstabilkan
penerimaan email melalui
sistem yang berbeda sehingga
dapat diterima dengan
sempurna.

3

9
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Klaim yang dikemukakan program
klien email yang satu ini adalah ke-
ampuhannya dalam menolak virus
dan worm. The Bat!, menurut
pembuatnya, tidak menggunakan
Window-dependent HTML viewer
yang selama ini menjadi sasaran
empuk virus yang bersembunyi di
balik attachment email. Untuk itu,
The Bat! dilengkapi dengan HTML
email viewer yang sudah built-in.
Bahkan jika anda tidak suka
mendapat email dalam bentuk
HTML, anda dapat mengubahnya
menjadi file teks. Ketika menerima
email, jika mengendus ada ‘bau’ virus
pada suatu attachment, sang kalong

akan memberi peringatan kepada
pengguna atau bahkan memblok
email itu sama sekali. Tetapi agar
sang kalong dapat menjagai email
anda dari virus, anda harus meng-
upgrade ke SecureBat.

Selain ‘kesaktian’ di atas, yang pasti
dibutuhkan banyak pengguna email,
The Bat! pun ramai dengan fitur lain
yang tidak kalah penting dan ber-
manfaatnya. Jumlah account yang
dapat dimasukkan ke dalam klien
email ini tidak terbatas. Artinya bisa
berapa orang saja menggunakannya
secara bersama-sama. Dan saat anda
menggunakan The Bat! dengan nama

satu account, klien email ini dapat
memproses pesan lain yang ditujukan
kepada account berbeda.

Agar anda tidak harus selalu
mengetik ulang beberapa hal yang
rutin anda masukkan ke dalam email
anda, The Bat! menyediakan message
template. Dengan template ini anda
tidak perlu lagi selalu repot
melakukan beberapa pekerjaan pada
program ini lewat menu.

Untuk yang telah menggunakan klien
email lain, anda tidak perlu khawatir
karena The Bat! dapat menerima
pesan yang masuk ke klien email
besar.

PGP
Bila anda mendapatkan email
berbentuk enkripsi dan anda
mempunyai public key-nya
maka secara otomatis akan
langsung dibuka oleh The Bat!,
namun bila tidak anda tinggal
mengklik Tools →Open PGP.

HTML & TEKS
The Bat! dapat secara otomatis
mengubah email berbasis
HTML menjadi Txt sehingga
anda akan terhindar dari hal
yang mengganggu bila
menerima email HTML.

SMTP & POP
Seperti layaknya klien email
lain, The Bat! juga meminta
alamat SMTP dan POP3 anda
untuk pengiriman dan peneri-
maan surat.

USERNAME
Masukkan username dan
password anda pada klien e-
mail (POP3) dan bila anda
menggunakan fasilitas enkripsi
(PgP) aktifkan metode APOP.

4
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5 MENGAMBIL EMAIL
Untuk mendapatkan mail anda,
klik ‘Account’ → ‘Get New Mail,’
atau anda tinggal menekan
tombol F2 pada keyboard
anda.

EDITOR
Di saat anda membalas atau
menulis email untuk rekan an-
da, The Bat! secara otomatis
akan menentukan besar para-
graph dan formatnya. Untuk
menonaktifkannya, anda dapat
mengklik Option → Editor.

6
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3 PROSES INSTALASI
Ikuti proses instalasi seperti biasa
anda lakukan. Pilih saja default
yang diberikan sampai muncul
pesan Installation Complete.

NeoTutor

ila ingin mengirim email melalui
program email client, tentu anda
harus mengisikan data smtp

server yang diberikan oleh ISP yang anda
gunakan pada saat terhubung ke Internet.
Sebagai contoh, bila sedang terhubung ke
Internet melalui VisionNet, maka anda
harus mengisikan smtp.vision.net.id pada
kolom smtp server dalam setting email
client anda. Bila melalui TelkomNet, maka
setting email client harus diisi dengan
smtp.telkom.net pada kolom yang sama.
Bila anda tidak melakukan hal ini maka
pesan email anda tidak bisa dikirim ke
alamat email yang dituju.

Selama berada dalam daerah operasi ISP
anda, hal ini tidak jadi soal. Masalah baru

MMEENNGGIIRRIIM EM EMAIMAIL VL VIAIA
POPOSSTTCCAASST ST SEERVRVEERR
TTANANPPA SA SMMTTP SP SEERVRVEER IR ISSPP
Adakah cara untuk mengirim email berbasis POP3 tanpa harus
melalui SMTP server dari ISP langganan kita? Ada! Gunakan
saja PostCast Server, yang mampu mengirimkan pesan email
tanpa harus mengisikan data SMTP server ISP pada konfigurasi
email client yang anda gunakan.

EMAIL CLIENT SETTING
Untuk menyetel program email
client di setiap komputer di dalam
LAN yang terhubung ke komputer
gateway, isikan nomor IP dari kom-
puter gateway itu pada kolom
Outgoing mail (SMTP) server.
Dalam contoh ini, nomor IP-nya
adalah 192.168.0.9 dan port-nya 25.

TEST SETTING ANDA
Pada program email anda, (kami
pakai The Bat!) pada Kolom SMTP
server, isikan 192.168.0.9 (sesuaikan
dengan IP gateway anda). Pada
kolom Pop server, isikan pop server
ISP anda juga User name dan
Password. Lalu connect ke Internet.

DOWNLOAD PROGRAM
Untuk mendownload program
freeware ini, masuk ke situs
www.postcastserver.com lalu
klik bagian download dan cari
Postcast server versi 2.0.11.
Segera klik Download. Anda juga
bisa mengambilnya dari CD
NeoTek bulan ini. 

INSTAL PROGRAM
Selanjutnya instal program ini
pada komputer yang berperan
sebagai gateway ke Internet. Jadi
pengguna LAN yang lain dapat
menggunakan program SMTP
server ini bersama-sama.

1
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Cara mengirim email dengan PostCast Server

SEND, CHECK AND REPLY
Untuk mentesnya gunakan Web
based email anda, lalu klik tombol
Send. Buka web email yang dituju
lalu klik Inbox, bravo! It works!
Kemudian balas dengan meng-klik
tombol Reply.

9
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CEK EMAIL BALASANNYA
Untuk lebih meyakinkan lagi, bu-
ka program email anda lalu klik
Inbox. Ada email balasannya?
Mulai sekarang anda tidak lagi
tergantung pada SMTP server ISP
anda karena telah punya SMTP
server sendiri.

SETTING PADA POSTCAST
SERVER
Bila anda hanya menggunakan
satu komputer saja, maka nomor
IP komputer anda pada kolom
Host Name dapat diganti dengan
127.0.0.1 tetapi Server Port tetap
sama yaitu 25. Coba saja!

SETUP WIZARD
Untuk menyetel aplikasi ini, ikuti
proses Setup Wizard. Pada Inco-
ming connections, anda bisa
mengisikan nomor IP mana saja
di dalam LAN yang boleh mema-
kai SMTP server ini. Selanjutnya
klik Next.   

4
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timbul jika anda sedang berada di luar
jangkuan ISP anda atau ISP langganan
anda tidak menyediakan layanan smtp
server. ‘Kan ada web based email atau
layanan seperti Mail2Web! Memang,
tetapi lagi-lagi demi penghematan pul-
sa, kami sarankan anda menggunakan
software cantik ini, PostCast Server. 

PostCast Server adalah freeware yang
berfungsi sebagai SMTP server yang
dapat dijalankan oleh setiap komputer
berbasis Windows. Ya, program server
ini akan menggantikan fungsi smtp
server dari ISP langganan anda. Jadi,
anda tidak perlu lagi mengisikan data
smtp server ISP di email client.

MAIL SENDING FREQUENCY
Ada beberapa pilihan mengenai ca-
ra yang digunakan untuk mengirim-
kan email. Pilih saja Immediately,
yang artinya email anda akan
langsung diproses untuk di-forward
ke alamat yang dituju. Kemudian
klik Next.

5

Apakah SMTP Server Itu?

Sebuah program yang mendownload
pesan email dari klien dan segera
mem-forward-nya ke tujuan yang
diinginkan. Pada saat anda mengirim
email dari program email client (Out-
look Express, Eudora, The Bat! dll),
maka pesan itu tidak langsung dikirim
ke penerima tetapi harus di-download
oleh SMTP server. Kemudian SMTP
server akan mencek apakah pesan-
pesan email itu dikirim ke alamat
email yang benar. Dari penjelasan ini,
maka ada 4 faktor yang terlibat di
dalamnya, yaitu: 

1. Program email client yang diguna-
kan untuk membuat email.

2. SMTP server yang akan mem-forward
pesan email ke alamat yang tepat.

3. Server yang akan mendownload
pesan email dari SMTP server dan
kemudian dari server ini si penerima
dapat men-download pesan yang
ditujukan kepadanya.

4. Program email client yang diguna-
kan penerima untuk mendownload
email dari server tersebut.

RUN-TIME SETTINGS
PostCast Server akan berjalan ber-
samaan dengan komputer anda.
Anda bisa menampilkannya atau
menyembunyikan ikonnya. Pada
Run-time Settings, ikuti saja default
yang diberikan. Lalu klik Next.

6

KIRIM LANGSUNG DARI
POSTCAST SERVER JUGA BISA
Anda juga bisa menggunakan Post-
Cast Server untuk mengirim email
tanpa harus lewat program email
client anda. Untuk itu klik New
Message pada PostCast Server
maka anda tinggal mengetik pesan
email seperti biasa. 

12
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ANGKAH-LANGKAH PERSIAPAN
dalam hacking telah dibahas
di NeoTek November 2001

(Remote Hacking), yang pada dasar-
nya terdiri dari tiga tahap: Footprint-
ing, Scanning, dan Enumeration.
Setelah itu baru kegiatan hacking-
nya sendiri yang caranya bergantung
pada jenis sasarannya, apakah Win-
dows 95/98/ME/XP, apakah Windows
NT/2000, apakah Novell Netware,
atau juga Unix. Untuk itu digunakan
exploit, suatu program kecil untuk
memanfaatkan kelemahan masing-
masing sistem.

Footprinting telah dibahas secara te-
rinci oleh Onno W. Purbo pada Neo-
Tek Desember 2001, Scanning pada
November 2001, dan Compile Exploit
juga pada November 2001. Tulisan ini
melanjutkan tulisan tentang Scanning
dari sisi lain. Bila artikel Scanning
pada November 2001 dengan pende-
katan contoh, maka kali ini dengan
pendekatan variasi tools yang dapat
digunakan. Kedua artikel tentang
Scanning itu dengan demikian saling
melengkapi.

Setelah Footprinting: Scanning
Seperti juga footprinting, scanning
merupakan proses pengumpulan in-
formasi. Bila footprinting diibaratkan
sebagai usaha mencari informasi un-
tuk menetapkan sasaran mana untuk
melakukan hacking, maka pada scan-

ning sasarannya sudah ditetapkan dan
diibaratkan sudah mulai mengetuk-
ngetuk tembok sasaran untuk mencari
kelemahannya. Mencari pintu yang
terbuka, setengah terbuka, ataupun
tembok yang rapuh.

Melalui footprinting telah diperoleh
informasi daftar network dan alamat-
alamat IP melalui whois dan intero-
gasi DNS. Informasi yang berupa
nama karyawan dan nomor telepon,
IP address, DNS server, dan mail
server, sangat berharga untuk calon
penyerang. Kini yang akan dilakukan
oleh penyerang adalah mencari sistem
mana yang sedang berjalan (hidup)
dan mana yang dapat dicapai melalui
Internet dengan menggunakan bebe-
rapa tool seperti ping sweep, port
scan, dan automated discovery tool.

Perlu diingat bahwa IP address yang
diperoleh melalui interogasi DNS bu-
kanlah berarti IP Address itu dapat
dicapai melalui Internet. Yang perlu
dilakukan sekarang adalah mencek
setiap target sasaran, mencari mana
yang berjalan dan, bila ada, listen
pada port berapa.

Menentukan Apakah Suatu
Sistem Hidup
Salah satu langkah dasar dalam me-
metakan suatu jaringan adalah mela-
kukan penyapuan ping (ping sweep)
pada sekelompok IP Address untuk

menentukan sistem mana yang se-
dang berjalan. Ping pada dasarnya
mengirimkan paket ICMP ECHO ke
sistem sasaran dan mencoba menda-
patkan paket ICMP ECHO_REPLY
yang menandakan sistem itu sedang
berjalan. Ping dapat digunakan ter-
hadap sistem jaringan kecil atau me-
nengah, tetapi untuk jaringan besar
tidak efisien sebab dapat memakan
waktu berhari-hari.

Unix Ping Tools
Nmap (www.insecure.org/nmap/)
Nmap merupakan utilitas port scanner
terbaik yang ada saat ini. Nmap akan
dibahas lagi kemudian. Yang ditekankan
di sini adalah bahwa Nmap mempunyai
juga fasilitas ping dengan opsi -sP

Fping
(http://packetstorm.securify.com/Exp
loit_Code_Archive/fping)

Tidak seperti utilitas ping biasa yang
menunggu respon terlebih dahulu se-
belum mengirimkan ping ke host ber-
ikutnya, fping mengirimkan sejumlah
besar ping request secara paralel. De-
ngan demikian fping akan jauh lebih
cepat untuk sejumlah besar IP address
daripada ping.

Opsi -a pada fping sekedar menun-
jukkan apakahh suatu sistem berjalan
yang bila dikombinasi dengan opsi -d
akan melihat hostname-nya. Opsi lain-
nya -f, yang berarti membaca dari file,

L

HackingHacking && KKeamananeamanan JaringanJaringan
ScanningScanning && ScanningScanning TToolsools

Scanning adalah proses pengumpulan informasi jaringan yang menjadi sasaran hacking. Jika pada
NeoTek terdahulu dibahas pengertian mengenai scanning, maka kali ini diuraikan perangkat atau

tools yang digunakan untuk scanning.
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memungkinkan menyiapkan script dan
kegiatan ping. Semua opsi dapat dili-
hat dengan mengetikkan fping -h.

Bila Paket ICMP Diblokir
Bila ICMP diblokir oleh situs sasaran,
yang biasanya terjadi pada router atau
firewall, maka beberapa tool atau tek-
nik lain dapat digunakan untuk me-
nentukan apakah sistem itu sebenar-
nya hidup atau tidak. Namun teknik
ini tidak setepat dan seefisien ping
sweep normal. Sebagai contoh di ba-
wah ini diberikan Nmap, tetapi selain
Nmap sebenarnya ada tool lain di
antaranya Hping (www.hping.org)
dan Icmpenum (www.nmrc.org/files/
sunix/icmpenum-1.1.1.tgz)

Nmap
Apabila lalu-lintas ICMP diblokir,
maka teknik pertama yang dapat di-

gunakan untuk menentukan suatu
sistem itu hidup atau tidak adalah
port scanning. Dengan men-scan
port-port yang umum pada setiap IP
address, kita dapat menentukan host
mana yang hidup dari dikenalinya
port-port umum atau listening port
dari suatu sistem. Teknik ini mema-
kan waktu dan tidak selalu tepat.

Nmap selain mampu melakukan
ICMP sweep, juga menyediakan opsi
yang lebih maju yaitu TCP ping scan.
TCP ping scan dijalankan pada Nmap
dengan opsi -PT dan nomor port
tertentu (misal 80):

# nmap -sP -PT80 192.168.1.0/24

Metode ini sangat efektif untuk me-
nentukan apakah suatu sistem itu
hidup, walaupun memblokir ICMP.
Ada baiknya coba juga pada port-port
umum lainnya seperti SMTP (25),

POP (110), AUTH (113), IMAP (143),
ataupun port lain yang kiranya khas
untuk situs sasaran itu.

Menentukan Servis Apa yang
Berjalan atau Listening
Sejauh ini telah dibahas pelbagai tek-
nik dan tools untuk menentukan apa-
kah suatu sistem itu hidup atau tidak
baik dengan ping sweep ICMP atau-
pun TCP dan kita dapat mengumpul-
kan informasi sehubungan dengan
ICMP. Kini kita melangkah lebih jauh
lagi, yaitu men-scan port dari masing-
masing sistem itu.

Port scanning adalah proses koneksi
ke port-port TCP atau UDP pada sis-
tem sasaran untuk menentukan servis
apa yang berjalan atau dalam status
LISTENING. Mengidentifikasi port-
port yang listening ini amat kritis da-
lam menentukan jenis sistem operasi
yang dipakai serta aplikasi yang digu-
nakan. Servis-servis yang dalam sta-

Pinger (www.nmrc.org/files/snt/)
Pinger dari Rhino9 ini adalah pinger tercepat yang ada untuk Windows dan
merupakan freeware! Seperti juga fping, Pinger mengirimkan benyak paket
ICMP ECHO secara bersamaan dan menunggu responnya. Selain itu,
Pinger dapat melacak host name dan menyimpannya pada suatu file.

Ping Sweep (www.solarwinds.net)
Ping Sweep dapat sangat cepat sebab kita dapat menentukan delay time
antara paket-paket yang dikirimkan. Dengan menetapkan delay time seba-
gai 0 atau 1, suatu hostname dari network kelas C dapat diperoleh dalam
waktu kurang dari 7 detik. Hati-hati dengan tool ini sebab bisa-bisa mem-
buat macet link yang lambat seperti ISDN 128K atau Frame Relay link.

WS_Ping ProPack (www.ipswitch.com)
NetScanTools (www.nwpsw.com)
Kedua utilitas ping sweep ini memadai untuk melakukan ping sweep terha-
dap network kecil, namun keduanya lebih lambat dibandingkan dengan
Pinger atau Ping Sweep.

Windows Ping Tools

INSTALASI NMAP
nmap sudah tersedia pada Mandrake
Installation CD bersama nmapfe
(nmap front end, interface grafis
untuk nmap). Install nmap dan
nmapfe dengan rpminst. Untuk
menjalankankan tekan Alt-F2 lalu
ketikkan nmapfe.

NMAP COMMAND LINE
Mungkin lebih leluasa mengguna-
kan nmap (command line). Jalan-
kan command line terminal dan
ketikkan perintah nmap yang
diinginkan, misalnya terhadap
local network:
nmap -sP 192.168.123.187

1 2 PING SWEEP TERHADAP TELKOM
Bila menggunakan nmapfe, dengan
menentukan pilihan-pilihan akan
terlihat perintah command line-nya.
Di sini kita melakukan ping sweep
terhadap 202.134.0.172.24 terhadap
port TCP maupun ICMP yang setara
dengan nmap -sP 202.134.0.172/24

3

• Apabila ICMP traffic diblokir, maka untuk
menentukan host yang hidup harus
menggunakan port scanning.



tus listening ini memungkinkan peng-
guna yang tidak berhak mendapatkan
akses akibat konfigurasi yang tidak
tepat ataupun adanya kelemahan
dalam sistem tersebut.

Tujuan port scanning dapat diringkas
sebagai berikut:

a. Mengidentifikasi servis-servis TCP
atau UDP apa yang berjalan pada
sistem sasaran.

b. Mengidenfikasi jenis sistem
operasi dari sistem sasaran.

c. Mengidentifikasi aplikasi ataupun
versi dari servis tertentu.

Mengindentifikasi Servis TCP
dan UDP yang Berjalan
Utilitas yang dipakai untuk scanning
merupakan komponen yang sangat
menentukan dalam proses footprinting.
Ada banyak port scanner yang terse-
dia baik untuk lingkungan Unix mau-
pun NT. Adapun yang dibahas di sini
adalah port scanner yang populer dan
sudah teruji.

Strobe
Stobe adalah utilitas port scanner
karya Julian Assange
(ftp://ftp.FreeBSD.org/pub/FreeBSD/
ports/distfiles/strobe-1.06.tgz). Port
scanner ini sudah cukup lama dikenal
dan merupakan salah satu TCP scan-
ner yang paling cepat dan paling da-
pat diandalkan. Fitur-fitur utama Strobe
mencakup kemampuan mengoptimal-
kan sumber daya sistem dan network
dan men-scan sistem sasaran itu se-
cara efisien. Selain efisien, strobe mulai
versi 1.04 ke atas secara otomatis
mengambil banner (bila ada) dari se-
tiap port yang terkoneksi padanya.
Hal ini dapat membantu mengidenti-
fikasi sistem operasi dan service yang
berjalan padanya. Strobe memberi-
kan output berupa daftar dari setiap
port TCP yang listening.

Walaupun strobe sangat dapat dian-
dalkan, penting untuk mengenali
keterbatasannya. Strobe hanya TCP
scanner saja dan tidak menyediakan
kemampuan scanning UDP. Dengan
demikian, dalam hal scanning, kita
hanya mendapatkan separuh dari
gambaran scanning. Selain itu, strobe
hanya menjalankan teknologi TCP
connect hanya bila terkoneksi pada
setiap port. Bila fasilitas-fasilitas itu
digabungkan juga pada strobe, akan
membuatnya mudah dikenali oleh
sistem sasaran.

Udp_scan
Karena strobe hanya menyediakan
TCP scanning, kita dapat mengguna-
kan udo_scan, yang asalnya dari
SATAN (Security Administrator for
Analyzing Networks), yang ditulis
oleh Dan Farmaer dan Wietse Vene-
ma pada tahun 1995. Walaupun SATAN
sudah agak lama, tool-tool di dalam-
nya masih dapat difungsikan dengan
baik. Sebagai tambahan, kini telah
ada versi baru dari SATAN, yaitu
SAINT (http://wwdsilx.wwdsi.com).
Banyak utilitas lain yang menjalan-
kan UDP scanning, namun udp_scan
yang merupakan UDP scanner yang
paling dapat diandalkan.

Walaupun udp_scan merupakan UDP
scanner yang paling dapat diandalkan,
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Di bawah ini disajikan teknik-teknik
port scanning yang ada. Salah satu
pionir dalam mengimplementasikan
teknik port scanning adalah Fyodor.
Ia memasukkan berbagai teknik
scanning kedalam karyanya yang
amat terkenal: nmap.

TCP connect scan
Jenis scan ini konek ke port sasaran
dan menyelesaikan three-way hand-
shake (SYN, SYN/ACK, dan ACK).
Scan jenis ini mudah terdeteksi oleh
sistem sasaran.

TCP SYN scan
Teknik ini dikenal sebagai half-opening
scanning karena suatu koneksi penuh
TCP tidak sampai terbentuk. Sebalik-
nya, suatu paket SYN dikirimkan ke
port sasaran. Bila SYN/ACK diterima
dari port sasaran, kita dapat meng-
ambil kesimpulan bahwa port itu
berada dalam status LISTENING. Sua-
tu RST/ACT akan dikirim oleh mesin
yang melakukan scanning sehingga
koneksi penuh tidak akan terbentuk.
Teknik ini bersifat siluman dibanding-
kan TCP connect penuh, dan tidak
aka tercatat pada log sistem sasaran.

TCP FIN scan
Teknik ini mengirim suatu paket FIN
ke port sasaran. Berdasarkan RFC 793,
sistem sasaran akan mengirim balik
suatu RST untuk setiap port yang ter-
tutup. Teknik ini hanya dapat dipakai
pada stack TCP/IP berbasis UNIX.

TCP Xmas Tree scan
Teknik ini mengirimkan suatu paket
FIN, URG, dan PUSH ke port sasar-
an. Berdasarkan RFC 793, sistem sa-
saran akan mengembalikan suatu
RST untuk semua port yang tertutup.

TCP Null scan
Teknik ini membuat off semua flag.
Berdasarkan RFC 793, sistem sasar-

an akan mengirim balik suatu RST
untuk semua port yang terturup.

TCP ACK scan
Teknik ini digunakan untuk memeta-
kan set aturan firewall. Dapat mem-
bantu menentukan apakah firewall
itu merupakan suatu simple packet
filter yang membolehkan hanya
koneksi-koneksi tertentu (koneksi
dengan bit set ACK) atau suatu fire-
wall yang menjalankan advance packet
filtering.

TCP Windows scan
Teknik ini dapat mendeteksi port-port
terbuka maupun terfilter/tidak ter-
filter pada sistem-sistem tertentu
(sebagai contoh, AIX dan FreeBSD)
sehubungan dengan anomali dari
ukuran windows TCP yang dilaporkan.

TCP RPC scan
Teknik ini spesifik hanya pada sistem
UNIX dan digunakan untuk mende-
teksi dan mengidentifikasi port RPC
(Remote Procedure Call) dan program
serta normor versi yang berhubung-
an dengannya.

UDP scan
Teknik ini mengirimkan suatu paket
UDP ke port sasaran. Bila port sasaran
memberikan respon berupa pesan
“ICMP port unreachable” artinya port
ini tertutup. Sebaliknya bila tidak me-
nerima pesan di atas, kita dapat me-
nyimpulkan bahwa port itu terbuka.
Karena UDP dikenal sebagai connect-
ionless protocol, akurasi teknik ini
sangat bergantung pada banyak hal
sehubungan dengan penggunaan ja-
ringan dan system resource. Sebagai
tambahan, UDP scanning merupakan
proses yang amat lambat apabila anda
mencoba men-scan suatu perangkat
yang menjalankan packet filetring
berbeban tinggi.

Jenis-Jenis Scanning

• Berbagai fungsi nmap dapat dilihat
dengan mengetikkan nmap -h



utilitas ini mempunyai efek samping
berupa munculnya pesan scan dari
produk-produk IDS utama. Jadi,
udp_scan bukanlah tool yang paling
‘siluman’ yang dapat digunakan. De-
ngan UDP umumnya kita men-scan
port-port berisiko tinggi di atas 1024.

Netcat
Utilitas lain yang amat baik adalah
netcat atau nc, yang ditulis oleh
Hobbit (hobbit@avian.org). Utilitas
ini dapat menjalankan begitu banyak
pekerjaan sehingga dikenal sebagai
Swiss army knive dalam kelompok
security toolkit. Di antara fungsi-
fungsi yang ada adalah kemampuan
men-scan port TCP dan UDP. Opsi -v
dan -vv memberikan  output verbose
dan very verbose. Opsi -z memberikan
mode zero I/O dan digunakan untuk
port scanning, dan opsi -w2 menye-
diakan nilai timeout pada setiap ko-
neksi. Secara default, nc akan men-
scan port TCP, jadi untuk men-scan
port UDP kita harus menggunakan
opsi -u.

Nmap (Network Mapper)
Bila yang lain-lain merupakan port
scanning tool dasar, maka port scan-
ning tool utama adalah nmap. Nmap
(www.insecure.org/nmap) karya Fyodor

menyediakan kemampuan scanning
TCP dan UDP selain teknik-teknik
scanning lain yang telah dibahas di
atas. Sangat jarang ada tool yang
menyediakan begitu banyak utilitas
dalam satu paket seperti nmap ini.

Selain dapat digunakan untuk men-
scan suatu sistem, nmap dapat juga
digunakan untuk men-scan network
secara keseluruhan. Nmap memung-
kinkan kita memasukkan range no-
tasi blok dari CIDR (Classless Inter-
Domain Routing), suatu format yang
memungkinkan kita menspesifikasi
192.168.1.1 - 192.168.1.254 sebagai
range yang kita pilih.

Selain itu nmap menyediakan opsi -o
untuk menyimpan output ke dalam
suatu file. Opsi -oN akan menyimpan
output dalam format yang dapat
dibaca oleh manusia. Bila ingin lebih
mudah dibaca lagi, misalnya dengan
tab delimited, gunakan opsi -oM.
Mengingat akan ada banyak informa-
si yang diperoleh, ada baiknya untuk
menyimpannya pada salah satu format
itu. Anda juga bisa mengkombinasi
opsi -oN dan -oM untuk menyimpan
outputnya kedalam kedua format itu.

Misalkan setelah melakukan finger-
printing terhadap suatu organisasi,
didapatkan bahwa mereka menggu-
nakan packet-filtering device sebagai
firewall, kita dapat menggunakan
opsi -f dari nmap untuk memfrag-
mentasi paket-paketnya. Pada dasar-
nya opsi ini memecah header TCP
menjadi beberapa paket, yang akan
mengakibatkan access control system
maupun IDS kesulitan mendeteksi
adanya scan. Dalam banyak hal,
piranti-piranti packet filtering dan
firewall berbasis aplikasi akan meng-

queue semua fragmen IP sebelum
mengevaluasinya, tetapi pada versi
yang lebih lama, access control device
tidak akan men-defragmentasi paket-
paket dan membiarkannya saja masuk.

Tergantung pada seberapa canggih
network atau host sasaran, kegiatan
scan dapat terdeteksi. Untuk itu nmap
menyediakan pula opsi -D (decoy)
yaitu fasilitas scan palsu yang dapat
mengelabui sasaran dengan informasi
palsu. Scan palsu diluncurkan bersa-
maan dengan scan yang sebenarnya.
Hal ini dicapai dengan men-spoof
source address dari server-server
yang ada pada sistenm sasaran dan
mencampur scan palsu tadi dengan
port scan yang sebenarnya. Sistem
sasaran akan merespon baik alamat-
alamat yang di-spoof tadi maupun
port scan anda yang sebenarnya,
sehingga sistem sasaran akan terbe-
bani untuk melacak semua scan dan
menentukan mana yang sebenarnya
dan mana yang palsu. Perlu diingat
bahwa alamat-alamat palsu itu harus
berasal dari sistem yang hidup, sebab
bila tidak, scan anda akan menye-
babkan banjir SYN flood pada sistem
target dan mengakibatkan kondisi
denial of service.

Fitur scanning lain yang berguna
adalah ident scanning. Ident digu-
nakan untuk mengidentifikasi user
pada koneksi TCP tertentu dengan
jalan berkomunikasi padanya di port
113. Banyak versi dari ident akan
memberikan respon berupa pemilik
proses yang terikuat pada port ter-
tentu. Hal ini terutama berjalan pada
UNIX sebagai sasaran.

Teknik scanning terakhir adalah FTP
bounce scanning. FTP bounce attack
dikemukakan oleh Hobbit pada tahun
1995 yang menunjukkan kelemahan-
kelemahan protokol FTP. Pada dasar-
nya FTP bounce attack adalah metode
insidentil dengan memanfaatkan ko-
neksi melalui protokol FTP dan me-
nyalahgunakan dukungan ‘proxy’
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• Opsi -oN menyimpan hasil scanning dalam file. Pada perintah nmap -sF 02.134.0.196/24
-oN outfile, hasil scan disimpan dalam file outfile dan dapat diakses kemudian.

• Opsi -sS menunjukkan service-service apa
saja yang terdapat pada suatu server.

• Opsi -I menunjukkan siapa owner dari
service-service yang ada.



yang terdapat pada koneksi FTP.
Hobbit menunjukkan bahwa FTP
bounce attack dapat digunakan untuk
mem-posting mail dan news yang
praktis tidak terlacak, menghajar
server pada berbagai macam situs,
mengisi disk, mencoba melangkahi
firewall, dan pada umumnya men-
jengkelkan dan sulit dilacak. Lebih
jauh lagi, anda dapat mem-bounce
port scan ke server FTP untuk
menutupi identitas anda, dan lebih
jauh lagi mem-bypass mekanisme
kontrol akses.

Nmap mendukung scan tipe ini de-
ngan opsi -b; tetapi ada beberapa
kondisi yang harus dipenuhi. Per-
tama, server FTP haruslah suatu
direktori yang writeable dan readable
seperti misalnya direktori /incoming.
Kedua, server FTP harus
memungkinkan nmap mengisikan
informasi port palsu melalui perintah
PORT. Teknik ini sangat efektif
untuk mem-bypass access control
device dan juga menyembunyikan
identitas, namun proses ini merupa-
kan proses yang sangat lambat. Lebih
jauh lagi, kini server-server FTP yang
baru banyak yang tidak mengizinkan
aktivitas seperti ini lagi.

Apa yang Dilihat dari Hasil
Scan?
Setelah mengenal macam-macam
teknik dan tool untuk port scanning,
apa yang dapat diperoleh dari hasil
scan? Dari tool apapun yang
digunakan, yang kita coba dapatkan
adalah mengidentifikasi port yang
terbuka dan memberi tanda mengenai
sistem operasinya. Sebagai contoh,
apabila port 139 dan 135 terbuka,
besar kemungkinannya bahwa sistem
operasi sasaran adalah Windows NT.
Windows NT umumnya listen pada
port 135 dan 139. Berbeda dengan
Windows 95/98 yang listen pada port
139.

Dari output TCP scanning dengan
strobe misalnya, kita dapat melihat
service-service apa saja yang berjalan
pada sistem sasaran. Sistem UNIX
misalnya listen pada port mapper
(111), berkeley R services port (512-
514), NFS (2049), dan port-port no-
mor besar 3277X ke atas. Salah satu
jenis UNIX, yaitu Solaris biasanya
menjalankan RPC service pada port
3277X.

Windows NT mewarisi beberapa ke-
lemahan sehingga mudah diserang,
tetapi UNIX juga berisiko terutama
Remote Procedure Call (RPC) dan
Network File System (NFS) yang

paling sering dimanfaatkan oleh
penyerang.

Mendeteksi Sistem Operasi
Dari sekian banyak tool port scan-
ning untuk mendeteksi port TCP dan
UDP, kita kembali ke tujuan pertama
port scanning, yaitu menentukan
sistem operasi yang berjalan pada
sistem sasaran.

Mengetahui dengan pasti sistem
operasi yang digunakan akan sangat
berguna untuk membuat peta kele-
mahan sistem sasaran (langkah be-
rikutnya: Enumerasi). Untuk lebih
memastikan sistem operasi yang
berjalan, perlu dilakukan kegiatan
banner grabbing dari service-service
seperti FTP, telnet, SMTP, HTTP,
POP, dan lainnya. Ini adalah cara
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Jenis-jenis pemeriksaan (probe)
yang dapat dikirim untuk memban-
tu membedakan suatu sistem
operasi dari yang lain:

FIN probe
Suatu paket FIN dikirim ke suatu
port terbuka. Perilaku yang benar
adalah tidak memberikan respon.
Akan tetapi, banyak implementasi
stack seperti Windows NT akan
merespon dengan suatu FIN/ACK.

Bogus Flag probe
Suatu flag TCP yang tidak didefini-
sikan di-set pada header TCP dari
suatu SYN packet. Beberapa sistem
operasi, seperti Linux, akan meres-
pon dengan flag yang di-set pada
response packet-nya

Initial Sequence Number (ISN)
sampling
Pemahaman dasarnya adalah men-
dapatkan suatu pola pada initial
sequence yang dipilih oleh imple-
mentasi TCP sewaktu merespon
suatu permintaan koneksi.

'Don't fragment bit' monitoring
Beberapa sistem operasi akan men-
set 'Don't fragment bit' untuk me-
ningkatkan kinerja. Bit ini dapat
dimonitor untuk menentukan jenis
sistem operasi apa yang menam-
pilkan perilaku ini.

TCP initial windows size
Melacak initial window size pada
paket yang kembali. Pada beberapa
implementasi stack, ukuran ini unik
dan sangat meningkatkan akurasi
mekanisme fingerprinting.

ACK value
IP stack berbeda-beda dalam meng-
gunakan nsequence value yang di-
gunakan untuk ACK field; beberapa
implementasi akan mengembalikan
sequence number yang anda kirim
dan yang lain akan mengembalikan
sequence number + 1

ICMP error message quenching
Suatu sistem operasi mungkin meng-
ikuti RFC 1812 dan membatasi ke-

cepatan pengiriman error message.
Dengan cara mengirim paket UDP
ke beberapa port acak bernomor
besar, anda dapat menghitung ba-
nyaknya unreachable message
received dalam suatu jangka waktu
tertentu

ICMP message quoting
Sistem operasi berbeda-beda dalam
memberikan informasi yang dikutip
sewaktu mendapatkan ICMP error.
Dengan memeriksa quoted message,
anda dapat menduga sistem operasi
sasaran.

ICMP error message - echoing
integrity
Beberapa implementasi stack mung-
kin mengubah IP header sewaktu
mengirim balik ICMP error mes-
sages. Dengan memeriksa jenis-
jenis pengubahan yang dilakukan
pada header, anda dapat memperki-
rakan sistem operasi sasaran.

Type of service (TOS)
Untuk pesan 'ICMP port unreach-
able,' TOS-nya diperiksa. Kebanya-
kan implementasi stack mengguna-
kan 0, tapi bisa berbeda di sistem
operasi lain.

Fragmentation handling
Stack yang berbeda menangani
overlapping fragmen dengan cara
yang berbeda. Ada yang menimpa
data lama dengan yang baru atau
dapat pula sebaliknya pada waktu
fragmen-fragmen ini dirakit
kembali.

TCP options
TCP options didefiniskan oleh RFC
793 dan yang lebih baru oleh RFC
1323. Implementasi stack yang lebih
baru cenderung mengimlementasi-
kan opsi RFC 1323 yang lebih maju.
Dengan mengirimkan paket dengan
multiple option set, seperti no ope-
ration, maximum segment size,
window scale factor, dan timestamp,
dimungkinkan untuk membuat
dugaan-dugaan tentang sistem
operasi sasaran.

Jenis-Jenis Probe



paling sederhana untuk menentukan
sistem operasi dan servis-servis yang
berjalan beserta versinya. Tool yang
dapat digunakan adalah nmap dan
queso, yang menyediakan ke-
mampuan stack fingerprinting.

Active Stack Fingerprinting
Stack fingerprinting adalah teknologi
yang sangat baik untuk dengan cepat
memperkirakan sistem operasi sistem
sasadan dengan peluang tepat yang
sangat tinggi. Para pemasok menerje-
mahkan RFC guidance secara berbe-
da-beda sewaktu menuliskan TCP/IP
stack-nya. Jadi dengan mencari perbe-
daannya, kita dapat memperkirakan
apa sistem operasi yang digunakan.

Untuk ketepatan maksimum, stack
fingerprinting umumnya memerlu-
kan paling sedikit satu port yang
dalam kondisi listen. Kalau tidak ada
port yang terbuka, maka nmap akan
membuat perkiraan, namun akura-
sinya tetap sangat rendah.

Nmap menerapkan teknik-teknik yang
disebutkan di atas (kecuali fragment-
ation handling dan ICMP error message
queuing) dengan menggunakan opsi
-O. Dengan menggunakan opsi stack
fingerprinting dari nmap, kita dapat
dengan mudah memperkirakan sistem
operasi sasaran dengan ketepatan ting-
gi. Walaupun bila tidak ada port yang
terbuka pada sistem sasaran, nmap
tetap dapat membuat dugaan menge-
nai sistem operasinya.

Salah satu fitur nmap yang terbaik
adalah bahwa daftar signature-nya
disimpan dalam file bernama nmap-
os-fingerprints. Setiap kali versi nmap
baru dikeluarkan, file ini diperbaha-
rui dengan signature-signature yang
baru. Pada saat ini sudah terdapat
ratusan signature yang terdaftar.

Pada saat ini TCP detection nmap
merupakan yang paling akurat, namun
nmap bukanlan tool yang pertama
menerapkan teknik-teknik ini. Queso,
yang dapat di-download di

http://packetstorm.security.com/UNI
X/scanners/queso-980922.tar.gz, ada-
lah pendeteksi sistem operasi yang
diluncurkan sebelum nmap. Perlu
diperhatikan bahwa queso bukanlah
suatu port scanner dan menjalankan
hanya deteksi sistem operasi melalui
satu-satunya port yang terbuka (default
di port 80). Bila port 80 tidak terbuka,
maka perlu untuk menentukan port
mana yang terbuka.

Passive Stack Fingerprinting
Pada passive stack fingerprinting, pe-
nyerang dengan pasif memonitor lalu-
lintas network untuk menentukan
sistem operasi yang digunakan. Jadi
dengan memonitor bermacam-macam
sistem network, kita dapat menen-
tukan sistem operasi suatu sistem.

Passive Signature
Ada macam-macam signature yang
dapat digunakan untuk mengidentifi-
kasi suatu sistem operasi. Kita akan
bahas beberapa atribut sehubungan
dengan sesi TCP/IP.

TTL
Berapa nilai yang di-set untuk time-
to-live untuk outbound paket oleh
sistem operasi itu?

Window Size
Berapa nilai yang di-set untuk
window size oleh sistem operasi itu?

DF
Apakah sistem operasi itu men-set
bit Don't Fragment?

Dengan cara menganalisa secara pasif
setiap atribut dan membandingkan
hasilnya dengan database atribut
yang ada, anda dapat menentukan
sistem operasi dari suatu sistem
remote. Metode ini tidak menjamin
hasil yang benar, tetapi dengan
mengkombinasikannya hasilnya
lumayan dapat diandalkan. Teknik
inilah yang sebenarnya dilakukan
oleh siphon.

Automated Discovery Tool
Ada usaha menggabungkan semua
tool yang dibahas sebelum ini
menjadi suatu alat serba guna untuk
pemetaan jaringan. Tool untuk ini
dikenal dengan nama Cheops yang
kemudian dikembangkan lagi dengan
Cheops-ng.

Baik Cheops maupun Cheops-ng
adalah tool pemetaan jaringan yang
menyajikan hasil pemetaan dalam
bentuk grafis.
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• nmap dapat membuat dugaan terhadap
sistem operasi suatu sistem, walaupun
belum tentu tepat bila tidak ada port yang
terbuka.

• Cheops menyajikan hasil pemetaan suatu network dalam bentuk grafis dengan icon-icon.
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ALAH SATU KESULITAN UTAMA BAGI PARA hacker
pemula untuk mulai bekerja adalah menemukan
tool yang baik di Windows untuk memulai

operasinya. Terus terang agak sulit untuk memperoleh
tool untuk Windows 98, karena sebagian besar adalah
untuk NT atau Win2000.

Salah satu tool yang baik untuk melakukan scanning
jaringan di Windows 98 dan tersedia secara gratis adalah
SuperSCAN 3.0. SuperSCAN 3.0 dapat diambil dari:

http://www.foundstone.com/knowledge/free_tools.html

Selain SuperSCAN, anda akan menemukan banyak sekali
software gratisan di foundstone.com ini. Silakan dijajal.

Ada beberapa catatan yang perlu diperhatikan sebelum
menggunakan software scanner ini. Sebaiknya jangan
melakukan ini di Internet karena sebetulnya identitas
anda terbuka di Internet dan dapat diketahui dari kompu-
ter mana asal scanning dilakukan. Bukan mustahil anda
akan ditegur oleh administrator ISP, syukur-syukur tidak
di-ban atau “dipecat” sebagai pelanggan ISP.

Proses instalasi SuperSCAN praktis hampir tidak ada
yang istimewa. Anda cukup menjalankan program super-
scan.exe yang berhasil anda ambil dari URL di atas dan
superscan akan jalan.

Untuk ujicoba pertama-tama saya sarankan untuk men-
scan IP 127.0.0.1 yaitu komputer anda sendiri. Sambil
membuat diri anda familiar dengan berbagai fasilitas
yang ada. Pada kesempatan ini saya akan men-scan
jaringan LAN yang ada di rumah yang terdiri dari,

• 192.168.0.1 Server Linux Mandrake di PC Pentium 
II 133MHz

• 192.168.0.4 PC Windows 98 sebagai workstation

• 192.168.0.10 PC Windows Me sebagai workstation

Setelah SuperSCAN dijalankan maka akan tampil
Windows seperti tampak pada gambar. Set agar start IP
127.0.0.1 dan stop IP 127.0.0.1 untuk menscan PC sendiri.
Saya kebetulan menscan PC di LAN, saya set start IP
192.168.0.1 dan stop IP 192.168.0.10.

Untuk start awal ada baiknya pilih hanya “All selected
ports in list.” List dari port yang akan dievaluasi meng-
gunakan SuperSCAN dapat di set di tombol “Port list
setup.”

Perlu diperhatikan bahwa SuperSCAN hanya men-scan
port TCP saja, protokol lain seperti UDP dll tidak akan di
scan.

Setelah tombol “Start” ditekan maka akan tampak IP
address dari komputer yang hidup di LAN tersebut
seperti pada gambar di halaman selanjutnya.

Untuk melihat port mana saja yang terdeteksi, tombol
“Expand all” harus di tekan. Perlu kita ingat bahwa pada

S

TTool Scool Scanning Jaringan di Windoanning Jaringan di Windowsws
SuperSSuperSCCANAN

Tidak banyak program untuk melakukan scanning yang dapat dijalankan di Windows 98.
SuperSCAN adalah salah satu dari yang jarang itu. Onno W. Purbo menguraikan untuk anda

tentang cara kerja SuperSCAN.
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saat ini kita menggunakan “Port list” default yang hanya
mendeteksi sebagian kecil port.

Terlihat dari hasil scan bahwa komputer 192.168.0.1 yang
merupakan server Linux Mandrake mempunyai cukup
banyak port yang terbuka, ada Web server, POP3 server,
dll. Sedang komputer yang lain 192.168.0.4 dan
192.168.0.10 hanya terbuka port 139 untuk protokol
NetBIOS yang digunakan untuk network neighbourhood.

Anda dapat menyimpan hasil scan ke file teks dengan
menekan tombol “Save.”

Tampak pada gambar adalah tampilan notepad pada saat
mengedit hasil scan dalam bentuk teks ASCII. Beberapa
hal yang menarik untuk dilihat, terlihat secara eksplisit
bahwa Server Web (port 80) yang digunakan adalah
Apache, POP3 yang digunakan adalah v2000.69mdk yang
di keluarkan oleh Linux Mandrake.

Bagi anda yang ingin melakukan scan lebih banyak port,
sangat di sarankan untuk mengedit port list. Sebetulnya
kita tinggal mengklik saja port mana saja yang perlu kita
check.

Daftar port yang akan di scan tersimpan pada Port list
file. Default setting adalah daftar "scanner.lst" yang akan
mendeteksi port standar Server di IntraNet / Internet.

Jika anda ingin menscan lebih banyak port server, sangat
di sarankan untuk menggunakan daftar "hensss.lst".

Sebagian virus dan trojan yang menyerang komputer
melalui Internet akan membuka port komunikasi dengan
Internet. Bagi anda yang ingin mendeteksi virus dan
trojan yang bercokol di komputer anda maka dapat
menggunakan daftar port “trojans.lst.”
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Kalau anda cukup sabar, anda dapat memilih untuk
menscan semua port dari nomor 1 s/d 65535 port pada
semua PC yang ada di LAN. Untuk tiga (3) buah PC saya
membutuhkan waktu sekitar 1-2 jam.

Hasil yang diperoleh akan tampak pada tampilan gambar
di kolom kanan atas.

Tampilan ini adalah hasil scan semua port yang di edit
menggunakan notepad. Tampak sekali bahwa server
Linux Mandrake di 192.168.0.1 yang saya gunakan
banyak sekali membuka port TCP, beberapa yang penting
lainnya adalah

Port 22 - untuk SSH.

Port 23 - untuk telnet.
Port 143 - untuk IMAP (selain POP3).
Port 443 - untuk https.
Port 901 - untuk SWAT (Administrasi SAMBA

menggunakan Web)
Port 3128 -    proxy server menggunakan Squid.
Port 10000 -    untuk Webmin.

Yang agak menarik adalah PC Windows ME 192.168.0.10,
ternyata banyak sekali membuka port yang saya sendiri
tidak mengetahui untuk apa? Di bandingkan dengan PC
yang menjalankan Windows 98 yang sangat konservatif
hanya membuka port 139 untuk Network
Neighbourhood saja.

Beberapa port scanner berbasis Windows yang cukup
baik kecepatan, akurasi, dan fitur-fitur yang tersedia.

NetScan Tools Pro 2000
NetScan Tools Pro 2000 (NSTP2K) menyediakan segala
macam utilitas dalam satu paket: DNS query mencakup
nslookup dan dig dengan axfr, whois, ping sweeps, Net-
BIOS name table scan, SNMP walks, dan banyak lagi.
Lebih jauh lagi NSTP2K mempunyai kemampuan multi-
tasking. Anda dapat menjalankan port scan terhadap suatu
sistem dan menjalankan ping sweep pada sistem yang lain.

NetScan Tools Pro 2000 menyertakan port scanner versi
Windows terbaik yang ada sekarang, yaitu pada tab Port
Probe. Kehebatan Port Pro mencakup flexible target dan
spesifikasi port (IP sasaran maupun daftar port dapat di-
impor dari file teks), mendukung scan TCP maupun UDP
(tapi tidak selektif per port), dan multithreaded speed. Di
sisi negatifnya, output yang dihasilkan Port Pro bersifat
grafis sehingga sulit dibaca oleh script ataupun tool pemilah-
milah data. Sayangnya juga, output dari suatu fungsi
(misalnya NetScanner) tidak dapat secara otomatis dija-
dikan input oleh fungsi lain (misalnya Port Probe).

Versi kecilnya adalah NetScanTools (terakhir versi 4)
yang tersedia sebagai trial 30 hari, namun fiturnya jauh
dibandingkan dengan NetScan Tools Pro 2000 (misalnya
NetScan Tools tidak melakukan UDP scan).

SuperSCAN
SuperScan dapat diperoleh di www.foundstone.com/rdlabs/
termofuse.php?filename=superscan.exe. SuperScan ada-
lah port scanner TCP yang juga cepat dan dapat diandal-
kan pada harga yang jauh lebih baik (gratis!). Seperti juga

NSTP2K, SupeScan memungkinkan spesifikasi fleksibel
dari IP-IP sasaran dan daftar port. Opsi Extract From File
nyaman mudah digunakan dan cepat pula. Onno W. Purbo
membahas khusus SuperScan ini dalam artikel tersendiri.

WinScan
WinScan,karya Sean Mathias dari Prosolve (http://prosolve.com)
adalah suatu TCP port scanner yang tersedia baik dalam
format grafis (winscan.exe) maupun command line (scan.exe).
Versi command line-nya mampu men-scan network
Class-C dan output-nya mudah dibaca.

IpEye
Packet scan eksotis hanya nmap di Linux? Tidak juga.
IpEye karya Arne Voidstrom (http:// ntsecurity.nu) dapat
menjalankan source port scanning, selain SYN, FIN, dan
Xmas scan dari command line Windows. Satu-satunya
keterbatasan ipEye adalah hanya berjalan pada Windows
2000 dan setiap kali hanya dapat men-scan satu host.

Banyak router dan firewall dikonfigurasikan agar memung-
kinkan protokol seperti DNS (UDP 53), FTP data channel
(TCP 20), SMTP (TCP 25), dan HTTP (TCP 80) masuk
melalui filter, source port scanning dapat menyerang kontrol-
kontrol ini dengan jalan menyamar sebagai lalu-lintas
komunikasi inbound ini. Untuk itu, anda harus mengeta-
hui ruang alamat yang ada di balik firewall atau router,
yang sulit bila melibatkan NAT (NetBIOS Auditing Tool).

WUPS
Windows UDP Port Scanner (WUPS) berasal dari penga-
rang yang sama dengan ipEye (Arne Vidstorm). Suatu
UDP scanner grafis yang mudah digunakan dan cepat
(tergantung pada delay setting-nya), walaupun hanya
dapat men-scan satu host setiap kali. Suatu tool yang
baik untuk UDP scan cara cepat.

Port Scanner Berbasis Windows
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ONSEP IP ADDRESS, NETWORK
address, subnet mask, broad-
cast address merupakan dasar

dari teknik routing di Internet. Untuk
memahami ini semua kemampuan
matematika khususnya matematika
boolean, atau matematika binary
akan sangat membantu memahami
konsep routing Internet. Contoh
pertanyaan yang sering dilontarkan,

• Mengapa kita memilih IP address
192.168.1.5?

• Mengapa subnet mask yang
digunakan 255.255.255.224?
mengapa bukan angka lain?

• Mengapa network address
167.205.10.0?

• Mengapa broadcast address-nya
202.159.32.15? dan sebagainya.

Bagaimana menentukan
semua alamat-alamat
tersebut? Hal tersebut
yang akan dicoba
dijelaskan secara
sederhana dalam tulisan
ini.

Kalkulator—Alat Bantu
yang Dibutuhkan
Untuk memudahkan
kehidupan anda, ada
baiknya menggunakan
fasilitas kalkulator yang
ada di Windows. Di
Windows 98 dapat diakses
melalui Start →
Programs→ Accessories
→ Calculator.

Kalculator yang standar
memang sulit digunakan
untuk membantu kal-
kulasi biner. Oleh karena
itu pilih View → Scientific
untuk memperoleh
tampilan kalkulator
scientific yang dapat
digunakan untuk perhitungan biner.

Dengan cara memindahkan mode
operasi ke bin, maka nilai yang ada
akan berubah menjadi binary. Pada
gambar contoh diperlihatkan nilai
awal 15 desimal, dipindahkan
menjadi 1111 binary.

SSeeddiikkiitt  AAlljjaabbaarr  BBoooolleeaann
Aljabar Boolean adalah teknik meng-
hitung dalam bilangan binary
101010111 dsb. Proses konversi dari
desimal ke binary sudah tidak perlu
kita pikirkan lagi karena sudah
dibantu menggunakan kalkulator
yang ada di Windows 98.

K

TTeknikeknik
RRouting Internetouting Internet

Untuk memahami teknik routing di Internet anda perlu mengetahui beberapa konsep dasar. Untuk
membantu anda memahami teknik routing tersebut, Onno W. Purbo menjelaskan secara

sederhana mulai dari konsep-konsep dasarnya.
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Dari sekian banyak fungsi yang ada
di aljabar boolean, seperti and, or, xor,
not dll. Untuk keperluan teknik rout-
ing di Internet, kita hanya memerlu-
kan fungsi “dan” atau “and.” Contoh,

1 and 1 = 1
1 and 0 = 0
0 and 1 = 0
0 and 0 = 0

atau yang lebih kompleks

11001010.10011111.00010111.0010
1101

di AND dengan

11111111.11111111.11111111.0000
0000

menjadi

11001010.10011111.00010111.0000
0000

Tidak percaya? Coba saja masukkan
angka-angka di atas ke kalkulator
Windows, anda akan memperoleh ha-
sil persis seperti tertera di atas. Pusing?
Mari kita konversikan bilangan binary
di atas menjadi bilangan desimal su-
paya anda tidak terlalu pusing melihat
angka 10101 dsb. Dalam notasi desimal,
kalimat di atas menjadi,

202.159.23.45

di AND dengan

255.255.255.0

menjadi

202.159.23.0

Cukup familiar? Coba perhatikan nilai-
nilai alamat IP yang biasa kita masuk-
an di Start → Settings → Control
Panel →Network →TCP/IP Properties.

Kalau kita perhatikan baik-baik maka
panjang sebuah alamat IP adalah 32
bit, yang dibagi dalam empat segmen
yang di beri tanda titik “.” antar seg-
mennya. Artinya setiap segmen ter-
dapat delapan bit.

Alokasi Jumlah Alamat IP di
Jaringan
Teknik subnet merupakan cara yang
biasa digunakan untuk mengalokasi-
kan sejumlah alamat IP di sebuah ja-
ringan (LAN atau WAN). Teknik sub-
net menjadi penting bila kita mem-
punyai alokasi IP yang terbatas misal-
nya hanya ada 200 IP yang akan di
distribusikan ke beberapa LAN.

Untuk memberikan gambaran, misal-
kan kita mempunyai alokasi alamat
IP dari 192.168.1.0 s/d 192.168.1.255
untuk 254 host, maka parameter yang
digunakan untuk alokasi adalah:

192.168.1.255 - broadcast address
LAN

255.255.255.0 -  subnet mask LAN

192.168.1.0 - netwok address LAN.

192.168.1.25 - contoh IP address
salah workstation di LAN.

Perhatikan bahwa,

• Alamat IP pertama 192.168.1.0 tidak
digunakan untuk workstation, tapi
untuk menginformasikan bahwa
LAN tersebut menggunakan alamat
192.168.1.0. Istilah keren-nya ala-
mat IP 192.168.1.0 di sebut network
address.

• Alamat IP terakhir 192.168.1.255
juga tidak digunakan untuk work-
station, tapi digunakan untuk alamat
broadcast. Alamat broadcast diguna-
kan untuk memberikan informasi
ke seluruh workstation yang berada
di network 192.168.1.0 tersebut.
Contoh informasi broadcast adalah
informasi routing menggunakan
Routing Information Protocol (RIP).

• Subnet mask LAN 255.255.255.0,
dalam bahasa yang sederhana dapat
diterjemahkan bahwa setiap bit “1”
menunjukan posisi network address,
sedang setiap bit “0” menunjukkan
posisi host address.

Konsep network address dan host
address menjadi penting sekali ber-
kaitan erat dengan subnet mask. Per-
hatikan dari contoh di atas maka
alamat yang digunakan adalah

192.168.1.0 network address
192.168.1.1 host ke 1
192.168.1.2 host ke 2
192.168.1.3 host ke 3
……
192.168.1.254 host ke 254
192.168.1.255 broacast address

Perhatikan bahwa angka 192.168.1 ti-
dak pernah berubah sama sekali. Hal
ini menyebabkan network address
yang digunakan 192.168.1.0. Jika di-
perhatikan maka 192.168.1 terdiri dari
24 bit yang konstan tidak berubah,
hanya 8 bit terakhir yang berubah
memberikan identifikasi mesin yang
mana. Tidak heran kalau netmask
yang digunakan adalah

(binary)
11111111.11111111.11111111.
00000000
(desimal) 255.255.255.0.

Walaupun alamat IP workstation te-
tap, tetapi netmask yang digunakan
di masing-masing router akan ber-
ubah-ubah bergantung pada posisi
router dalam jaringan. Bingung? Ma-
ri kita lihat analogi di jaringan tele-
pon yang biasa kita gunakan sehari-
hari, misalnya kita mempunyai no-
mor telepon yang dapat di telepon

dari luar negeri dengan nomor,

+62 21 420 1234

Lokasi nomor telepon tersebut di
Jakarta, dengan sentral di sekitar Senen
dan Cempaka Putih. Kita perhatikan
perilaku sentral telepon di tiga lokasi

1. Sentral di Amerika Serikat
2. Sentral di Indosat Jakarta
3. Sentral telepon di Telkom Jakarta

Gatot Subroto
4. Sentral telepon di Senen, Cempaka

Putih.

Pada saat kawan kita di amerika Seri-
kat akan menghubungi rekannya di
Jakarta dengan nomor +62 21 420 1234.

Pada sentral di Amerika Serikat, ha-
nya memperhatikan dua digit perta-
ma (+62), setelah membaca angka +62
tanpa mempedulikan angka selanjut-
nya maka sentral di Amerika Serikat
akan menghubungi gerbang SLI di
Indosat Jakarta untuk memperoleh
sambungan. Perhatikan di sini netmask
di sentral Amerika Serikat untuk ja-
ringan di Indonesia hanya cukup dua
digit pertama, selebihnya dianggap
host (handset) di jaringan telepon
Indonesia yang tidak perlu di perdu-
likan oleh sentral di Amerika Serikat.

Pada sentral Indosat Jakarta, berbeda
dengan sentral di Amerika Serikat, akan
memperhatikan dua digit selanjutnya
(jadi total +62 21). Dari informasi terse-
but sentral Indosat mengetahui bahwa
trafik tersebut untuk Jakarta dan akan
meneruskan trafik ke sentral Telkom
di Jl. Gatot Subroto di Jakarta. Perhati-
kan sekarang netmask menjadi 4 digit.

Pada sentral Telkom di Gatot Subroto
Jakarta akan  melihat 3 digit selanjutnya
(+62 21 420). Dari informasi tersebut
maka sentral Telkom Gatot Subroto
akan meneruskan trafik ke sentral yang
lebih rendah kemungkinan di Gambir
atau sekitar Senen. Perhatikan seka-
rang netmask menjadi 7 digit.

Pada sentral terakhir di Gambir atau
Senen, akan dilihat pelanggan mana
yang dituju yang terdapat dalam empat
digit terakhir (1234). Maka sampailah
trafik ke tujuan. Nomor pelanggan
kira-kira ekuivalen dengan host address
di jaringan Internet.

Mudah-mudahan menjadi lebih jelas
fungsi netmask. Secara sederhana net-
mask digunakan untuk memisahkan
antara network address dan host
address untuk memudahkan proses
routing di jaringan Internet. Dengan
adanya netmask kita tidak perlu
memperhatikan seluruh alamat IP
yang ada, tetapi cukup memperhati-
kan segelintir network address saja.



Beberapa contoh network address di
Internet di Indonesia, dapat dengan
mudah mengidentifikasi ISP atau
pemilik jaringan tersebut, misalnya,

202.134.0.0 telkom.net
202.154.0.0 rad.net.id
202.159.0.0 indo.net.id
202.158.0.0 cbn.net.id
167.205.0.0 itb.ac.id

Terlihat jelas bahwa terdapat sebuah
struktur penomoran, terlihat sekali
bahwa IP address dengan awalan 202
umumnya ISP dari Indonesia yang
dialokasikan oleh penguasa IP di Inter-
net seperti www.icann.org. Dengan
teknik ini sebetulnya dari Internet
untuk mengarah ke Indonesia cukup
melakukan masking dengan mask

255.0.0.0

karena 8 bit pertama yang perlu di
mask. Biasanya pada router dapat
juga ditulis dengan kalimat

202.159.0.0/8

ada slash /8 di belakang IP address
menandakan bahwa cukup 8 bit
pertama yang perlu diperhatikan.

Selanjutnya untuk mengarahkan
paket data ke jaringan internal di
IndoNet (indo.net.id), maka mask-
ing pada router di IndoNet atau
berbagai ISP di Jakarta adalah

255.255.0.0

atau pada router tersebut dapat di-

gunakan routing ke arah

202.159.0.0/16

perhatikan sekarang slash yang di-
gunakan adalah slah 16 (/16), arti-
nya cukup diperhatikan 16 bit saja
dari total 32 bit IP address yang ada.

Selanjutnya mengarahkan paket ke
PT. Antah Berantah yang memiliki
sambungan leased line di IndoNet,
pada router di IndoNet dapat digu-
nakan masking yang tidak terlalu
normal misalnya

255.255.255.240

atau dapat digunakan pengalamatan

202.159.12.0/24

artinya router harus memperhati-
kan 24 bit pertama dari IP address.

Sintaks Penambahan Route
Setelah kita mengetahui pola pikir
routing pada Internet, maka langkah
selanjutnya yang perlu kita tahu
adalah cara menambahkan route pada
tabel route di komputer. Hal ini
tidak terlalu sukar, perintah yang
dapat digunakan adalah

C:> route (di Windows)
# route (di Linux)

di Windows format penambahan route
tersebut sangat sederhana yaitu

C:> route add 202.159.0.0
netmask 255.255.0.0 192.168.0.1

metric 3

Di Linux format-nya dapat menjadi

# route add -net 202.159.0.0/16
gw 192.168.0.1 metric 3

Dimana 202.159.0.0 adalah network
address (dapat juga kalau dibutuhkan
kita memberikan routing ke sebuah
host); 255.255.0.0 atau /16 adalah
netmask yang digunakan; 192.168.0.1
adalah gateway yang digunakan;
metrik 3 menandakan prioritas rout-
ing, yang dapat dikosongkan saja.

Untuk melihat tabel routing di kom-
puter kita dapat dilakukan dengan
perintah

C:> netstat -nr (di Windows)
C:> route print (di Windows)
# netstat -nr (di Linux)
# route (di Linux)

Tentunya akan pusing kepala jika
kita beroperasi pada jaringan yang
kompleks. Sebaiknya kita menggu-
nakan teknik routing yang otomatis.
Hal ini dapat dilakukan dengan mu-
dah di Linux dengan menjalankan
software seperti

# routed

atau

# gated

Software routing seperti ini mungkin
ada di Windows NT atau Windows
2000, tapi tidak pada Windows 98.
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ACKING MERUPAKAN ‘SENI’ TERSENDIRI YANG MELIBATKAN
proses mencari serpihan-serpihan informasi yang ber-
tebaran di mana-mana dan seolah-olah tidak ada hu-
bungannya satu sama lainnya. Setelah

Footprinting dan Scanning, tahap berikutnya adalah
mencari informasi absah mengenai resource dan share, user dan
group, serta aplikasi dan bannernya pada suatu network. Suatu
proses yang dinamakan Enumeration.

Mempelajari teknik routing internet merupakan dasar penge-
tahuan untuk melakukan enumerasi yang akan kita bahas di
edisi NeoTek berikutnya.Adapun untuk memberi gambaran
tentang keseluruhan proses hacking, di bawah ini disajikan
langkah-langkah logisnya.

1. Footprinting.. Mencari rincian informasi terhadap sistem-
sistem untuk dijadikan sasaran, mencakup pencarian infor-
masi dengan search engine, whois, dan DNS zone transfer.

2. Scanning.. Terhadap sasaran tertentu dicari pintu masuk
yang paling mungkin. Digunakan ping sweep dan port scan.

3. Enumeration..  Telaah intensif terhadap sasaran, yang men-
cari user account absah, network resource and share, dan
aplikasi untuk mendapatkan mana yang proteksinya lemah.

4. Gaining Access..  Mendapatkan data lebih banyak lagi
untuk mulai mencoba mengakses sasaran. Meliputi meng-
intip dan merampas password, menebak password, serta
melakukan buffer overflow.

5. Escalating Privilege.. Bila baru mendapatkan user pass-
word di tahap sebelumnya, di tahap ini diusahakan men-
dapat privilese admin jaringan dengan password cracking
atau exploit sejenis getadmin, sechole, atau lc_messages.

6. Pilfering..  Proses pengumpulan informasi dimulai lagi untuk
mengidentifikasi mekanisme untuk mendapatkan akses ke
trusted system. Mencakup evaluasi trust dan pencarian
cleartext password di regiatry, config file, dan user data.

7. Covering Tracks.. Begitu kontrol penuh terhadap sistem
diperoleh, maka menutup jejak menjadi prioritas. Meliputi
membersihkan network log dan penggunaan hide tool
seperti macam-macam rootkit dan file streaming.

8. Creating Backdoors..  Pintu belakang diciptakan pada ber-
bagai bagian dari sistem untuk memudahkan masuk kembali
ke sistem ini dengan cara membentuk user account palsu,
menjadwalkan batch job, mengubah startup file, menanam-
kan service pengendali jarak jauh serta monitoring tool,
dan menggantikan aplikasi dengan trojan.

10. Denial of Service..  Bila semua usaha di atas gagal, penye-
rang dapat melumpuhkan sasaran sebagai usaha terakhir.
Meliputi SYN flood, teknik-teknik ICMP, Supernuke,
land/latierra, teardrop, bonk, newtear, trincoo, dan lain-lain.

NeoTek sudah membahas langkah 1 (footprinting) dan 2
(scanning) serta sebagian langkah 4 (password sniffing) dan
akan dilanjutkan lagi di nomor-nomor mendatang

H
Anatomi Proses HackingAnatomi Proses Hacking
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NeoStyle

uarkXpress adalah salah satu
program desktop publishing
yang mumpuni di dunia

penerbitan. Kepiawaian program ini
telah dibuktikan oleh nama-nama
besar di dunia media massa interna-
sional sampai penerbitan buku dan
perusahaan periklanan. Kini dengan
keluarnya Quark terbaru, Quark-
Xpress 5, keunggulan-keunggulan
baru pun ditambahkan di dalamnya:

• Tables Fungsi untuk membuat ta-
bel. Masing-masing sel dapat di-
fungsikan sebagai sel teks atau sel
tabel.

• Layers Fungsi yang memungkinkan

MMEENNYYIAPIAPKKAN IAN ISSI NI NEEOOTTEEKK
DDEENNGGANAN
QQUARUARKXKXPPRRESSESS
Ingin tahu rahasia dapur redaksi NeoTek? NeoTek menggunakan
program desktop publishing bernama QuarkXpress untuk
‘menggoreng’ sajian kami bagi anda. Kami memperkenalkannya
bersamaan dengan peluncuran QuarkXpress 5.0 beta

Q

MEASUREMENT UNTUK TEKS
Palet measurement pun akan berubah
fungsinya sesuai dengan tools yang
aktif. Ketika fungsi teks aktif dikombi
nasikan dengan frame grafik, maka
unsur-unsur pada palet measurement
yang aktif adalah seperti posisi X dan Y
dari frame tersebut, dsb.

JENIS HURUF
Palet measurement berubah kembali
setelah tool teks ditempatkan di frame
teks. Palet memperlihatkan jenis huruf
atau font yang digunakan beserta
ukuran atau size dari huruf itu.

FUNGSI TEKS
Fungsi teks pada Quark diaktifkan
dengan mengklik ikon bergambar
tangan pada palet ‘Tools,’ sedangkan
frame yang memuat teks bersangkutan
akan ditandai dengan kotak-kotak kecil
di keempat sudut dan bagian atas dan
bawahnya.

MENU STYLE UNTUK TEKS
Dengan aktifnya fungsi teks, maka
menu Style pun berfungsi. Di sinilah
anda dapat mengubah font, ukuran
font (size), jenis font (bold, italic,
underline, dsb.), dan fungsi lain yang
berkaitan dengan teks.

1

5 6

2

Menjadi redaksi luar-kantor pada Majalah NeoTek

MENJADI REDAKSI
NEOTEK EXTENSION?

Dengan menginstalasi
Quark XPress 5.0 beta di
komputer anda dan mem-
punyai salah satu file .qxd
dari Majalah NeoTek, anda
sudah dapat menjadi
redaksi extension pada
Majalah NeoTek.

PERSYARATAN
HARDWARE?

Dibandingkan program
desktop publiahing sejenis
seperti misalnya PageMaker,
Quark XPress secara meng-
herankan ‘sangat ringan.’
Persyaratan hardware un-
tuk menjalankannya tidak
tinggi. Dengan prosesor
setara Pentium (166 MHz)
dan RAM 32 MHz, anda
sudah dapat dengan lelu-
asa menjadi penerbit
sendiri.

PERSIAPAN
LENGKAP EDITOR?

Untuk dapat menyiapkan
artikel ‘siap pakai’ untuk
NeoTek, pada komputer an-
da harus terpasang ATM
(Adobe Type Manager) dan
font-font Postscript (Type 1),
selain juga font tipe Truetype
yang merupakan standard
Windows.
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anda memisahkan unsur desain
dan teks dalam dokumen anda.
Sel-sel dengan mudah dapat
dipisahkan atau disatukan.

• Web Design Tools Fungsi yang
akan membantu anda menyiapkan
rancangan halaman Web dengan
menggunakan palet dan tool yang
sama dengan yang anda gunakan
untuk mendesain barang cetakan.
Hasil desain pada Quark dapat
dibuka dan diedit pada HTML
development tool standar seperti
Dreamweaver.

• XML Export Fitur ini memungkin-
kan anda mengekstrak isi

dokumen Quark anda dan
menyimpannya sebagai XML
sehingga anda dapat
mempublikasikan dokumen anda
sebagai dokumen Quark di
Internet atau dengan format lain.

Redaksi NeoTek pun menggunakan
program ini untuk menyiapkan isi
majalah NeoTek yaitu untuk mena-
taletak (lay out) halaman-halaman
majalah ini sampai dengan menyiap-
kan file PDF dari isi majalah. File-file
PDF ini dapat anda download gratis
dari situs NeoTek (www.neotek.co.id)
atau anda peroleh dari CD Pendidik-
an NeoTek (PDF dari seluruh isi

majalah NeoTek Volume I dan edisi
khusus NeoTek, Mandrake 8.0).

Bagi anda yang ingin ‘mencicipi’
QuarkXpress 5.0, kami menyediakan
versi trial-nya pada CD NeoTek
bulan ini. Anda dapat menginstalnya.
Walaupun versi trial, program ini
ketika diinstal dapat berfungsi penuh.

MEASUREMENT UNTUK GRAFIK
Inilah palet measurement yang muncul
ketika tool grafik diaktifkan dan ditem-
patkan pada frame grafik. Selain men-
cantumkan posisi frame, palet juga mem-
beritahukan panjang dan lebar frame
grafik yang aktif, juga persentase ukuran
grafik yang ditempatkan di frame itu.

MEASUREMENT FRAME TEKS
Palet measurement kembali berubah
ketika tool grafik ditempatkan pada
frame teks. Yang muncul hanyalah po-
sisi frame serta lebar dan panjang frame
yang aktif, sedangkan yang ukuran-
ukuran yang berkaitan dengan grafik
tidak muncul.

FUNGSI GRAFIK
Untuk mengaktifkan fungsi grafik, anda
cukup mengklik ikon paling atas pada
palet ‘Tools.’ Dengan aktifnya fungsi
grafik, maka anda dapat mengaktifkan
frame grafik dengan mengklik frame
bersangkutan.

MENU STYLE UNTUK GRAFIK
Dengan aktifnya fungsi grafik, elemen
yang aktif pada menu Style pun berubah
sesuai dengan fungsi ini. Seperti tampak
pada gambar, tampak antara lain fungsi
yang dapat digunakan adalah flip
horizontal dan flip vertical.

3
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MMARARI KI KITITAA
CCOOBA!BA!

TIP UNTUK QUARK1
Menyajikan tip dan trik
penggunaan Quark yang
amat membantu anda
untuk mengenali fungsi-
fungsi operasi Quark yang
mungkin tidak tercantum
di buku manual.
Situs: www.digitrain.
com/Tips/QX.html.

Internet sebagai sumber
informasi juga dapat
membantu anda untuk
lebih memahami dan
menguasai pengopera-
sian QuarkXpress.

TEMPLATE QUARK3
Link untuk template-
template Quark untuk
pembuatan kartu nama,
jurnal, brosur, dsb.

Situs: http://desktoppub.
about.com/cs/templatesqxp

TUTORIAL QUARK2
Link untuk beberapa situs
tutorial Quark, mulai dari
produksi dengan Quark
sampai masalah pra-cetak.
Situs:
http://desktoppub.about.
com/cs/qxptutorials/
index.htm
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Belakangan ini banyak pengguna komputer yang terkaget-kaget ketika tombol Start di desktopnya
‘melarikan diri’ saat akan diklik dengan mouse atau saat didekati kursor. Orang pun menyangka ini

pekerjaan virus. Benarkah ini ulah virus?

ANGAN JANTUNGAN DAHULU
jika tiba-tiba komputer mem-
format hard disk anda karena
itu mungkin sebenarnya ha-

nya ulah dari program iseng yang
dipasang sahabat anda di komputer
anda. Anda pun dapat mengisengi
orang lain, kalau mau, karena pro-
gram iseng tersebut dapat anda per-
oleh gratis dari Internet pada alamat
www.rjlsoftware.com/software/entert
ainment atau bagi pembeli CD

NeoTek dapat memperolehnya pada
CD NeoTek bulan ini. Untuk
mengetahui ‘keisengan’ program-
program itu, di bawah ini disajikan
beberapa di antaranya sebagai
contoh.

MencucukMencucuk
PrProgrogram Isengam Iseng

J

• Untuk menghentikan program iseng anda
cukup meletakkan kursor di ujung kiri atas
sehingga keluar sebuah kotak dialog. Klik

tombol Close pada kotak dialog atau tekan
sembarang tombol pada keyboard.

AVOID Namanya Avoid dan karena
ulahnya tombol Start pada Windows
anda akan melompat-melompat
menghindari kursor mouse. Untuk

menjalankan program ini, klik dua kali
program yang anda urai dari file zip yang
di-download dari Internet. 

1 HEADACHE Setelah mengklik dua
kali program ini, muncul kotak pe-
ringatan yang mengingatkan anda
bahwa jika anda mempunyai kecen-

derungan epilepsi lebih tidak meneruskan
program ini. Program dapat membuat
anda pusing tujuh keliling.

3FLIP IT Pesan-pesan kotak dialog pada
Windows anda menjadi terbalik. Dan
jika anda mengklik tombol Yes,
kalimat-kalimat pada pesan dibalikkan

perlahan-lahan oleh si iseng. Untuk
menghentikannya, klik tombol No atau tanda
silang (X) di sudut kanan atas.

2

JIKA SI ISENG BERCOKOL DI KOMPUTER ANDA

WWeelleehh--WWeelleehh......  TToommbboollkkuu  BBeerrllaarriiaannWWeelleehh--WWeelleehh......  TToommbboollkkuu  BBeerrllaarriiaann
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FAKE FORMAT Download si iseng
yang satu ini, unzip file-nya lalu klik
dua kali programnya. Setelah itu,
tombol apa pun yang anda klik akan

menyebabkan hard disk anda ‘terformat’
dan anda tidak akan dapat menghentikan-
nya! Hmm...

1 SOMEONE PLAYED A JOKE ON
YOU Betul ‘kan? Tidak ada gunanya
jantungan karena hard disk diformat
virus, begitu kata anda. Dengan PD

sepenuhnya anda cukup mengklik tombol
Close pada kotak dialog di atas. Dan
komputer anda masih bekerja normal!

3FORMAT RESULTS Setelah ‘proses
pemformatan’ usai, seperti layaknya
jika hard disk diformat, akan muncul
laporan hasil pemformatan. Tanpa rasa

‘putus asa’ sedikit pu anda mengklik tombol
Close. Lalu tombol Close lagi.

2

KARENA TAHU ITU ULAH SI ISENG

HHaarrdd  DDiisskk--kkuu  TTeerrffoorrmmaatt......??  SSiillaakkaann  SSaajjaa..HHaarrdd  DDiisskk--kkuu  TTeerrffoorrmmaatt......??  SSiillaakkaann  SSaajjaa..

Add/Remove Seakan semua program
di komputer anda terhapus lewat fungsi
Add/Remove Programs-nya Windows.
Click Me Membuat tombol
menghindar ketika akan diklik.
Dirty Mouse Membuat orang mengira
bola mouse-nya kotor.

Fake Start Menu 95 Menggantikan menu
Start Windows 95 dengan menu Start
yang tidak berespons terhadap apa pun.
Open/Close CD Membuat CD-ROM
korban seolah-olah tidak dapat diken-
dalikan, membuka dan menutup sen-
diri tanpa diminta.

Fake Delete Satu lagi si iseng yang
bikin jantungan pemakai canggih
sekalipun.
Bomb Menampilkan pesan horor
“illegal operation” yang seolah-olah
terjadi crash pada Windows anda.

Anggota Keluarga si Iseng (http://www.rjlsoftware.com/software/entertainment)




